BIOMATION

CLAS 4000 Configurable
Logic Analysis System
Publication Number 0192-0225-10

Rev. A

February, 1991

CLAS 4000

CONFIGURABLE LOGIC ANALYSIS SYSTEM

USER'S MANUAL

BIOMATION CORPORATION

19050 Pruneridge Avenue,
Cupertino, CA. 95014 - 0718
Telephone: (800) 538 - 9320
FAX: (408) 988-1647

Copyright © 1991. No part of this publication may be reproduced without written permission from BIOMATION Corporation. Printed in U.S.A.
Preface:

This manual explains the operation of the BIOMATION Configurable Logic Analysis System (CLAS 4000). The CLAS 4000 is designed to monitor numerous electronic signals simultaneously for the purpose of solving software and/or hardware problems in digital systems.

By using the powerful features, like Trace Control and a full range of clock schemes, you will be able to isolate complex events and find the causes of specific software and hardware related problems.

If you require any assistance on this product, please call BIOMATION Customer Service on the toll-free hot-line number: (800) 538-9320; then dial 2 to contact the marketing department.

The material in this manual reflects the CLAS 4000 software level which was valid at the time of publication, but is subject to change without notice.

Copies of this manual and other BIOMATION publications may be obtained from the BIOMATION sales office or distributor serving your locality.
WARNING:

This equipment has not been tested to show compliance with new FCC Rules (47 CFR Part 15) designed to limit interference to radio and TV reception. Operation of this equipment in a residential area is likely to cause unacceptable interference to radio communication requiring the operator to take whatever steps are necessary to correct the interference.

The following procedures may help alleviate the Radio or Television Interference problems:

1. Reorient the antenna of the receiver receiving the interference.

2. Relocate the equipment causing the interference with respect to the receiver (move or change relative position).

3. Reconnect the equipment causing the interference into a different outlet so the receiver and the equipment are connected to different branch circuits.

4. Remove the equipment from the power source.

NOTE:

The user may find the following booklet prepared by the FCC helpful: “How to Identify and Resolve Radio-TV Interference Problems”. This booklet is available from the U.S. Government Printing Office, Washington, D.C. 20402. Stock Number 004-000-00345-4.
Contents:

- Part 1 GETTING STARTED ................................................................. 1
  Chapter 1 Introduction ............................................................... 3
    How to Use This Manual ......................................................... 3
  Chapter 2 Preparing to Operate the CLAS 4000 ............................. 5
    Plugging In and Powering Up .................................................. 5
    Turning on the Computer ......................................................... 8
  Using Windows ........................................................................... 9
  Using Menus .............................................................................. 10
  Using Files and Folders ............................................................... 11
  Moving, Copying, and Deleting Files ........................................... 12
  Rebooting or Turning Off the Computer ....................................... 14
  Setting up the Computer Environment ......................................... 15
  Automatically Executing Applications ......................................... 21
  Running Applications .................................................................. 22

- Chapter 3 Quick Tour of Windows and Displays ............................ 23
  Checking the Configuration ......................................................... 23
  Viewing Setup Windows .............................................................. 24
  Viewing Displays .......................................................................... 29
  Viewing Standard Command Menus .............................................. 34
  Viewing Special Command Menus ................................................ 39
  Quitting/Shutdown ...................................................................... 44

- Part 2 LEARNING THE CLAS 4000 ............................................... 47
  Chapter 4 Configuration .............................................................. 49
    Overview ................................................................................... 49
    Board Assignments ................................................................. 50
    Board Info .............................................................................. 51
    Machine Info ........................................................................... 51
  Chapter 5 Channel Setup ............................................................ 53
    Overview ................................................................................... 54
    Channel Groups ........................................................................ 55
    Radix ....................................................................................... 60
    Symbolic Display ..................................................................... 60
    Polarity ..................................................................................... 65
    Thresholds .............................................................................. 66
    Clocking Techniques ............................................................... 68
    Internal Clocks ........................................................................ 69
    External Clocks ....................................................................... 70
  Chapter 6 Trace Control Setup .................................................... 77
    Overview ................................................................................... 77
    Predefined Tasks ..................................................................... 79
    Pattern Definition ..................................................................... 82
    Trigger Placement ..................................................................... 85
    Catalog of Predefined Tasks ..................................................... 86
  Chapter 7 Arm Control Setup and Run Control .............................. 93
    Overview ................................................................................... 93
    Single-shot Recording .............................................................. 95
    Rearm ....................................................................................... 95
    Automatic Data Save ............................................................... 99
    Data Comparisons .................................................................... 100
• Part 1 GETTING STARTED •
Chapter 1  Introduction

To help you learn to make the best use of the advanced features of the CLAS 4000, this manual is divided into several sections:

Part 1, *Getting Started*, guides you quickly through the preparations for use of the logic analyzer and gives you a brief tour of its principle functions.

Part 2, *Learning the CLAS 4000*, instructs you in the use of each of the screens used in operating the CLAS 4000.

Part 3, *Advanced Uses of the CLAS 4000*, provides detailed instructions on the advanced features of the logic analyzer.

The *Appendices* contain additional information about keyboard shortcuts, customer service, and specifications.

The *Index* is also provided to assist you in finding information on certain topics.

How to Use This Manual

First-time Users

In Part 1, *Getting Started*, chapters two and three provide a detailed procedure for setting up the CLAS 4000 and touring through the menus. The bold-type text in the left margin identifies each major topic. Within these topics, the various steps are identified by a bold-type leading sentence.

Notice that you can move quickly through any given procedure by reading only the bold-type leading sentence that introduces each step. If you need more details on any step, read the material below the leading sentence. All of the figures and descriptions in this section are written under the assumption that you are following all the steps exactly. You may, of course, skip steps or otherwise deviate from the procedure, but keep in mind that the results you see may not match the expected results in the manual.

In *Learning the CLAS 4000*, chapters four through ten provide detailed information about each of the setup and display windows. The bold-type text in the left margin identifies each major topic in the chapter. Within these topics, the various sections are identified by a bold-type leading sentence. The information may be read in any order because, unlike chapters two and three, there is no procedure to follow. Each section explains a single facet of the CLAS 4000 and is independent from other sections.
Experienced Users

If you are familiar with logic analyzers and want to learn quickly how to use the CLAS 4000 for your specific application, first skim the procedures in Getting Started and use them to get the logic analyzer powered up and connected to your target board. Then refer to the Learning the CLAS 4000 section of the manual for details about the Channel setup, Trace Control, and Arm Control setup windows, and the State and Timing displays.

If you are familiar with the CLAS 4000 and you need help with a certain application, you can turn directly to the part of the manual that covers the desired topics. You can use the Index to quickly locate a particular section of the manual.

Part 3, Advanced Uses of the CLAS 4000, provides detailed information on the advanced features of the CLAS 4000. You may need to refer to this section to make use of some of the more sophisticated features required to solve complex problems. Appendix D describes Multianalyzer Operation and Appendix E describes special features of 100 MHz operation.

When you see a light bulb icon next to a paragraph, read the paragraph for a subtle hint or shortcut to mastery of the CLAS 4000.
Chapter 2 Preparing to Operate the CLAS 4000

This chapter covers the first steps in setting up your CLAS 4000 logic analyzer. After unpacking and checking the materials list, read the following procedure to ensure successful use of the CLAS 4000 from the start.

Plugging In and Powering Up

Check your location’s power supply and set indicator on the CLAS 4000.

Determine whether the outlet you will be plugging the CLAS 4000 into is 100-115 volts or 220-230 volts. Locate the voltage indicator, above the power cord socket near the lower left corner of the front of the main unit of the CLAS 4000 (see Figure 2-1). Set the switch to your outlet’s voltage level.

![Figure 2-1. Power Plug, Voltage Indicator, and Switch.](image)

Ensure that there is adequate current for the operation of the CLAS 4000. If you are using the full complement of Data Boards, the CLAS 4000 may require as much as 10 amps to operate, in addition to current required for your target unit. For more information on power requirements, see Appendix C, Specifications.
Plug in the power cord and power up the CLAS 4000.

Make sure the CLAS 4000 power switch is in the OFF position, then plug the power cord into a grounded AC outlet (see Figure 2-2).

Figure 2-2. CLAS 4000 Connections.

Connect the computer to the CLAS 4000 chassis.

Plug the computer into an AC outlet, then use the SCSI interface connector cable to connect it to the CLAS 4000. The large connector (50 pin) connects to CLAS 4000. The smaller end (25 pin) plugs into the back of the computer. Connect the SCSI terminator to the bottom SCSI connector on the CLAS 4000 chassis. If you only have one SCSI connector, use the terminator between the cable and the CLAS 4000 chassis. If you have any SCSI communication problems or the computer does not boot up when the analyzer is connected, try putting the terminator on a different connector or not using it at all.
If you have not already put the computer together, do so at this time. Plug in the long power cord to the main computer chassis and the wall outlet. Connect the monitor power cord to the monitor and the computer. Connect the video cable to the monitor and the computer. Connect the keyboard cable to the back of the computer and to either end of the keyboard. The cable has symbols on it that match the symbols near the correct connector on the back of the computer.

You can connect the mouse to the back of the computer or to either end of the keyboard. Right-handed people can connect the mouse to the right end of the keyboard, and have the computer connected to the left end of the keyboard. Left-handed people can connect the mouse to the left end of the keyboard, and have the computer connected to the right end of the keyboard.

The *Getting to know the computer* section of this chapter describes the basics of using the computer, but refer to the computer manuals for detailed information.

**Connect a probe to the Aw probe connector.**

Connect a probe to the *w* probe connector on data board *A*. This is now probe *Aw*.

The probes are referred to by data board name and probe connector name. The 96-channel data boards are labeled *A*, *B*, *C*, and *D*, though not all CLAS 4000's are configured with four boards. If your CLAS 4000 has only 192 channels, for example, it will only have data boards *C* and *D*.

Throughout this manual, data board *A* is used as an example. If this board is not installed in your CLAS 4000, substitute board *D* or any of the other data boards.

Each data board supports four 24-channel probes. The probe connectors on the data boards are labeled *w*, *x*, *y*, and *z*. Therefore probe *Aw* is the probe connected to data board *A* at the probe connector *w*.

Individual channels are referred to by data board name and channel number. For example, the channel designators for data board *A* are *A00-A95*. Probe *Aw* has channels *A00-A23*; probe *Ax* has channels *A24-A47*; probe *Cz* has channels *C72-C95*. All the standard data probes are identical and can be connected to any data board probe connector.

**Connect probe Aw to the probe test connector.**

The Probe Test socket is in the left center area on the front panel of the CLAS 4000 chassis (see Figure 2-3). Connect *Aw* to the
test socket. The connectors are keyed to prevent the probe from being plugged in upside down.

The Probe Test socket generates some test waveforms in a "walking one's" style pattern. In Chapter 3, you will use the CLAS 4000 to collect data from this socket to demonstrate some of the basic capabilities of the analyzer.

Figure 2-3. Detailed View of CLAS 4000 Front Panel.

Turning on the Computer.

Turn on the computer and verify that you are at the desktop.

Turn on the computer by pressing the key with the small triangle or the button on the back of the computer. The menu bar at the top of the screen should look like Figure 2-4.

Figure 2-4. Desktop Menu Bar.
If it does not, you may be in the CLAS 4000 software. Since this section describes the computer environment called the desktop, you need to be out of the CLAS 4000 software and at the desktop. The computer has the ability to run a program automatically when you turn it on and it boots up. Your computer may be setup to automatically run the CLAS 4000 software when you turn it on.

If this is the case, the menu bar at the top of the screen will look like the Figure 2-5. To exit the CLAS 4000 software, select Quit from the File menu. You are now at the computer desktop.

**Using Windows.**

**Arrange the windows on the desktop.**

The basic unit of the computer interface is the Window. As you look at the screen, there may already be one or more windows on the desktop. If there are no windows on the desktop, move the mouse cursor to the hard disk icon in the upper right corner of the desktop and double-click the mouse button.

The screen should look something like Figure 2-6. If it does not, try to use the techniques described below to make your desktop look like the one in the Figure. The key parts of a window are shown in Figure 2-7.

The configuration of the desktop windows will be saved when you shut down the computer.
Change the size of a window with the Zoom Box.

The Zoom Box is in the upper right corner of the window. Move the mouse cursor to this box and click the mouse button to enlarge the window to maximum size. Clicking on the Zoom Box again will return the window to its original size and position.

Change the size of a window with the Size Box.

The Size Box can be used to change the size of the window. Put the cursor on the Size Box, hold down the mouse button, drag the cursor to a new location, and let go of the mouse button.

Move a window with the Title Bar.

The Title Bar can be used to move a window. Use the same dragging technique used to change the size of the window, except start with the mouse on the Title Bar.

Scroll through a window with the scroll bars.

The Scroll Bars are used to see information that is in a window, but not currently shown. The Scroll Bars are only available when the window is too small to show all the information contained in that window. You can scroll by clicking on the scroll arrows, or dragging the Scroll Box along the Scroll Bar. You can also move a page at a time by clicking above or below the Scroll Box.

Close a window with the Close Box.

Clicking on the Close Box in the upper left corner will close the window. (If you close the only window on the screen and you want to open it again, move the mouse cursor to the hard disk icon in the upper right corner of the desktop and double-click the mouse button.)

Using Menus. Use menus to select options.

Another important part of the computer interface is the menu. The menu bar at the top of the screen has several menus in it. If you move the cursor to a menu and hold down the mouse button, you can see all the available selections in the menu. To select one of the options, drag the cursor down the menu to highlight the desired option, and let go of the mouse button (see Figure 2-8).
If you open a menu and do not want to select any of the options, you can move the cursor off the menu entirely before letting go of the mouse button.

If one of the options in a menu is already the current selection, there will be a check mark to the left of the option.

Some menu options are followed by ellipsis (...). Selecting one of these options will open another window or a dialog box with additional information and options.

Use keyboard equivalents to select menu options from the keyboard.

To the right of some options in the menus there is a symbol and a letter. This is the keyboard shortcut for selecting the option from the keyboard instead of the menu. Select the option directly from the keyboard by holding down the [key and typing the letter shown in the menu. For example, in the File menu, you can type [E to select the Close option directly from the keyboard. (This command closes the current active window.)

View the contents of the hard disk.

You may be familiar with the way other computer interfaces store files in directories and subdirectories. This computer also stores information using a hierarchy. In this case, however, the directories are called folders. Folders inside of folders are the equivalent of subdirectories.

The top level folder is the root directory of the hard disk. It is represented as a window with the same name as hard disk. To open this window, double-click on the hard disk icon in the upper right corner of the screen. This top level window becomes visible and is the current active window. It should contain several icons including a folder called the System Folder. You can distinguish folders from files by looking at the icon. Folders are always represented by folder icons like the one in Figure 2-9.

View the contents of a folder.

You can see the contents of a folder by double-clicking on the folder icon or clicking on the icon once to highlight it and selecting Open from the File menu. A new window appears showing you the contents of the folder (see Figure 2-10).
Figure 2-10. Viewing the contents of the System folder.

Change the display format of the folder window.

The files and folders in a window may be viewed in several different formats. Select the various options in the View menu to see the different formats.

Create a new folder.

You can create a new folder inside the current active folder window by selecting New Folder from the File menu. A new folder appears with the name Empty Folder. You can name this folder by clicking on the folder name to highlight it and typing the new name.

If there is not already a folder called CLAS4000Folder in the top level window of the hard disk, use the technique described above to create one.

Move a file icon within a folder.

You can rearrange the icons in a window by dragging them with the mouse. Put the cursor on the icon, hold down the mouse button, move the cursor to a new place, and let go of the mouse button.
Hold down the <shift> key as you click on multiple files. They will all become highlighted. You can now move, copy, or delete them all at once. Another way to highlight multiple files is to click and hold the mouse button in an area of the window near the desired file icons. As you drag the cursor toward the icons, a dashed box appears. Drag the box around all the desired icons and then let go of the mouse button. All the icons inside the box will be selected (see Figure 2-11).

![Hard disk diagram](image)

Figure 2-11. Selecting multiple files.

**Move a file to a different folder.**

You can move a file to a different folder by dragging the file icon from one folder window to another. You can also drag the file icon onto the destination folder icon.

If the CLAS 4000 application program file is not in the CLAS 4000 folder, move it there now.

**Make a copy of a file.**

You can make a copy of a file using the Duplicate option from the File menu. First, highlight the file by clicking on it once. Then select Duplicate or type 96D. A new file will be created with the name, "Copy of <filename>" where <filename> is the name of the original file.
Delete a file.

You can delete a file by dragging the file icon onto the trash can icon in the lower right corner of the screen. The trash can icon bulges to indicate that it is not empty (see Figure 2-12).

The file is not completely gone until you select Empty Trash from the Special menu. If you want to retrieve the file, double-click on the trash can icon to open the trash window. You can then drag the file icon back out of the trash.

There are several actions which will automatically empty the trash, so you should never throw anything away unless it is really trash.

Copy a file to a floppy disk.

When you put a floppy disk in the disk drive, the floppy disk icon appears below the hard disk icon in the upper right corner of the screen (see Figure 2-13). You can see the contents of the disk by double clicking on the icon. To copy files to the floppy, drag the file icons from the hard disk window to the floppy disk window.

Copy a file from a floppy disk to the hard disk.

You can copy files from the floppy disk to the hard disk by dragging the file icons from the floppy disk window to any of the hard disk windows.

Restart the computer.

There are times when you may want to restart (reboot) the computer. For example, some of the changes you make to the interface environment will not be implemented until the computer is restarted. You can restart the computer at any time by selecting the Restart option from the Special menu.

Shut down the computer.

Turning off the computer can be done right from the desk top by selecting Shut Down from the Special menu (see Figure 2-14). This parks the hard disk heads and turns off the power. The computer can also be turned off with a button on the back of the main computer chassis.
Setting up the Computer Environment

Open the Control Panel.

Select the Control Panel option from the ⌁ menu at the far left end of the menu bar as shown in Figure 2-15. A pop-up window appears with a variety of options (see Figure 2-16). You can use this control panel area to setup the computer interface environment as described in the following sections.

Set the date.

In the center of the control panel pop-up window, you see a Date field. The date shown should be today's date. If it is incorrect, you should set the proper date because files are tagged with the date and time when they are saved.

If you need to change the date, click on the day, month, or year that you need to change. Small scroll arrows appear to the right...
of the date. Scroll up or down to the correct value. When you are finished, click just above the date on the date symbol.

**Set the time.**

Changing the time is just the same as changing the date except you click on the hours, minutes, or seconds that you need to change. Use the scroll arrows to set the correct value. To save the new time, click just above the time on the time symbol.

**Set the desktop pattern.**

You can change the color and pattern of the desktop background by using the Desktop Pattern area of the control panel.

If you have a color monitor set to the correct mode, the upper part of the control panel should contain a row of colored boxes, a checkered square, and a larger rectangle (see Figure 2-17). If you have a color monitor, but there are no colored boxes, your monitor may be in the wrong mode. See the *Set the monitor mode* section in this chapter.

![Control Panel](image)

**Figure 2-17. Setting the desktop pattern.**

The row of colored boxes is the palette that you use to paint the desktop. The checkered square is a zoomed-in section of the desktop background. Each tiny square represents one pixel on the screen. You can set the color of each pixel in the zoomed-in section. When you are finished, this section will be repeated all over the desktop. The larger rectangle to the right shows you what the zoomed-in pattern will look like when it is used on the desktop.
To change the color of a pixel in the checkered square, first click on the color that you want in the palette. Then click on the pixel you want to change. When you are all finished and you want to use the new pattern on the desktop, click on the larger rectangle. The new pattern will now be your desktop background.

If you want to change the colors in the palette, double-click on the palette color you want to change. A large pop-up window appears. Adjust the brightness with the scroll bar on the right. To set the new color, click in the part of the colored circle that has the desired color. Click OK to save your change, or Cancel to quit without changing the color.

Set the speaker volume.

The computer has a speaker that is used to give an audible beep in certain situations. On the right side of the control panel there is a speaker volume scale (see Figure 2-18). You can adjust the speaker volume by dragging the horizontal bar up or down the scale. You can also change the beep sound. See the Set the beep sound section in this chapter.

![Figure 2-18. Speaker volume scale.](image)

Set the highlight color.

When you click on an object to highlight it, the color of the object changes. You can change this highlight color from the control panel. For all the control panel adjustments described above, you were using the General section of the control panel. In order to change the highlight color, you need to go to another control panel section.

Use the scroll bar near the left of the control panel window to scroll down through the list of sections. When you see the
section called **Color**, click on the **Color** icon (see Figure 2-19). The new control panel section appears to the right of the scroll bar.

![Control Panel](image)

**Figure 2-19. Setting the highlight color.**

To change the color, click on the **Change Color** button. A large pop-up window appears. Adjust the brightness with the scroll bar on the right. To set the new color, click in the part of the colored circle that has the desired color. Click **OK** to save your change, or **Cancel** to quit without changing the color.

**Set the mouse tracking.**

As you move the mouse across the mouse pad, the cursor moves across the screen. If it seems like you have to move the mouse a long ways across the mouse pad to get the cursor to move a short distance across the screen, the mouse tracking is set too slow. If you are having trouble putting the cursor on an object because any slight movement of the mouse moves the cursor too far, the mouse tracking is set too fast.

If you want to change the mouse tracking, use the scroll bar near the left of the control panel window to scroll down through the list of sections. When you see the section called **Mouse**, click on the **Mouse** icon (see Figure 2-20). The new control panel section appears to the right of the scroll bar. Click on the desired button to set the new mouse tracking.
You can also use this window to set the double-click speed. Whenever you push the mouse button twice, the computer needs to decide whether you did a double-click or two single clicks. It makes this decision based on whether or not the second click came within a certain delay period. You can adjust this delay period using the **Double-Click Speed** portion of this control panel section.

**Set the beep sound.**

The computer has a speaker that is used to give an audible beep in certain situations. The actual beep sound does not have to be a simple beep. There are several other sounds that can be used as the beep sound.

If you want to change the beep sound, use the scroll bar near the left of the control panel window to scroll down through the list of sections. When you see the section called **Sound**, click on the **Sound** icon (see Figure 2-21). The new control panel section appears to the right of the scroll bar. Click on the desired sound in the list of sounds on the right side of the window.

You can adjust the speaker volume by dragging the horizontal bar up or down the scale. Note that you can also set the speaker volume from the **General** section of the control panel. See the **Set the speaker volume** section in this chapter.
Set the monitor mode.

If you have a color monitor, but all the displays seem to be in black and white, your monitor may be in the wrong mode.

If you want to check or change the monitor mode, use the scroll bar near the left of the control panel window to scroll down through the list of sections. When you see the section called Monitors, click on the Monitors icon (see Figure 2-22). The new control panel section appears to the right of the scroll bar. Select either Black & White/Grays or Color and the number of colors.

Figure 2-21. Setting the beep sound.

Figure 2-22. Setting the monitor mode.
Even if you have a color monitor, you may want to temporarily set the monitor mode to 2 colors. There is a built-in screen capture utility that allows you to make a copy of the screen and put it in a file. This can be very useful for creating documentation concerning something you see on the screen. Most of the Figures in this manual were created with a similar capture utility. The built-in screen capture utility only works in 2 color mode. You can do a screen capture by pressing `Shift`3.

**Automatically Executing Applications**

Set applications to run at startup

Executable programs like the CLAS 4000 software are called *Applications*. The computer has the ability to automatically execute an application when the computer boots up or restarts. If you are going to be using the computer exclusively for running the CLAS 4000 software, you may want to have the computer automatically run the CLAS 4000 software whenever you turn it on.

If the computer is already setup to run the CLAS 4000 application automatically, you can disable the automatic execution. Even if the CLAS 4000 software runs automatically on startup, you can always get to the computer desktop by quitting out of the CLAS 4000 software.

Make sure you are out at the desktop and not in the CLAS 4000 software. The menu bar at the top of the screen should contain the *Special* menu. If it does not, you may be in the CLAS 4000 software. To exit the CLAS 4000 software, select *Quit* from the *File* menu.

Locate the CLAS 4000 software application in one of the windows on the desktop. If you want the application you run automatically on startup, click once on the CLAS 4000 icon to highlight it. If you do not want the CLAS 4000 software to run automatically, make sure that it is not highlighted.

Select the option *Set Startup...* from the *Special* menu (see Figure 2-23). A pop-up window appears like the one shown in Figure 2-24. In the bottom part of the window you have several choices. Some of them may not be available depending on whether or not you have applications highlighted or open.
Special
- Clean Up Window
- Empty Trash
- Erase Disk

Set Startup...

- Restart
- Shut Down

Figure 2-23. Opening the Set Startup window.

Figure 2-24. Set Startup... window.

If you highlighted the CLAS 4000 application and you want it to run at startup, select the top option which should have the name of the CLAS 4000 application. If you do not want the CLAS 4000 application to run at startup, select the bottom option which is probably Finder Only.

Click on the OK button to implement your changes or the Cancel button to leave the window without making any changes. The next time you startup or restart the computer, the new startup parameters will be used.

Running Applications

Execute the CLAS 4000 application.

When you are at the computer desktop and you want to run an application, double-click on the application icon. To run the CLAS 4000 application, double-click on the CLAS 4000 icon.

If you do not have the CLAS 4000 chassis turned on or connected properly, a dialog box appears like the one shown in Figure 2-26. Correct the problem and select Retry, or if you just want to look at the CLAS 4000 interface, select DEMO.

Figure 2-25. Dialog box indicating the CLAS 4000 chassis was not found by the software.
Chapter 3  Quick Tour of Windows and Displays

It is assumed that you have read Chapter 2 and connected Probe 4w to the Probe Test socket before starting work on Chapter 3. Make sure that you are in the CLAS 4000 software and not out at the desktop. The menu bar should look like the one shown in Figure 3-1.

![Menu Bar](image)

**Figure 3-1.** CLAS 4000 menu bar.

This chapter gives a quick introduction to the main windows and displays that you use to take measurements with the CLAS 4000. As you follow the procedure in this chapter, you will open and view the different windows as you set up the CLAS 4000 to make a simple recording of the data from the probe test socket.

Note that the order of the icons on the icon menu bar, moving from left to right across the icon menu bar, is the same order used for actually setting up the CLAS 4000 to record, namely: Channel Setup, Trace Control, Arm Control, Run, and the Timing and State Displays.

Be sure to follow the steps in this chapter exactly if you want your results to match the figures in this chapter. Leave windows open unless you are directed to close them. Near the end of the Tour you will be manipulating all the open windows.

**Checking the Configuration**

Check to make sure data board A is assigned to LA1.

When you run the CLAS 4000 software, the Configuration window appears in the center of the screen. Data Board "A" should appear in LA 1, as shown in Figure 3-2.

![Configuration Window](image)

**Figure 3-2.** Configuration Window
Any or all of the data boards installed in your CLAS 4000 may be assigned to LA 1, but for simplicity, only the first board (A) will be referred to in the Getting Started and Learning the CLAS 4000 sections of this manual. If more than one data board is assigned to LA 1 (the board icons will be stacked up under "LA 1") just drag all boards except "A" back down to their own slots. If data board A is not installed in your CLAS 4000, substitute board D or any of the other data boards.

For more information on assigning other Data Boards to the logic analyzer, see Chapter 4, Configuration.

Viewing Setup Windows.

Open and observe the channel setup for the next recording.

Pull down the Channel Setup menu and choose LA 1: Next (see Figure 3-3).

![Help Channel Setup menu](image)

Figure 3-3. Channel Setup menu.

Selecting the Help Channel Setup... option opens a Help window.

The term "Next" is used to describe the recording you are currently setting up. It is the next recording you will take on the CLAS 4000.

The "Last" recording is the one most recently taken. It shows the data captured the last time the CLAS 4000 took a measurement and the setup used to capture the data. Each time you take a new measurement, the Last data is replaced with the newly recorded data, and the Last setup is replaced with the Next setup that was used to record the data.

A "Reference" recording is one you have transferred from a Last recording or loaded from the hard disk. The Reference setup is the setup that was used to record the Reference data. Reference data can be compared to the Last data. The data and setup are not replaced until you use the Transfer menu to put another Last recording into Reference or load data from the hard disk.

When you choose Next from the menu, Channel Setup window appears. If the window does not look like the one in Figure 3-4
when you initially start the CLAS 4000 software, you may have a power-up file. See the Quitting/Shutdown section at the end of this chapter for more information on power-up files.

![Channel Setup Window](image)

**Figure 3-4. Channel Setup Window**

The Channel Setup window is the one you use to assign probe channels to groups so they appear in logical order in the State and Timing displays. You also use this window to define the clock scheme and rate, and to choose the label, polarity, and threshold for the channels.

The group labels, "Address," "Data" and "Status" are the default labels and are used as examples.

**Use the probe ID button to identify probes.**

If you have many probes attached to the CLAS 4000 and you want to know which is which, press the flat membrane switch on the probe body (pod). If the probe is not attached to the test socket, a message appears on the CLAS 4000 screen telling you which board and channels are connected to that probe. This will not work if the probe is attached to the probe test socket or if certain pop-up windows are present on the screen.

**Click on the channels box for the Address group.**

Under each group name in the Channel Setup window are several rows of fields. The names for each row of fields are at the far left of the window. Click on the box in the Channels field for the Address group. The Inputs dialog box appears showing which channels are currently selected (see fig 3-5).
The four main rectangles represent the four probes that can be attached to the data board. The left-most probe has channels 00 through 11 on the top row and channels 12 through 23. The right-most probe has channels 72 through 95, etc. The selected channels are listed at the top of the window. The \textbf{A} in front of each number means that the channel is from data board \textbf{A}. The \textbf{A} does not stand for Address.

The inputs selected for Address are highlighted. In the illustrated sample, channels \textbf{A15-A00} are selected. The inputs available to be selected are dark squares. The greyed squares represent ground connections that are in the probe connectors.

\textbf{Define channels A07-A00 as the Address channels.}

Click on the \textbf{Clear All} button to unselect all the channels.
Highlight channels \textbf{A07-A00}. You can highlight channels by clicking on them individually or dragging the cursor across them.

When you highlight the channels for the group, you are also defining the order that you want them to be displayed. The first channel highlighted will be considered the most significant channel in this group. The last channel highlighted will be the least significant. For example, highlighting \textbf{A07-A00} will make \textbf{A07} the most significant channel. Highlighting \textbf{A00-A07} will make \textbf{A00} the most significant. The data collected for each group will be displayed in the State display with the most significant channel on the left and the least significant channel on the right.

Click \textbf{OK} to leave the Inputs dialog box and return to the Channel Setup window.

\textbf{Define channels A19-A12 as the Data channels.}

Click on the Channels field for the group Data to open the Inputs dialog box for that group. Click on the \textbf{Clear All} button to
unselect all the channels and highlight channels A19-A12. Click OK to close the window.

Define channels A22—A20 as the Status channels.

Click on the Channels field for the group Status. Click on the Clear All button and highlight channels A22-A20. Click OK to close the window.

Set clock to internal 20 ns.

Open the Sample Clock menu; select the Internal clock then Rate at 20 ns option (see Figure 3-6).

Leave the Channel Setup window open and go on.

For the purposes of this guided tour, you do not need to change the Radix or Polarity for any channels, and you can leave the Thresholds of the channels at their default value. For more information on this window, see Chapter 5, Channel Setup. Leave the window open and go on to Trace Control.

Open and observe the Trace Control Window.

Pull down the Trace Control Menu and choose LA 1: Next (see Figure 3-7).

The Trace Control window appears and should look like the one in Figure 3-8. You can use this window to define what event or combination of events will be used to trigger the CLAS 4000
during data collection. You can also specify whether to store all incoming data or to store only a certain type of data.

The default setup for this window is a simple Fill Memory. This setup will be sufficient for the purposes of this quick tour.

Leave the Trace Control window open and go on.

For more information on this window, see Chapter 6, *Trace Control Setup*. Leave the window open and go on.

Open and observe the Arm Control Window.

Pull down the Arm Control menu and choose LA 1: Next (see Figure 3-9). The window should look like the one in Figure 3-10.

![Help Arm Control...]  
**Figure 3-9.** Arm Control menu.

![Arm Control Window and Status Box]  
**Figure 3-10.** Arm Control Window and Status Box

Use this window to set up the CLAS 4000 to make a single pass or repeated recordings. You can also choose any of several other automatic Arming options: updating the screen between recordings, comparing Last and Reference data, and saving the data from the recordings onto the hard disk. The default setup is to Stop after one pass which will be fine for this quick tour.

Leave the Arm Control window open and go on.

For more information on this window, see Chapter 7, *Arm Control Setup and Run Control*. Leave the window open and go on.
Run the logic analyzer.

You can observe the status of the CLAS 4000 analyzer hardware in the small status window in the lower left corner of the screen (see Figure 3-11). When the analyzer is running, the status window will say **Busy**. When the analyzer is finished, the status window will say **Ready** and you will hear a beep.

![Figure 3-11. Status window.](image)

Pull down the Run menu and choose **Run** (see Figure 3-12). The CLAS 4000 will take a few seconds to collect and store the data from the probe test connector.

### Viewing Displays

Open and observe the Timing Display.

Pull down the Timing menu and choose **LA 1: Last** (see Figure 3-13). The waveforms are shown in the order arranged in Channel Setup with the most significant channel at the top of each group. Your timing display should look like the one in Figure 3-14. If it does not, you may be using a different setup than the one created by the procedure in this chapter.

![Figure 3-14. Timing Display](image)
Click the Zoom Box to enlarge the window.

Click the Zoom Box in the upper right corner of the window to enlarge it to full size.

Adjust the horizontal and vertical expansion to 4 and 3.

Be sure to set the expansion to exactly $V = x \ 3 \quad H = x \ 4$. If the expansions are set differently, steps later in this chapter will not have the expected results.

On a 13" monitor, the default display resolution shows you the first 90 or so samples from about 15 channels. You can zoom-in or zoom-out by changing the horizontal and vertical expansion of the display. In the upper left part of the window the current expansion values are shown as $V = x \ 2 \quad H = x \ 2$.

Change the horizontal expansion to $H = x \ 4$ by pulling down the Options menu and putting the cursor on the Horizontal Exp. (The arrow, $\triangleright$, indicates that there is a side menu. See Figure 3-15.) Move the cursor onto the side menu and select the $x \ 4$ option. When you let go of the mouse, the horizontal display resolution changes to $H = x \ 4$ as indicated in the upper left part of the window.

Use the same method to change the vertical expansion to $V = x \ 3$.

Insert a new line above Address07.

The timing display can be rearranged and altered to suit your needs. The steps below describe how to display a channel group in the bus display format.

Click in the blank box to the left of the channel named Address07 to highlight the channel (see Figure 3-16).

Select Insert from the Edit menu. A new line named ---New---→ is added to the top of the display.
Figure 3-16. Highlighting a line on the display.

Name the line "Addr Bus."

Click in the box that contains the name ---New--- to highlight the name for editing. Type Addr Bus as the new name for the channel.

Define the new line as Address displayed as a bus.

Locate the Chan column just to the right of the channel names. Click in the Chan box on the new line (see Figure 3-17). A dialog box appears like the one shown in Figure 3-18. Verify that the Display: field specifies Address. Click on the as a BUS. button.

Figure 3-17. Defining the contents of a line in the timing display.

Figure 3-18. Channel selection dialog box.
Click on the Select box to close the dialog box and return to the timing display. The new line on the display now contains all of the address channels grouped as a bus. You can now easily see the hex address value for each sample (see Figure 3-19).

![Bus display in Timing window.](image)

**Figure 3-19. Bus display in Timing window.**

**Scroll through the data.**

At some of the display resolutions you will not be able to see all the data for all the channels in the window at the same time. You can scroll using the scroll bar on the right side of the screen to scroll down the list of channels. Either click on the down arrow, drag the scroll box down, or page down by clicking in the grey area below the scroll box.

In a similar manner, you can scroll right or left to see earlier or later portions of the recording than those seen on the screen.

**Leave the Timing Display window open and go on.**

For more information on this window, see Chapter 7, Timing Display. Leave the window open and go on.

**Open and observe the State Display.**

Pull down the State menu and choose **LA 1: Last** (see Figure 3-20). The data in this display is arranged in columns as specified in Channel setup. The sample number of each line of data appears on the left side of the screen. Your state display should look like the one in Figure 3-21 a. If it does not, you may be using a different setup than the one created by the procedure in this chapter.

![State menu.](image)

**Figure 3-20. State menu.**
Chapter 3 Quick Tour of Windows and Displays

Figure 3-21 a. State Display

Scroll through the data.

To see data that is hidden from view, scroll up and down with the scroll bar on the right side of the screen. If you had more groups defined in Channel Setup than could fit horizontally across the display, you could use a scroll bar on the bottom of the window to scroll horizontally to see the other groups. The bottom scroll bar is not available unless it is needed.

Display Time Stamp information.

The CLAS 4000 stores a Time Stamp with each data sample that indicates when the sample was taken relative to other samples. The Time Stamps can be displayed next to each sample. Select Display Setup... from the Options menu as shown in figure 3-21 b. A dialog box appears with a variety of options (see Figure 3-22).

Figure 3-22. Display Setup dialog box.
Click on the **Time from line** button to enable the Time Stamps in the State display.

Click the **OK** button to close the window and return to the State display. The Time Stamp information is shown to the right of each sample indicating when each sample was taken relative to the first sample in analyzer memory (see Figure 3-23).

![State display window with Time Stamps.](image)

**Figure 3-23.** State display window with Time Stamps.

Leave the State Display window open and go on.

For more information on this display, see Chapter 9, State Display. Leave the window open and go on.

**Viewing Standard Command Menus**

Observe the menu bar.

The menu bar at the top of the screen contains up to seven menus. Five of them are standard pull-down menus (see Figure 3-24). The menus have a variety of commands that are used to manipulate data, files and windows. You have already used many of these commands as you toured the setup and display windows.

![Menu bar.](image)

**Figure 3-24.** Menu bar.

The following sections will give you a quick tour of all the menus and their commands. For each menu there is a table showing all the commands, their purpose and their keyboard shortcuts keys (if applicable).
Commands that are greyed are not available in the current context. They may be available when you are in some other situation.

The same kind of keyboard shortcuts that were available in the desktop menus are available from the CLAS 4000 menus. Any menu command that has the command symbol and a letter shown with it, such as $\text{⌘T}$ in the \texttt{Windows} menu, can be executed from the keyboard by holding the $\text{⌘}$ key down and pressing \texttt{T}. When you get familiar with the commands, the keyboard shortcuts can be much faster than pulling down the menu and choosing the command with the mouse. For a complete list of these shortcuts, see Appendix B.
Open and observe the File Menu.

Open the File menu on the top menu bar (see Figure 3-25). The File menu deals with loading, saving, and printing files made up of data and/or setups. Table 3-1 contains a summary of the commands. For more information on these File menu commands, see Chapter 10.

![File Menu](image)

**Figure 3-25.** File menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td>Load a setup from the hard disk into the Next setup; Load setup and data from the hard disk into Last or Reference</td>
<td>⌘ o</td>
</tr>
<tr>
<td>Close</td>
<td>Close the active window or display</td>
<td>⌘ w</td>
</tr>
<tr>
<td>Save as...</td>
<td>Save a setup from Next, onto hard disk; Save setup and data from Last or Reference onto hard disk</td>
<td></td>
</tr>
<tr>
<td>Save as text...</td>
<td>Saves State or Disassembly data to a file in ASCII format</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Set up page size and orientation for printing</td>
<td></td>
</tr>
<tr>
<td>Print Window...</td>
<td>Print only the contents of the active window</td>
<td></td>
</tr>
<tr>
<td>Print Long...</td>
<td>Print a long state data display using as many sheets of paper as necessary</td>
<td>⌘ p</td>
</tr>
<tr>
<td>Quit</td>
<td>Allows you to quit the CLAS 4000 application and return to the desktop; A dialog box will allow you to save all setups and data in the CLAS 4000 power-up file</td>
<td>⌘ q</td>
</tr>
<tr>
<td>Restart</td>
<td>Reboots the computer immediately; No setups are saved</td>
<td></td>
</tr>
<tr>
<td>Shut Down</td>
<td>Turns off the computer immediately; No setups are saved</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-1.** File menu commands.
Open and observe the Edit Menu.

Open the Edit menu on the top menu bar (see Figure 3-26). The Edit menu commands are used to manipulate selected objects. The commands are greyed if they are not selectable in the current context. Table 3-2 contains a summary of the commands.

![Edit Menu](image)

Figure 3-26. Edit menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo/Can't Undo</td>
<td>&quot;Undo&quot; reverses the results of your last editing action; If the action cannot be undone, the command is &quot;Can't Undo&quot;</td>
<td>☒ Z</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes selected object(s) and places it on the Clipboard</td>
<td>☒ X</td>
</tr>
<tr>
<td>Copy</td>
<td>Places a copy of selected object(s) on the Clipboard</td>
<td>☒ C</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts a copy of Clipboard contents at insertion point</td>
<td>☒ V</td>
</tr>
<tr>
<td>Clear</td>
<td>Removes a selection without placing it on the Clipboard; Often the same as the &lt;Delete&gt; key</td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts a new object prior to the selected object sheets of paper as necessary</td>
<td>☒ I</td>
</tr>
<tr>
<td>Append</td>
<td>Appends a new object to the end of the current sequence of objects</td>
<td></td>
</tr>
<tr>
<td>Duplicate</td>
<td>Inserts a duplicate of the selected object(s) in front of the selected object(s)</td>
<td>☒ D</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all manipulatable objects</td>
<td>☒ A</td>
</tr>
</tbody>
</table>

Table 3-2. Edit menu commands.
Open and observe the Control Menu.

Open the Control menu on the top menu bar (see Figure 3-27). The Control menu lets you modify the internal timebase of the CLAS 4000 chassis and show or hide the status and configuration windows. Table 3-3 contains a summary of the commands.

![Control Menu](image)

**Figure 3-27. Control menu.**

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Configuration</td>
<td>&quot;Show...&quot; Opens Configuration window if it is closed</td>
<td></td>
</tr>
<tr>
<td>Hide Configuration</td>
<td>&quot;Hide...&quot; Closes Configuration window if it is open</td>
<td></td>
</tr>
<tr>
<td>Show Status/Hide Status</td>
<td>&quot;Show...&quot; Opens Status window if it is closed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;Hide...&quot; Closes Status window if it is open</td>
<td></td>
</tr>
<tr>
<td>Master Clock</td>
<td>Allows you to modify the internal timebase of the CLAS 4000; See Chapter 12 for more information</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-3. Control menu commands.**

Open and observe the Transfer Menu.

Open the Transfer menu on the top menu bar (see Figure 3-28). The Transfer menu commands are used to transfer setups and data between Next, Last and Reference. Table 3-4 contains a summary of the commands.

![Transfer Menu](image)

**Figure 3-28. Transfer menu.**

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last » Reference</td>
<td>Copies Last data and setup into Reference; Replaces old Reference contents</td>
<td></td>
</tr>
<tr>
<td>Last » Next</td>
<td>Copies Last setup into Next; Replaces old Next setup contents</td>
<td></td>
</tr>
<tr>
<td>Reference » Next</td>
<td>Copies Reference setup into Next; Replaces old Next setup contents</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-4. Transfer menu commands.**
Open and observe the Windows Menu.

Open the **Windows** menu on the top menu bar (see Figure 3-29). The **Windows** menu allows you to rearrange windows that are currently open, or place any one of them in front of all the others for a clear view. Table 3-5 contains a summary of the commands.

The lower portion of the window contains a list of open windows. The exact contents of this list will vary depending on which windows are currently open. A checkmark by a window title indicates it is the active one. Selecting a window's title in the list will make it the active one and bring it to the front.

![Windows menu](image)

**Figure 3-29.** Windows menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>keypress</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile Windows</td>
<td>Arranges all open windows into tile pattern that fill the screen</td>
<td>⌘ T</td>
</tr>
<tr>
<td>Stack Windows</td>
<td>Stacks all open windows into a stack showing all title bars</td>
<td>⌘ Y</td>
</tr>
<tr>
<td>&lt;window list&gt;</td>
<td>List of all open windows; A checkmark indicates which is the active window; Selecting a window title from the list makes that window the active one</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-5.** Windows menu commands.

### Viewing Special Command Menus

Observe the special command menus for each window.

All the setup and display windows have special menus that appear to the right of the standard menus. The menus contain special commands and choices for the corresponding setup or display window. Only the special menu for the active window is present on the menu bar. All of the special menus are called **Options** except the Trace Control special menu. It is called **Trace Ctl**.

The following sections contain brief descriptions of each special menu. Remember, in order to see the special menu for a certain
window, that window must be the current active window. For
detailed information on each special menu, see the chapter on the
Corresponding window in the Learning the CLAS 4000 section
of the manual.

Open and observe the Channel Setup Options menu.

Go to the Channel Setup window to make it the current active
window. Open the Options menu on the top menu bar (see
Figure 3-30). The Options menu commands are used to set the
threshold for the probes and the colors of selected channel
groups. Table 3-6 contains a summary of the commands.

![Options menu](image)

**Figure 3-30. Channel Setup Options menu.**

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Threshold</td>
<td>Opens dialog box for setting probe thresholds</td>
</tr>
<tr>
<td>Color</td>
<td>Used to change color of selected channel group</td>
</tr>
</tbody>
</table>

**Table 3-6. Channel Setup Options menu commands.**

Open and observe the Trace Control Trace Ctl menu.

Go to the Trace Control window to make it the current active
window. Open the Trace Ctl menu on the top menu bar (see
Figure 3-31). The Trace Ctl menu commands are used to select
the Trace Control mode, enable/disable the output menu, and
open the pattern and range definition windows. Table 3-7
contains a summary of the commands.

![Trace Ctl menu](image)

**Figure 3-31. Trace Control Special menu.**
Table 3-7. Trace Control Special menu commands.

Open and observe the Arm Control Options menu.

Go to the Arm Control window to make it the current active window. Open the **Options** menu on the top menu bar (see Figure 3-32). The **Options** menu command is used to set the edge tolerance for Last/Reference comparisons. Table 3-8 contains a description of the command.

![Options](Image)

**Edge Tolerance**

Figure 3-32. Arm Control Options menu.

Table 3-8. Arm Control Options menu command.
Open and observe the Timing display Options menu.

Go to the Timing Display window to make it the current active window. Open the Options menu on the top menu bar (see Figure 3-33). The Options menu commands are used to manipulate the display, initiate on-screen comparisons between Last and Reference data, and open the Timing Info dialog box. Table 3-9 contains a summary of the commands. You can change the horizontal and vertical expansion from the keyboard. Holding down the <option> key and use the arrows as indicated in the table.

**Figure 3-33. Timing Display Options menu.**

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>⌃ key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Exp.</td>
<td>Opens side menu used to change the vertical resolution of the display</td>
<td>⌃ opt. ↑, opt. ↓</td>
</tr>
<tr>
<td>Horizontal Exp.</td>
<td>Opens side menu used to change the vertical resolution of the display</td>
<td>⌃ opt. ←, opt. →</td>
</tr>
<tr>
<td>Group</td>
<td>Groups together selected channels into a bus</td>
<td>⌃ G</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ungroups selected bus into individual channels</td>
<td>⌃ U</td>
</tr>
<tr>
<td>Goto C1</td>
<td>Moves the display to the portion of sample memory containing cursor C1</td>
<td></td>
</tr>
<tr>
<td>Goto C2</td>
<td>Moves the display to the portion of sample memory containing cursor C2</td>
<td></td>
</tr>
<tr>
<td>Goto Sample…</td>
<td>Opens dialog box used to specify destination sample number; Closing dialog box moves the display to the specified sample</td>
<td></td>
</tr>
<tr>
<td>Get C1</td>
<td>Brings the C1 cursor onto the current display</td>
<td></td>
</tr>
<tr>
<td>Get C2</td>
<td>Brings the C2 cursor onto the current display</td>
<td></td>
</tr>
<tr>
<td>Compare</td>
<td>Initiates an on-screen comparison between Last and Reference data; Miscompares are indicated as ghost waveforms on top of actual waveforms</td>
<td>⌃ –</td>
</tr>
<tr>
<td>Color</td>
<td>Used to change the color of selected channels</td>
<td></td>
</tr>
<tr>
<td>Timing Info…</td>
<td>Opens the dialog box containing the Timing Info; See Chapters 8 and 11 for more information</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-9. Timing Display Options menu commands.**
Open and observe the State display Options menu.

Go to the State Display window to make it the current active window. Open the Options menu on the top menu bar (see Figure 3-34). The Options menu commands are used to manipulate the display, and initiate on-screen comparisons between Last and Reference data. Table 3-10 contains a summary of the commands.

![State Display Options menu](image)

Figure 3-34. State Display Options menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning/Use</th>
<th>key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to C1</td>
<td>Moves the display to the portion of sample memory containing cursor C1</td>
<td>1</td>
</tr>
<tr>
<td>Go to C2</td>
<td>Moves the display to the portion of sample memory containing cursor C2</td>
<td>2</td>
</tr>
<tr>
<td>Go to Sample...</td>
<td>Opens dialog box used to specify destination sample number; Closing dialog box moves the display to the specified sample</td>
<td>G</td>
</tr>
<tr>
<td>Get C1</td>
<td>Brings the C1 cursor onto the current display</td>
<td></td>
</tr>
<tr>
<td>Get C2</td>
<td>Brings the C2 cursor onto the current display</td>
<td></td>
</tr>
<tr>
<td>Find...</td>
<td>Opens dialog box used for searching through the data for certain pattern(s)</td>
<td>F</td>
</tr>
<tr>
<td>Compare</td>
<td>Initiates an on-screen comparison between Last and Reference data; Miscomparisons are indicated with a ≠ sign in the marker area to the left of the samples</td>
<td>=</td>
</tr>
<tr>
<td>Clear the Marker Area</td>
<td>Clears the area between the sample number and the data of all markers manually placed there by double clicking; Also clears markers left by searches and compares</td>
<td></td>
</tr>
<tr>
<td>Edit Reference</td>
<td>Used to put the display into edit mode for editing Reference data; Command is only enabled when looking at Reference data</td>
<td></td>
</tr>
<tr>
<td>Display Setup...</td>
<td>Opens dialog box used to set display parameters such as font size and Time Stamp information</td>
<td></td>
</tr>
<tr>
<td>Force to object mode</td>
<td>Available only in disassembler mode; see disassembler manual</td>
<td></td>
</tr>
<tr>
<td>Disassemble from top line</td>
<td>Available only in disassembler mode; see disassembler manual</td>
<td></td>
</tr>
<tr>
<td>Disassembler Format...</td>
<td>Available only in disassembler mode; see disassembler manual</td>
<td></td>
</tr>
<tr>
<td>Disassembler Config...</td>
<td>Available only in disassembler mode; see disassembler manual</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-10. State Display Options menu commands.
Quitting/Shutdown

Exit the CLAS 4000 application.

There are three ways to exit the CLAS 4000 application, Quit, Restart, and Shut Down. All three options are available from the File menu.

Selecting Quit from the File menu opens a dialog box that offers to save "All Setups" (see Figure 3-35). If you answer No, you will automatically leave the CLAS 4000 application and exit to the desktop. Clicking the Cancel button aborts the Quit and puts you back in the CLAS 4000 software.

Figure 3-35. Quit dialog box.

Selecting Restart reboots the computer immediately. You do not have a chance to save setups or change your mind.

Selecting Shut Down from the File menu turns off the computer immediately. You do not have a chance to save setups or change your mind. This option is very useful for turning off the computer at the end of
the day without having to exit to the desktop to select **Shut Down** from the **Special** menu. Be sure to save any important setups or data with the **Save as** option first.

For more information on saving setups and data, see Chapter 10.

💡 There is actually a fourth way to exit the CLAS 4000 software. Pushing the button on the back of the computer turns it off. You can do this at any time regardless of where you are and what you are doing. This method is not very graceful, however, and should only be used as a last resort.
Part 2  LEARNING THE CLAS 4000
Chapter 4  Configuration

This chapter explains how to assign one or more data boards in the CLAS 4000 to the logic analyzer, and how to choose names for the analyzer to suit your specific problem solving needs.

Overview

Getting to know the Configuration Window

The Configuration window is the first window you see each time you start using the CLAS 4000. By default, the configuration window appears in the center of the screen when you run the CLAS 4000 application. If you have already closed the Configuration window and you want to open it again, select Show Configuration from the Control menu.

The Configuration window has two main parts (see Figure 4-1). The lower portion of the window tells you how many data boards are installed in the CLAS 4000. For each slot in the chassis, there is an icon area that either says 96 chnl data bd or Empty slot depending on whether or not there is a data board installed. If a slot has a data board installed that is not currently being used, the icon area will contain a board icon. If the board is assigned to the analyzer, the icon area has just a greyed box.

The upper portion of the window shows you how many data boards you are currently using in the analyzer and how many total channels are available.

![Configuration Window Image]

Figure 4-1. Configuration Window

In Figure 4-1, there are two data boards in the CLAS 4000 chassis. The board from slot A is being used in the analyzer, LA1, for a total of 96 channels. Slot B has another 96-channel data board that is not being used.
Assigning the data boards to the logic analyzer

You can assign additional boards to the logic analyzer by using the mouse to drag the board icons from the lower portion of the window up to the analyzer name in the upper portion. As you drag boards to and from the analyzer, a dialog box may appear asking you if you want to save the analyzer before adding/removing the board. If you click **yes**, the save window appears so you can save the current setup of the analyzer. See Chapter 10 for more information on saving setups.

You can assign all of your data boards to the analyzer as long as they are kept in contiguous order. For example, you could drag boards from slots B, C, and D up to LA 1 and have 288 channels, but you could not assign boards from slots A, B, and D to LA 1, and leave the board from slot C unused. Assigning more boards to a logic analyzer increases the number of usable channels, at a rate of 96 per board.

Various clocking schemes can reduce the number of available channels while increasing the memory depth. For example, in 10 ns and 5 ns internal clocking modes, the number of available channels per board is reduced by a factor of 2 and 4 respectively. In these modes, the sample memory depth increases by the same factors. Table 4-1 shows the relationship between sample rates, channel count, and memory depth. External clock signals must be included in the channel count, and Latch clocks can also affect the number of channels available. See Chapter 5 for more information on clocking modes.

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>1 Board</th>
<th>2 Boards</th>
<th>3 Boards</th>
<th>4 Boards</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤50 MHz Internal or External</td>
<td>96 Channels 4K Samples</td>
<td>192 Channels 4K Samples</td>
<td>288 Channels 4K Samples</td>
<td>384 Channels 4K Samples</td>
</tr>
<tr>
<td>100 MHz Internal or External</td>
<td>48 Channels 8K Samples</td>
<td>96 Channels 8K Samples</td>
<td>144 Channels 8K Samples</td>
<td>192 Channels 8K Samples</td>
</tr>
<tr>
<td>200 MHz Internal</td>
<td>24 Channels 16K Samples</td>
<td>48 Channels 16K Samples</td>
<td>72 Channels 16K Samples</td>
<td>96 Channels 16K Samples</td>
</tr>
</tbody>
</table>

**Table 4-1 Configuration Combinations.**

The channel reductions are actually done across each half of the data board, not across the whole board. For example, with a one-board analyzer in 100 MHz internal clock mode, you can use half of the channels. You can use any 24 channels out of the lower 48 and any 24 channels out of the upper 48. In 200 MHz mode, you can use any 12 channels from the lower half of the board, and any 12 channels from the upper half. Keep in mind that the whole board (in fact, the whole analyzer) must be clocked at the same rate. See Appendix E for description of State Measurements to 100 MHz.
If you intend to assign more than one board to the logic analyzer and sample data with an external clock, you must use a Multi-Module Clock Probe to synchronize the clocks to each board. See Chapter 12 for more information.

If you want to open a setup file from the hard disk into the CLAS 4000, you must configure the analyzer with the proper number of boards first. For example, if you want to load a setup that was created with two data boards, you must configure the analyzer with two boards before you can load the setup. See Chapter 10 for more information on saving setups.

**Machine Info**

Getting information about the logic analyzer

You can also use the **Info...** button to get information on the logic analyzer. Click on the board icons in the analyzer portion.
of the window. Select the analyzer and click the **Info...** button. The **Machine Info** window appears (see Figure 4-2).

![Machine Info Window](image)

The **Kind** item tells you how many channels are available in the current logic analyzer configuration.

The **Depth** item tells you the sample memory depth of the boards.

The **Where** item tells you the SCSI address (ID number) used by the CLAS 4000.

The **Slot(s)** item tells which slot(s) in the CLAS 4000 contain the date boards assigned to the analyzer.

The **Type** item tells you the current clocking mode used by the analyzer.

**Naming the logic analyzer**

The default name for the analyzer is "LA 1." You can change this name by clicking the **Default Name** checkbox to uncheck it. An editable text field appears around the default name. Change the name to whatever you want (see Figure 4-3). For example, it can reflect the data sampling method or the user's name. This name is saved on the hard disk in the setup file and is used whenever you load the setup. The name appears at the top of all the setup and display windows.

![Changing the Analyzer Name](image)
Chapter 5  Channel Setup

This chapter explains how to use the Channel Setup window to assign probe channels to groups so they appear in logical order in the State and Timing displays. You will learn how to define external clock schemes for State recordings, and how to specify the internal clock sampling rate for Timing recordings. Polarity, labeling, and display radix choices are also explained.

To open the Channel Setup window, pull down the Channel Setup menu and choose **LA 1: Next** (see Figure 5-1).

![Help Channel Setup...](image)

<table>
<thead>
<tr>
<th>LA 1:</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Last</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LA 2:</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Last</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LA 3:</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Last</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LA 4:</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Last</td>
</tr>
<tr>
<td></td>
<td>Reference</td>
</tr>
</tbody>
</table>

Figure 5-1. Channel Setup menu.

The first option in all the setup window menus is always a **Help** option. Selecting this option opens a Help window that provides information about using the window. The three remaining options are the setup windows for Next, Last, and Reference.

The term "Next" is used to describe the recording you are currently setting up. It is the next recording you will take on the CLAS 4000.

The "Last" recording is the one most recently taken. It shows the data captured the last time the CLAS 4000 took a measurement and the setup used to capture the data. Each time you take a new measurement, the Last data is replaced with the newly recorded data, and the Last setup is replaced with the Next setup that was used to record the data.

A "Reference" recording is one you have transferred from a Last recording or loaded from the hard disk. The Reference setup is used to record the Reference data. Reference data can be compared to the Last data. The data and setup are not replaced until you use the Transfer menu to put another Last recording into Reference or load data from the hard disk.

Normally, you will only work with the Next setup, since this is the setup that will be used to collect the next batch of data. You would only select Last or Reference setup windows if you wanted to observe the setup that was used to collect the Last or
Reference data. Since these recordings have already taken place, there is very little you are allowed to change in these windows.

For example, if the data in Last memory was collected with and external clock, the Last Channel Setup shows the external clocking scheme that was used, and there is nothing you can do to change it. If you want to use an internal clock for the next recording, you must change it in the Next setup. There are a few things that you can change in the Last and Reference Channel Setup windows. If the Last data is displayed in Hex, and you want to see it in binary instead, you can go to the Last Channel Setup window and change the radix. If you want future recordings to be displayed in binary also, you will have to change the radix in the Next Channel Setup window.

Once you have created a setup that you like, you can save it on the hard disk for future use. You can also use the options in the Transfer menu to create Next setups from the setups used to collect the Last or Reference data. See Chapter 10 for more information on saving and transferring setups.

Overview

Getting to know the Channel Setup window

The Channel Setup window is shown in Figure 5-2. The main part of the window contains the information about the channel groups. The groups, "Address," "Data" and "Status" are the default groups and are used as examples.

![Channel Setup Window](image)

Figure 5-2. Channel Setup Window

Each group column has several rows of information. The labels at the left of the window indicate the purpose of each row. The first and second rows contain the group's name, or label, and the display radix. The third row contains the Channels box which is used to assign channels to the group. The fourth row
has the polarity information, and the fifth row is used in external clocking mode to specify the latch or clock for each group. You can add, delete and insert groups to this channel format.

The State Display window uses the formats defined in this window to display the data. The Timing Display window shows the data from the individual channels in each group. The most significant channel from the left-most group will be at the top of the Timing Display window.

The top line of the window contains fields for specifying the sample clock. If you select external clocking mode, additional fields appear at the bottom of the window.

The right-most menu on the top menu bar is the Options menu for this window (see Figure 5-3). The menu is only available when the Channel Setup window is the current active window in the display. The Show Treshold option is described in the Threshold section of this chapter. The Color option is used to change the color of the selected group. The Inserting or Appending a new group of channels section of this chapter describes how to select a channel group.

Channel Groups

Changing a label for an existing group of channels

The cursor changes to an "I beam" when it is over the group label field. This is an indication that the field contains editable text (see Figure 5-4).

![Figure 5-4. Editing the group labels.](image)

There are three ways to change the group label: replace the entire label with a new one, replace part of the old label with new characters, and insert new characters into the old label.

To replace the entire label, click on the label to select it. Type the new label. Press <return> to complete the change.

To replace part of the old label with new characters, click on the label to select it. Select the characters you want to change by dragging across them with the cursor while you press mouse button. Type the new characters.
To insert new characters into the old label, click on the label to select it. Click again at the desired insertion point. Type the new characters.

**Inserting or appending a new group of channels**

To **append** a new group of channels to the list of groups, select the **Append** option from the **Edit** menu (see Figure 5-5). A new group named, "New Label," appears at the end of the list. You may add groups to the list even if they do not fit in the window. Use the scroll bar at the bottom of the window to scroll the window to the right.

![Sampling: Internal Address channels: A15-A00 polarity: +++++++++++++++++++](image)

Figure 5-6. Selecting a group column.

To **insert** a new group, first select any existing group column by clicking in the blank space directly above the label. The cursor becomes the plus symbol when it is over the correct place (see Figure 5-6). After clicking in this space to highlight the whole column, select **Insert** from the **Edit** menu to insert the new group to the left of the selected group. You can also make a copy of the highlighted group by selecting **Duplicate** from the **Edit** menu.

**Deleting an existing group of channels**

Select the group column as described in the previous section. Delete the group by pressing **Delete** key on keyboard.

**Changing the width of a group's column**

If you have many groups, you may want to make each column very narrow so you can fit more on the screen at one time. You can change the the width of a column by putting the cursor in between two group labels. The cursor becomes the spreader bars symbol when it is over the correct place. Hold down the mouse button and drag the column edge left or right as shown in Figure 5-7.
Figure 5-7. Changing the width of the group column.

Determining which probes and channels you are using

If you have ever worked with many probes at once, you probably have found yourself holding a probe and wondering which probe it is. One common solution is to trace the probe cable back to the analyzer to see where it is connected. Another solution is to get some tape and label each probe. This works fine until you accidentally connect the probes to the wrong connectors on the analyzer.

The CLAS 4000 offers a better solution. All the probes are identical and can be connected to the analyzer in any order. To determine which probe you have, hold down the blue membrane switch on the probe case. After a second, the Probe ID pop-up window appears on the computer screen telling you which channels are connected to the probe.

Each probe has twenty-four channels. A sticker on the probe case indicates which color flying leads correspond to which channel number. The sticker has four rows of information, one for each possible position of the probe in the four data board connectors.

The Probe ID feature does not operate if the probe is connected to the Probe Test connector or the Inputs dialog box is present on the screen. See the following section for information on the Inputs dialog box.

Assigning channels to a group

Once you have named your groups and connected the channels to your target board, you need to specify which channels belong in which group, and in what order.
Click on the Channels box for the group you want to define (see Figure 5-8).

The Inputs dialog box appears showing which channels are currently selected (see fig 5-9). The four main rectangles represent the four probes that can be attached to a data board. Each rectangle is an end view of the probe with 12 channels on the top and 12 channels on the bottom. The left-most probe has channels 00 through 11 on the top row and channels 12 through 23. The right-most probe has channels 72 through 95, etc.

The lower left corner of the dialog box contains a square icon for each data board assigned to the logic analyzer. If there is more than one board assigned, you can select different boards by clicking on the corresponding square icons. The four larger rectangles always represent the four probes for the selected board.

The currently selected channels are listed at the top of the window. The letter in front of each channel number in the list indicates which data board the channels is on. For example, the default configuration has channels A15-A00 assigned to the group "Address." The A in front of each number means that the channel is from data board A. The A does not stand for Address.

To select channels for the group, click on the little boxes representing each desired channel. As you select channels, they are added to the list at the top of the dialog box. Up to 32 channels can be assigned to each group. You can unselect a channel by clicking on it again, or click on the Clear All button to unselect all the channels.
When you highlight the channels for the group, you are also defining the order that you want them to be displayed. The first channel highlighted will be considered the most significant channel in this group. The last channel highlighted will be the least significant. For example, highlighting A07-A00 will make A07 the most significant channel. Highlighting A00-A07 will make A00 the most significant. The data collected for each group will be displayed in the State display with the most significant channel on the left and the least significant channel on the right.

Click on the OK button to leave the window and define the highlighted channels as the group. If you have made mistakes and you want to leave the window without changing the group's channel assignments, click on the Cancel button.

The channel designators for the selected inputs appear in the Channels box of the group's column (if there is room) with commas between those that are not adjacent.

**Collecting data from a multiplexed bus**

Many microprocessors have multiplexed address and data busses. The address and the data are present on the same channels, but at different times. To collect this type of data, you do not have to double probe the bus channels. You can assign the same exact set of channels to the two different groups, Address and Data.

In order to demultiplex the information, you need to sample the information on the channels at different times. For example, you need to latch the Address group information early in the microprocessor's instruction cycle and sample the Data group information at the end of the cycle. Additional information on how to clock these groups at different times is discussed in the *External Clocks* section later in this chapter.

When you assign a channel to two different groups, the data from the channel is stored in memory as if it were from two different channels. This uses up the sample memory in the data boards at twice the normal rate.

For example, if you demultiplex a 16 channel Address/Data bus, the Address information is stored in sample memory as 4K samples of 16 channels. The Data information is stored as 4K samples of another 16 channels. Therefore, you have used up 32 channels worth of the available 96-channel memory for that data board. There is only room for 64 more channels of information even though you only have 16 of the 96 probe leads connected.
You can only demultiplex 48 of the 96 channels on a data board. In fact, due to the internal architecture of the board, you can only demultiplex 24 of the lower (Left) 48 channels and 24 of the upper (Right) 48. However, you can pick any 24 of the 48 channels. Keep in mind that each external clock signal also uses up a channel.

Radix

Selecting the display radix for a group of channels

The second row in each group column contains the Radix field. Click on the radix to open a pop-up menu, and choose the new radix you wish to use (see Figure 5-10). The selected radix will be used to display the data in the State Display and the Trace Control Pattern Definition window. The Symbol radix is used to display user-defined symbols, or labels, whenever certain patterns are present in the data for that group. See the following section for more information on symbols.

![Figure 5-10. Selecting the Radix.](image)

Assign a radix setting that is logical for the number of channels in the group. For example, hex radix is most logical for channels in groups of four (four binary digits for each digit of Hex code). You can select any radix for any number of channels, and the CLAS 4000 uses the channels to create as many digits in the chosen radix as possible.

Symbolic Display

Displaying the symbol table

You can display the data from any group in a Symbol radix. This means that the State Display will substitute user-defined symbols for certain patterns in the data. It is especially useful to have labels like "Wait," "IOrad" or "memwr" in a Status column of the State Display instead of the raw Hex values (see Figure 5-11). You do not have to define symbols for all possible patterns that can occur in the group. If there are no symbols defined for a certain pattern in a group, the raw data will be displayed in Hexadecimal.
Chapter 5  Channel Setup

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000</td>
<td>F5F4</td>
<td>F7F6</td>
<td>F9F8</td>
<td></td>
</tr>
<tr>
<td>00001</td>
<td>E9E8</td>
<td>EBEA</td>
<td>EDCE</td>
<td></td>
</tr>
<tr>
<td>00002</td>
<td>DDDC</td>
<td>DFDE</td>
<td>Wait</td>
<td></td>
</tr>
<tr>
<td>00003</td>
<td>D1D0</td>
<td>D3D2</td>
<td>D5D4</td>
<td></td>
</tr>
<tr>
<td>00004</td>
<td>C5C4</td>
<td>C7C6</td>
<td>Data Rd</td>
<td></td>
</tr>
<tr>
<td>00005</td>
<td>B9B8</td>
<td>BBBA</td>
<td>Data Wr</td>
<td></td>
</tr>
<tr>
<td>00006</td>
<td>A9D4</td>
<td>AF9E</td>
<td>Fetch</td>
<td></td>
</tr>
<tr>
<td>00007</td>
<td>A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
<td></td>
</tr>
<tr>
<td>00008</td>
<td>9594</td>
<td>9796</td>
<td>I/O Rd</td>
<td></td>
</tr>
</tbody>
</table>

Figure 5-11. Symbols in the State Display.

To display the symbol table for a certain channel group, choose **Edit Symbols** from the Radix menu for that group as shown in Figure 5-12. The Symbol Table dialog box appears showing the symbols currently defined for this group.

Use the radix menu at the top of the window to specify the radix you want to use for defining the symbols (see Figure 5-13). This radix will also be used in the State Display for any patterns that do not have corresponding symbols.

The symbol table can be displayed in Hex even if individual bits are defined as x's. The resulting Hex character is a "Hex x" and is represented by the symbol x as shown in Figure 5-14. These characters indicate that some bits are x's, but not all of them. If all four bits were x's, the hex character would also be an x. Hex x characters are used other places in the CLAS 4000 software.

When you are finished with the symbol table dialog box, click the **OK** button to close the dialog box and return to the Channel Setup window. The radix for the group is automatically set to **Symbol** and symbols you defined will be used in the State Display. You can also click **Cancel** to close the window without implementing any of the changes you made.
Adding a symbol

To add a new symbol to the list, click the **Add** button. A new line appears in the list with the symbol name, "untitled," and the pattern defined as all X's (don't care). Enter the symbol name the same way you entered the names for the channel groups. Highlight one or more of the characters in the pattern to the right of the symbol name, and type the new value. If a symbol definition does not contain a 1, the value taken is Don't Care for the symbol.

Deleting a symbol

To delete a symbol from the list, click on the box to the left of the symbol name to highlight the entire line (see Figure 5-15). Click the **Delete** button to delete the symbol.

![Figure 5-15. Selecting a symbol from the list.](image)

Saving the symbol table

The symbol table is automatically saved with the rest of the setup when you select **Save** from the **File** menu. You can also save the symbol table separately on the hard disk for future use. Click the **Save** button in the Symbol Table dialog box. A Save dialog box appears that is very similar to the one used to save setup files. See Chapter 10 for a detailed description of how to use a Save window.

Symbol tables, like the one shown in Figure 5-16, that have been saved from the CLAS 4000 onto the hard disk can be edited from the desktop using standard text editing software packages. When you save the symbol table on the hard disk, it is saved as a file with the format shown in Figure 5-17.

![Figure 5-16. Symbol table created in the Symbol Table dialog box.](image)
The symbol file is a standard ASCII file that can be viewed and edited in a text editor. The file uses three columns to store the symbol table information. Figure 5-18 shows the same file with edit marks displayed. The small dot indicates a "space" character (ASCII code 20 Hex). The arrow indicates a "tab" character (ASCII code 09 Hex) which is used to separate the columns. The paragraph mark at the end of the line indicates a "carriage return" character (ASCII code 0D Hex).

The first column is the symbol label. This field is always ten characters long. If the label is less than ten characters, spaces are added to pad the field.

The second column contains the data value. The first two characters are always "0x" to indicate that the values are in Hex. The remaining characters are the Hex representation of the data values. Leading zeros are not included. For example, the "init_sub" symbol corresponds to the address value "200" Hex.

The third column contains a mask to indicate which bits in the data value are used, and which are x's ("don't care's"). If the symbol value contains no x's, the third column can be omitted. The first two characters are always "0x" and the field has the same number of bits as the data field in the second column. A value of "1" means that the corresponding bit in the data field is used as part of the symbol specification. A value of "0" means that the corresponding bit in the data field is ignored and this bit is an "x" in the symbol table.

For example, the "port 0" and "port 1" symbols have "fff00" as their masks (see Figure 5-17). The most significant eight bits of the data value are used as part of the symbol specification because the mask contains eight 1's ("ffe" in Hex). The least significant eight bits of the data value are ignored. These bits are x's in the symbol table.

The "tab" delimiters between the columns allow the file to be easily imported into data bases and spread sheets.
The symbol tables can also be created in binary format as shown for the "Status" group in Figure 5-19. Binary format allows you to edit each bit individually and specify x's for certain bits.

The saved symbol file uses the same format as before and is shown in Figure 5-20. The data and mask values are stored in Hex even though they were defined in Binary.

In the original symbol table shown in Figure 5-19, the symbol "idle" is defined as "1x1x". Two of the bits are x's so the mask for this symbol has "0's" corresponding to those bits. The other two bits are defined, so the mask will contain "1's" in those bit locations. The Binary representation of the mask is "1010," so the Hex value is "A" (see Figure 5-20). Only the first bit in the symbol "Reset" is defined, so the mask is "1000" ("8" in Hex).

**Loading the symbol table**

You can load an existing symbol table from the hard disk into the Symbol Table dialog box by clicking on the Load button. A Load dialog box appears that is very similar to the one used to load setup files. See Chapter 10 for a detailed description of how to use a Load window.

You can load a symbol table even if you already have a list of symbols in the Symbol Table dialog box. The loaded table is appended to the existing list.

Symbol tables can be loaded for each channel group in the channel setup window. The number of bits in the symbol table data values is the same as the number of channels in that group. A 16-bit channel group has symbols with 16-bit data values. You should only load symbol tables that have the correct number of bits, but you can load the table even if it does not. The symbol values are adjusted to make them the right width. If the table has too few bits, leading x's are added to the data values. If the table has too many bits, the most significant bits are truncated.
Importing symbol tables from other sources

The symbol table file format was discussed in detail in the Saving the symbol table section of this chapter. Any symbol table files can be loaded into the Symbol Table dialog box as long as they have this format. The tables do not need to be created in the CLAS 4000 software. They can be written from scratch in a text editing program. If you use a text editor that is also a word processor, make sure that the file is saved in a "text only" mode so that formatting characters are not included.

The files can also be imported from a software development station's linker output. For example, you write code for your target system that you then compile and link. The output of the linker usually includes the microcode that you burn into PROM's and a symbol table that contains all the symbols you used when you wrote the code. Your target board runs the code in the PROM's.

You can connect the CLAS 4000 to the address and data busses of your target board and watch the code execute. The format of the symbol table output from the linker should be very similar—if not identical—to the CLAS 4000 symbol table format. Load the symbol table into the CLAS 4000 for the address group and select "symbol" radix. The symbols are displayed in the address column of the State Display. Your source code symbols can be used to debug your target.

Polarity

Changing the polarity of a channel for the State display

Your target system may have signals which are active low. The signals are at a voltage level below the threshold when they are true, and above the threshold when they are false. When you look at the data in the State Display, you must look for zeros on these signals to find where they are true. By changing the polarity, you can change the way these signals are displayed in the State Display.

The fourth row in each channel group's column in the Channel Setup window contains the polarity field. There is a "+" or "-" character for each channel in the group. The characters are arranged with the most-significant on the left and the least significant on the right. If the group column is very narrow, or the group contains many channels, you may not be able to see all the "+" and "-" characters in the polarity field. To see all the characters in the field, you can change the width of the column. See the Changing the width of a group's column section of this chapter.
To change the polarity, highlight the "+" or "-" character(s) in the polarity field that you want to change by clicking on a character or dragging across a group of characters. Type a "-" or "1" for negative polarity, or type a "+" or "0" for positive polarity (see Figure 5-21).

![Polarity](image)

**Figure 5-21. Specifying the polarity of a channel.**

Changing the polarity only affects the way the data is displayed in the State Display. The timing display always shows the data in positive polarity. The patterns in the Trace Control Pattern Definition window also assume positive polarity.

### Thresholds

**Assigning thresholds to probes**

The default threshold for all channels is TTL. Any signal detected above 1.4 Volts is considered High, and below 1.4 Volts is Low. You may want to change the threshold levels for the probes if, for example, your data is ECL.

To open the Threshold dialog box, select **Show Threshold** from the Options menu or click on the threshold icon on the left side of the Channel Setup window (see Figure 5-22).

![Threshold](image)

**Figure 5-22. Threshold icon in Channel Setup window.**

The Threshold dialog box appears as shown in Figure 5-23. In the center of the window is a large rectangular shape with a pop-up menu in the top half and the bottom half. This shape represents the end of a data probe. To determine which probe is currently represented, look at the left and bottom of the dialog box. On the left side, there is an icon for each data board. The selected icon indicated which board contains the probe. On the bottom of the dialog box, there is an icon for each of the four probes on the selected board.
Figure 5-23. Threshold dialog box.

The rectangular shape in the center of the dialog box can only represent one probe at a time. To switch to another probe, click on a different board and/or probe icon. To switch to another board, click on the desired board icon on the left of the dialog box.

To change the threshold for the bottom or top half of the probe, click on the corresponding pop-up menu and select the new threshold (see Figure 5-24).

Figure 5-24. Selecting a new threshold.

Using variable thresholds

In addition to the TTL (1.4V) and ECL (-1.3V) thresholds, there are several variable thresholds, \( \text{VAR T}, \text{VAR A}, \text{VAR B}, \text{VAR C}, \) and \( \text{VAR D}. \) Some of the variable threshold choices may be disabled (greyed) depending on the number of boards configured for the analyzer. \( \text{VAR T} \) is a global threshold and always available. Threshold \( \text{VAR A} \) through \( \text{VAR D} \) are only available if the analyzer is configured to include data board A.
through D respectively. In the example in Figure 5-26, the analyzer is configured for data board A only, so VAR B, VAR C, and VAR D are all disabled.

To set the voltage level of a variable threshold, click on the corresponding threshold button at the top of the dialog box (see Figure 5-26). A new dialog box appears like the one shown in Figure 5-27.

![Variable Threshold dialog box](image)

**Figure 5-27. Variable Threshold dialog box.**

You can use the Variable Threshold dialog box to change the threshold name and voltage level. The threshold voltage can be set to ±10 Volts in 10 mV steps.

### Clocking Techniques

**Determining the best clocking scheme for your data**

The first step in setting up the clocking scheme for your measurement is to decide which clocking method best suits your needs. If you want to make a state measurement and sample data synchronously with your target, you must use an external clock to tell the CLAS 4000 when to sample. You can use a combination of signals or a single channel as the external clock, and you can collect data at a rate of up to 50 MHz. See the *External Clocks* section of this chapter and Chapter 12 for more information on external clocking.

If you want to make a timing measurement and sample data asynchronously with your target, you must use an internal clock. The standard internal clock rates are from 50 ns clock period to 500 ms. There are also three special internal clock modes with sample periods of 20 ns, 10 ns, and 5 ns. The 10 ns and 5 ns modes use interlacing techniques which increase the sample memory depth and decrease the available channel count. See the following section for more information on internal clocks.
Using standard internal clocking mode

To use one of the standard internal clock rates, choose **Internal** from the **Sample Clock** pop-up menu in the upper left corner of the Channel Setup window (see Figure 5-28). This specifies normal internal clocking mode. To set the sample rate, open the pop-up menu for **Internal Rate** in the upper right corner of the window and make the desired selection (see Figure 5-29).

![Figure 5-28. Selecting normal internal clocking mode.](image)

The rate you choose appears in the **Internal Rate** box and appears in the lower left corner of the Timing display.

### Using 20ns, 10ns, and 5ns clocking modes

If you want to sample faster than 40 ns, select one of the three high-speed clocking modes from the top of the **Internal Rate** pop-up menu (see Figure 5-30). **Internal at 20 ns** permits you to sample at a rate faster than the highest time stamp resolution.

![Figure 5-30. Selecting special internal clocking modes.](image)

The **Internal at 10 ns** mode is similar to the 20 ns mode except it uses interlacing techniques to double the sample rate. The memory depth is also doubled to 8K samples, but only half the channels on the 96-channel data board can be used. The interlacing is actually done across each half of the data board, not across the entire board. In 10 ns mode, you can use any 24 of the lower 48 channels on a data board, and any 24 of the upper 48.

The **Internal at 5 ns** mode is similar to the 10 ns mode except the sample rate and memory depth are doubled again. In 5 ns
mode, you can use any 12 of the lower 48 channels, and any 12 of the upper 48. The memory depth in this mode is 16K samples.

In choosing the clock rate, keep in mind the general rule that to obtain a waveform of samples that closely resembles the original waveform, you should sample at 5-10 times the frequency of the original waveform. For example, you want to monitor changes happening every 100 ns, you should choose an internal rate of 10-20 ns.

External Clocks

Selecting external clocking mode

To use an external clock to sample your data, select External from the Sample clock: menu in the Channel Setup window (see Figure 5-31). In this mode, several new fields appear at the bottom of the window. These are used to define the external clocking scheme and are explained in the following sections.

![External](image)

Figure 5-31. Selecting external clocking mode.

Selecting the external clock for each group

In the simplest external clocking case, all data in all the channel groups is sampled at the same—at the rising edge of a clock signal. In this case, that clock signal would be considered the Master Clock, and would be used as the clock for all the groups. At the bottom of each channel group's column is a new field called Clocked by. Clicking on this field opens a pop-up menu with four options (see Figure 5-32). The default is to have every group clocked by the Master Clock. In external clocking mode, each channel group must be clocked by either the Master Clock or a Latch Clock.

The Latch Clock options in the Clocked by menu are used for other applications that require more complex clocking schemes. The Latch Clocks temporarily save data that may no longer be valid when the Master Clock occurs.
Figure 5-32. Selecting the external clock for a channel group.

For example, a microprocessor usually has Address and Data information in each clock cycle. As you collect data using an external clock, you expect to see one sample containing Address and Data information for each cycle.

Unfortunately, the Address is often valid at the beginning of the cycle, and the Data is valid at the end. In this case, you need to latch the Address with a Latch Clock early in the cycle, and hold the information until the Data is valid. At the end of the cycle, you sample the Data with the Master Clock. At this time, the Data information and the latched Address information can be moved into the CLAS 4000 sample memory as a single sample. Even though the Address is latched prior to the Data being sampled, both appear on one line in the State Display.

The Latch Clocks are only used to save data until the Master Clock occurs. They do not actually move data into the CLAS 4000 sample memory. If a second Latch Clock occurs before a Master Clock, the first data is overwritten in the latch.

In the Address/Data example, Latch 0 could be specified in the **Clocked by** field for Address, and Master Clock could be used for Data and Status as shown in Figure 5-33. This same procedure would be used to collect Data and Address from a multiplexed bus. See the **Collecting data from a multiplexed bus** section of this chapter for more information on assigning channels.

**Defining the Master and Latch clock equations**

Once you have assigned a Latch or Master Clock to each channel group, you must define the clock equations. The clocks can be a single channel or a combination of channels. In the lower portion of the Channel Setup window are four long bars labeled, **MASTER CLOCK =, LATCH 0 =, LATCH 1 =**, and **LATCH 2 =**.
These bars are used to display the clock equations. The default setup has no clock equations defined and therefore the right side of each bar is blank. The left end of the bar contains the clock name.

You may rename any clock expression by clicking on the name, but the clock on the bottom bar always functions as the Master Clock. In this context, the Master Clock is the one that moves any data sampled by the Master Clock and any data sampled by any of the Latch Clocks into the CLAS 4000 sample memory.

To define the clock equations, click to the right of the equal sign on the bar (see Figure 34). The Clock Definition dialog box appears with the name of the clock you chose, and a schematic-style representation of the clock equation (see Figure 5-35).

There are 6 possible clock inputs shown at the far left. The top three can be AND'ed, and the bottom three can be OR'ed. The results of the AND's and OR's are OR'ed in the final OR gate on
the right. In this way, the six inputs are combined by using standard AND and OR logic. Channel groups assigned to this clock are sampled at the rising edge of the final OR gate's output.

The default equation has no clock inputs connected to the logic gates. To connect an input, click on the open switch icon to the right of the desired input name. A pop-up window opens with three choices (see Figure 5-35). The top choice is an open switch and disconnects the input from the gates. The middle choice is a closed switch and connects the input. The bottom choice inverts the input signal before connecting it to the gate.

As you connect clock inputs to the gates, the resulting clock equation is displayed at the top of the window.

You can change the name of the clock by typing over the old name on the far right. This is equivalent to changing the clock name at the left end of the bar in the Channel Setup window.

💡

Before you leave the Clock Definition dialog box, you must define the channels to be used as the clock inputs as described in the next section. After doing that, however, you can click OK or Cancel to leave the window. As always, OK saves your changes, Cancel does not. When you return to the Channel Setup window, the new clock equation, if any, appears in the bar for that clock (see Figure 5-36).

![Figure 5-36. Clock equation displayed in the Channel Setup window.](image)

Figure 5-36. Clock equation displayed in the Channel Setup window.

**Defining the clock inputs used in the clock equations**

Each clock input used in the Clock Definition dialog box is an actual channel on one of the probes. You must define which channel you want to use for each input in the equation in order for the equation to be meaningful. Click on the button containing the input name at the far left of the dialog box as shown in Figure 5-37. The Clock Input dialog box appears. It is identical to the Inputs dialog box described in the Assigning channels to a group section of this chapter except only one
channel can be assigned as the clock input. Selecting a new channel unselects the old one (see Figure 5-38).

![Figure 5-38. Clock Inputs Dialog Box](image)

The clock input name can be changed by typing over the old name at the top. The name for the clock input will appear in the Clock Definition dialog box.

To leave the window and return to the Clock Definition dialog box, click **OK** or **Cancel**.

If you have more than one data board assigned to the logic analyzer, see Chapter 12 for more information on external clocking with multiple data boards.

**Setting the Time Stamp resolution**

In external or special internal clocking mode you have the opportunity to change the Time Stamp resolution. As you collect data, each data sample is marked with a Time Stamp indicating when it was sampled relative to other samples. This information can be displayed in the State Display.

The maximum resolution of the Time Stamp is 40 ns. In this mode, the 16-bit Time Stamp counter increments its count every 40 ns. By keeping track of the number of times the Time Stamp counter increments and knowing that each count represents 40 ns, the CLAS 4000 software can determine how much time has gone by between samples.

If you are collecting data very slowly or you are measuring long periods of time, you may not need 40 ns resolution. For example, if you are sampling data at 50 MHz, but only saving samples that are "Write" instructions to Port 51, the sample memory would be filled exclusively with "Write" instructions to Port 51. These samples may occur several microseconds apart, and the 4K samples in memory would represent several milliseconds of time. In this case, a Time Stamp resolution of 1 microsecond may be sufficient.
To change the Time Stamp resolution open the **Time Stamp** menu in the upper left corner of the Configuration window and select the desired rate (see Figure 5-40). The range is from 40 ns to 500 ms.

If two samples occur within 40 ns of each other, the time between them cannot be measured even with the maximum time stamp resolution. The Time Stamp software recognizes this condition and can interpolate the Time Stamp values. See the *Window Format* section of Chapter 9 for more information on Time Stamp interpolation.
Chapter 6 Trace Control Setup

This chapter explains how to use the Trace Control Setup window in Predefined mode to define the triggering scheme for your next recording. By using the proper triggering setup, you can trigger on elusive or intermittent faults in your target system and filter out unwanted data. To open the Trace Control Setup window, select Next from the Trace control menu (see Figure 6-1). For a general description of the four options in a setup menu, see the beginning of Chapter 5. See Chapter 11 for more information on advanced uses of Trace Control.

Figure 6-1. Opening the Trace Control Setup Window

Overview

Getting to know the Trace Control Window

The Trace Control Setup window is shown in Figure 6-2. The default setup has the Trace Control window in Predefined mode. The Fill Memory Task is selected and appears with its illustration in the center of the window.

Figure 6-2. Trace Control Window
The menu bar includes a menu called Trace Ctl (see Figure 6-3). This is the options menu for the Trace Control window, and is only available when the Trace Control window is the current active window.

![Trace Ctl Menu]

Determining the best Trace Control mode for your application

You can use the Trace Control Setup window in two different modes. The Predefined mode provides a list of Trace Control macros, or Tasks, that you can use to solve all of your simple triggering applications. The list of Tasks is designed to provide common triggering scenarios that you can use as your Trace Control setup.

The Predefined Tasks are macros created from low-level language steps. All the steps are hidden, and only the main parameters need to be selected. The Predefined Tasks do not cover all possible triggering applications, however. You may need to build your own setups out of the low-level language steps.

Full Feature mode provides you with the list of steps that you can combine with other steps or Tasks to create the desired triggering scheme.

To determine which Trace Control mode to use, first become familiar with all the predefined Tasks. If your application matches one of the Task scenarios, you can use Predefined mode. Otherwise, you can use Full Feature mode to solve your problem.

You can select the desired mode from the Trace Ctl menu on the menu bar. This chapter explains how to use Trace Control in Predefined mode. A detailed explanation of Full Feature mode can be found in Chapter 11.
Predefined Tasks  Viewing the full selection of Predefined Tasks

To view the list of Predefined Tasks, click on the Tasks menu in the upper left corner of the Trace Control window (see Figure 6-4). Selecting a Task from the list changes the Trace Control setup to the chosen task. Each Task has an illustrated example to help you understand its purpose.

<table>
<thead>
<tr>
<th>✓ Fill Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Condition Trigger</td>
</tr>
<tr>
<td>Simple Edge Trigger</td>
</tr>
<tr>
<td>Store 'n' = Samples</td>
</tr>
<tr>
<td>Tight Sequence Trigger</td>
</tr>
<tr>
<td>Loose Sequence Trigger</td>
</tr>
<tr>
<td>End of Loop Trigger</td>
</tr>
<tr>
<td>Pulse Train Trigger</td>
</tr>
<tr>
<td>Interval Limits</td>
</tr>
<tr>
<td>Store/Time A Segment</td>
</tr>
<tr>
<td>Stable Trigger Filter</td>
</tr>
</tbody>
</table>

Figure 6-4. Task menu.

Selecting a simple Task

A complete catalog of all the Predefined Tasks is included at the end of this chapter. The catalog includes a description of the capabilities and purpose of each task as well as a picture of the Task itself.

Refer to the catalog to learn the details of all the Tasks. The Simple Condition Trigger Task is used as an example in this section to demonstrate the theory of using Predefined Tasks for simple triggering and some of the common features in the Tasks.
The Simple Condition Trigger Task is shown in Figure 6-5, and is used to trigger on a single event. The Task has three separate elements: Store, Search, and Fill. These three elements are explained in the following sections. All the boxed fields are parameters that you can change. You can also change the name of the task by typing over the default name.

**Step #1**  
Store, filtering input to \( \text{Pattern 1} \)  
Until a sample is \( \text{Pattern 1} \)  
Then store 2048 more filtered inputs (2 to 65535)  
(2048 would be 50 percent of 4K memory = center trigger).  
Then \( \text{Stop} \)

**Figure 6-5. Simple Condition Trigger.**

Using the Store element

The Store element, "Store, filtering input to...," appears on the first line and is used to filter out unwanted data. Only data samples that match the specified condition are stored in sample memory.

The only parameter you can change in the Store element is the store condition. The default condition is a pattern named \( \text{Pattern 1} \). The X's you see are actually the name of the pattern, but the pattern happens to be defined as all X's and is used as the "don't care" pattern. In the illustrated example, samples matching the "don't care" pattern are stored. Since any sample matches a "don't care," this setup stores everything. Most of the time you probably want to save all the data that is collected, to you can leave this Store element unchanged.

If you want to filter your data, you can change the store condition parameter. For example, if you are debugging a certain I/O port, you may want to store only reads and writes to that I/O address. All other data is thrown away, and the entire sample memory contains only the desired samples. To change the parameter, click on the parameter field and select a new pattern or condition from the list in the pop-up menu. This is the same type of pop-up menu that you use to change the Search condition and it is explained in more detail in the following section.
Using the Search element

The Search element, "Until a sample is...," appears on the second line of the task and is used to find a certain event or condition. The CLAS 4000 triggers when the condition is found.

You can change two parameters in the Search element. The "is" can be changed to "isn't" and the Search event can be changed to different events. In the example, the search event is set to Pattern 1.

To change the trigger condition, click on the Search event parameter. A pop-up menu appears with a list of conditions as shown in Figure 6-6. This list includes the "don't care" pattern and fifteen other patterns named Pattern 1 through Pattern 15. You also have the ability to specify the event as a group of patterns OR'ed together or a range of values for a certain channel group (see Chapter 11 for more information on ranges and OR groups).

Selecting a new pattern, like Pattern 1 is only part of the process. You also have to define Pattern 1 itself. The Pattern Definition section of this chapter describes this topic in detail.

Using the Fill element

The Fill element, "Then store [2048] more filtered inputs," appears on the third line of the Task and is used to position the trigger point in memory. You can change the parameter by typing a new number over the old one, or clicking on the up/down arrows to the right of the field. A detailed description of this concept is described in the Trigger Placement section of this chapter.
Getting an overview of the Tasks

The Simple Condition Trigger Task was used as an example to help you become familiar with the Store, Search, and Fill elements in a Task. All of the tasks contain one or more of these elements. Use Table 6-1 to get familiar with the different tasks. The first column contains a list of the Tasks. The second, third, and fourth columns summarize the capabilities of the Store, Search, and Fill elements.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Store</th>
<th>Search</th>
<th>Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Memory</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a single event to be true</td>
<td>fill 4096 samples then stop</td>
</tr>
<tr>
<td>Simple Condition</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a single event to become true</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Simple Edge</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a single event to become true</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Store 'n' Samples</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a sequence of three events to occur on three contiguous samples</td>
<td>fill &lt;n&gt; samples then stop</td>
</tr>
<tr>
<td>Tight Sequence</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a sequence of three events to occur on three contiguous samples</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loose Sequence</td>
<td>Store if &lt;condition&gt;</td>
<td>search for a sequence of three events to occur with no limits on the time between them</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End of Loop</td>
<td>Store if &lt;condition&gt;</td>
<td>search for the absence of one pattern immediately after another (e.g. end of loop not followed by start)</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse Train</td>
<td>Store if &lt;condition&gt;</td>
<td>search for the nth time a segment begins; the end of the segment can also be specified</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interval Limits</td>
<td>Store if &lt;condition&gt;</td>
<td>search for an event to occur too early or too late after another event</td>
<td></td>
</tr>
<tr>
<td>Store/Time a</td>
<td>Store if &lt;condition&gt;</td>
<td>search for initial event, then start of segment, then end of segment; segment is timed (see Timer Info)</td>
<td></td>
</tr>
<tr>
<td>Segment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stable Trigger</td>
<td>Store if &lt;condition&gt;</td>
<td>search for an event to be true for &lt;n&gt; consecutive samples</td>
<td>post-trigger fill &lt;n&gt; samples</td>
</tr>
<tr>
<td>Filter</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 6-1. Overview table of Tasks.

Pattern Definition

Selecting trigger patterns in Trace Control levels

As you create your Trace Control setup, you specify events or patterns as the store or trigger conditions. For example, in the Simple Condition Trigger Task, you can specify Pattern 1 as the trigger event by clicking on the parameter field in the second line of the Task and selecting Pattern 1. You can also select ranges and OR groups as the trigger events. These are explained in Chapter 11. The following section explains how to define the bit patterns corresponding to each pattern name.

Getting to know the Pattern Definition window

To see a list of patterns and their current definitions, select Show Patterns from the Trace Ctrl menu on the menu bar (see
Figure 6-7). You can also open the window by clicking on the Patterns icon in the upper left section of the Trace Control window (see Figure 6-8). Either method opens the Trace Control Pattern Definition window as shown in Figure 6-9.

The Pattern Definition window is considered a window, not a dialog box, because it has a scroll bar and Close box, and you can leave it open while you work in other windows. The top part of the window has the names of all the channel groups that are defined in the Channel Setup window.

The top part of the window also contains fields that are used to setup Glitch and Transition detection. See Chapter 11 for a complete explanation of these features.

The lower section of the window is used to name and define the sixteen patterns. By default, the first pattern is called "\texttt{HHHHHHHHH}," and is used as the "don't care" pattern. This pattern should always be defined as all x's, though it can be used as a regular pattern.
Changing the radix

Below each group name is a pop-up menu allowing you to change the radix of the group. Changing the radix in this menu is equivalent to changing it in the Channel Setup window.

Naming patterns

To rename a pattern, select part or all of the old pattern name and type a new one. The pattern names appear in the trigger event pop-up menus in the Trace Control window.

Defining patterns

To the right of each pattern name is a row of characters representing all the channels in the different channel groups. The number of characters for each column is a function of the number of bits in the channel group and the display radix.

To change the definition of a pattern, highlight the character you want to change and type the new value. You can only enter values that make sense for the current radix. For example, if the group's column is displayed in Binary, you can type 0, 1, or x. For a Hex column, you can type 0-F.

The "x" is the "don't care" character and it can represent from one to four bits depending on the current radix. Type an "x" to change a selected character to "don't care." Double-clicking on a character also changes it to an "x."

To make individual bits "don't care," you can change the group's radix to binary and type x's for the desired channels. The group can be displayed in another radix, like Hex, even if individual bits are defined as x's. The resulting Hex character is a "semi-care" and is represented by the symbol $ as shown in Figure 6-10. These characters indicate that some bits are x's, but not all of them. If all four bits were x's, the hex character would also be an x. Semi-care characters are used other places in the CLAS 4000 software.

To change several characters at once, highlight a block on characters in a column and type the new value.

Keep in mind that if you chose negative polarity in the Channel Setup window, the polarity of the channel is changed in the State Display. The Timing Display still considers any signal that is
more positive than the threshold as a "1." This means that pattern definitions must be specified with the same polarity as the data in the State Display, not the Timing Display.

Using symbols in pattern definition

The Pattern Definition window supports all the radices including the **Symbol** radix. If you are using symbols for a particular channel group, you can define patterns for that group in terms of the symbols. Click on any row in that group's column to highlight the symbol location. An *Edit* button appears in the upper left part of the window. Click on the *Edit* button to open the Symbol Selection Table dialog box (see Figure 6-11).

The dialog box contains a list of all the symbols defined for that group. Highlight the desired symbol and click the *Select* button. You return to the Pattern Definition window and the new symbol is used for that pattern.

You are not limited to the values represented by the symbols. You can define the pattern for that group to any value by momentarily changing the radix from **Symbol** to something else. Type in the desired pattern and change the radix back to **Symbol**.

**Trigger Placement**

Setting the trigger position in memory

When you arm the CLAS 4000, it flushes out the old data from sample memory replacing it with all zeros. The analyzer then starts collecting new data samples and storing them in the 4K memory. When the memory is full, the oldest samples are overwritten. The analyzer can run indefinitely, overwriting the oldest data and always saving the most recent 4096 samples. When you look at the data in the Timing or State displays, the oldest sample is labeled sample 0000, and the last sample recorded is sample 4095.

You can control the location of your trigger event in sample memory by specifying the number of samples to be recorded after triggering. This post-trigger fill can be used to save as many post-trigger samples as desired. For example, if you set up the analyzer to fill 10 samples after triggering, the trigger event will end up at sample 4085. Samples 0000-4084 are pre-trigger data, and 4086-4095 are post-trigger.

If you specify a post-trigger fill of 4000 samples, the trigger event will be at sample 0095. By adjusting the fill, you can place your trigger point anywhere in the sample memory.
In Predefined Trace Control mode, most of the Tasks have a field for specifying the post-trigger fill (see Figure 6-12). To change the fill value, type a new value over the old one, or use the up/down arrows.

Figure 6-12. Setting the post-trigger fill.

Keep in mind that the analyzer begins searching for the trigger event immediately. If the event is found very soon and the post-trigger fill is set to a small number, a significant portion of the sample memory may still be set to zero. For example, if you set the post-trigger fill for 10 samples, and the trigger event is found on the 57th sample taken by the analyzer, only 67 data samples will be saved. Samples 0000-4028 will still contain the zeros from the data flushing.

The 10 ns and 5 ns clocking modes increase the memory depth to 8K and 16K samples. To put the trigger event in the center of memory when using one of these modes, you would need to set the post-trigger fill to 4096 and 8192 samples respectively. See the Internal Clocks section in Chapter 5 for more information on these clocking modes.

Catalog of Predefined Tasks

Learning each task

This section is designed to provide you with detailed information about each Task. In the catalog on the following pages, each Task is shown as it appears in the Trace Control window with an example of how it is used.
FILL MEMORY

Step #1: Store only if input is "AAAAAAA". Fill memory, then [Stop].

Benefit: Fill the CLAS 4000 memory with data from the target system. This Task just takes a snapshot of whatever is out there, and does not search for any particular events. This is very useful for checking to see if the target system is running and if the logic analyzer is connected properly.

Data Stored: The CLAS 4000 Trace Control will take a sample on the first clock edge and then fill the sample memory with the next 4096 samples. A total of 4097 samples are taken, and the first one is not saved. Incoming data can be filtered by specifying a pattern in the Store element on the first line.

SIMPLE CONDITION TRIGGER

Step #1: Store, filtering input to "AAAAAAA" until a sample is "Pattern 1".
Then store 2048 more filtered inputs (2 to 65535) (2048 would be 50 percent of 4K memory = center trigger). Then [Stop].

Benefit: Allows you to store data around a specific trigger event or pattern. You can also search for the event to be false by selecting isn't instead of is on the second line.

Data Stored: The CLAS 4000 Trace Control will store data until Pattern 1 is found. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.
SIMPLE EDGE TRIGGER

BENEFIT: Allows you to store data around the edge transition of a specific pattern or condition. Searches for a pattern or condition to go true. If it is already true, it must go false and then true again. You can also search for the event to go false by selecting isn't instead of is on the second line.

DATA STORED: The CLAS 4000 Trace Control will store data until Pattern 1 changes from false to true. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.

STORE 'N' SAMPLES

BENEFIT: Allows you to store a certain number of samples that contain the specified pattern. For example, you can store 100 writes to a memory location.

DATA STORED: The CLAS 4000 Trace Control will store only the samples which match the condition defined on the second line. Stop after storing the specified number of these samples. You can store samples that do not contain a pattern by selecting isn't instead of is on the second line. If more than 4096 samples are requested, only the most recent 4096 are saved.
**Chapter 6 Trace Control Setup**

**TIGHT SEQUENCE TRIGGER**

**BENEFIT:** Find a certain multi-fetch instruction. The CLAS 4000 triggers when it finds the exact sequence of events on adjacent samples.

**DATA STORED:** The CLAS 4000 Trace Control will store data until the continuous sequence, Pattern 1, Pattern 2, Pattern 3, is found. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line. The CLAS 4000 will not trigger on Pattern 1, Pattern 2, Pattern 1, Pattern 2, Pattern 3.

---

**LOOSE SEQUENCE TRIGGER**

**BENEFIT:** Find a sequence of events that occur over a period of time. There is no time limit between events. For example, after the first event is found, the CLAS 4000 searches for the second event no matter how long it takes.

**DATA STORED:** The CLAS 4000 Trace Control will store data while it searches for the first event, then searches for the second, then the third. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.
**END OF LOOP TRIGGER**

**BENEFIT:** Allows you to trigger when the target software exits a loop. The CLAS 4000 watches for the end-of-loop pattern to not be followed by the start-of-loop pattern.

**DATA STORED:** The CLAS 4000 Trace Control watches for the start-of-loop pattern, then watches for the end-of-loop pattern. If the next sample is not the start-of-loop pattern again, the target software has exited the loop and the CLAS 4000 will trigger. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.

---

**PULSE TRAIN TRIGGER**

**BENEFIT:** Allows you to find the nth occurrence of a particular sub-routine or sequence of events.

**DATA STORED:** The CLAS 4000 Trace Control will store data while it searches for the initial condition. After that, it watches for the start of the cycle and then the end of the cycle. The CLAS 4000 will trigger after the specified number of cycles have been recorded. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.
INTERVAL LIMITS

BENEFIT: Allows you to trigger on a timing violation. Trigger when an event occurs too early or too late.

DATA STORED: The CLAS 4000 Trace Control watches for the start of the interval, then it watches for the end of the interval. If the end occurs outside the valid time range, the analyzer will trigger. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops. Incoming data can be filtered by specifying a pattern in the Store element on the first line.

STORE/TIME A SEGMENT

BENEFIT: Allows you to store the data between two events. The time between the events is measured and can be seen under “Timing Info” in the Timing Display Options menu.

DATA STORED: The CLAS 4000 Trace Control searches for the initial condition and the start of the segment. After that, it starts the timer while it watches for the end of the segment. The CLAS 4000 will trigger and stop when the end of the segment is found. Incoming data can be filtered by specifying a pattern in the Store element on the first line.
STABLE TRIGGER FILTER

BENEFIT: When making asynchronous recording, triggering on noise or data present during transitional periods is undesirable. This task will prevent a trigger on unstable data.

DATA STORED: The CLAS 4000 Trace Control watches for the specified pattern to occur. If the pattern is present for the desired number of samples, the analyzer will trigger. After the trigger, the specified number of post-trigger samples are stored before the analyzer stops.
Chapter 7  Arm Control Setup and Run Control

The majority of this chapter explains how to use the Arm Control Setup window to specify the run mode for the analyzer. Various rearm techniques are described for taking repetitive recordings. You can set up the analyzer to Run repetitively forever, or until a certain condition is found. The data collected in Last memory can be automatically compared to the Reference data. Rearming the analyzer can be conditional based on the results of the comparison. The Last data can also be automatically saved on the hard disk.

If you just want to make a standard single-shot recording, you can leave the Arm Control Setup window in its default configuration and just use the Run menu to arm the analyzer and initiate the recording. The Run menu is discussed later in the chapter along with the Status window.

To open the Arm Control Setup window, pull down the Arm Control Setup menu and select Next (see Figure 7-1).

For a general description of the four options in a setup menu, see the beginning of Chapter 5.

Using the comparison features in this window requires that meaningful data be present in both the Last and Reference memories. See Chapter 10 for an explanation of how to load or transfer data into Reference memory.

Overview  Getting to know the Arm Control Window

The Arm Control Setup window is shown in Figure 7-2. The default setup has all the rearm options disabled. In this mode, initiating a Run from the Run menu results in a standard single-shot recording. The window is virtually empty until you enable some of the rearm options. As you select some options, more fields appear. Selecting options in these fields make even more
selections available. There is really much more to this window than first meets the eye.

![Arm Control Setup window](image)

**Figure 7-2.** Arm Control Setup window.

The window is divided into two sections. The top half is used to specify the rearm conditions and the automatic data save options. The bottom half is used for defining which data samples in the Last and Reference memory banks are compared during the automatic comparisons.

The right-most menu on the top menu bar is the **Options** menu for this window (see Figure 7-3). The menu is only available when the Arm Control Setup window is the current active window in the display.

Selecting **Edge Tolerance** opens a dialog box that allows you to specify the allowable sample jitter during data comparisons. For example, if you are comparing data that was recorded asynchronously, the data is likely to be shifted by one sample from one recording to the next. Specifying an edge tolerance of one sample allows these recordings to pass the comparison even if there is a one-sample shift.

**Determining the best Arm Control mode for your application**

During the majority of your debugging sessions, you want to arm the analyzer and then study the data you collected. This is called a single-shot recording, and it is the default setup for the Arm Control window. For these type of recordings, you can leave the Arm Control window as it is and run the analyzer from the Run menu. See the **Run Control** section of this chapter for more information on the Run menu.
Other applications may require automatically rearming the analyzer to take repetitive recordings. After each recording, all or part of the Last data can be compared to the Reference data. You can setup the analyzer to make decisions based on the results of the compare.

For example, you could setup the analyzer to run all weekend collecting data from your target system. Each batch of data can be compared with good data in the Reference memory. The CLAS 4000 can keep track of the number of successful and failed comparisons, and save the data from the failures on the hard disk for you to study later.

The following sections provide many examples of how to setup the Arm Control Setup window for various applications.

**Single-shot Recording**

**Taking a single-shot recording**

This is by far the most commonly used setup because it allows you to study the data and modify the setups after each recording. This is the default option and is shown in Figure 7-4.

![Figure 7-4. Single-shot recording.](image)

**Rearm**

**Taking repetitive recordings indefinitely**

To take repetitive recordings, choose **Arm Again** from the pop-up menu at the top of the Arm Control window. This choice opens a second pop-up menu and three options with checkboxes (see Figure 7-5). Selecting **Arm Again** without selecting any other options causes the analyzer to take repetitive recordings until it is stopped from the Run menu. The **Arm Again** option should only be used with some of the other options as described in the following sections.

![Figure 7-5. Taking repetitive recordings indefinitely](image)
Updating the display after each recording

To update the displays on the screen each time the analyzer makes a recording, click the checkbox for the **Update on every rearm** option as shown in Figure 7-6.

![Update settings](image)

**Figure 7-6.** Updating the display after each recording.

Stopping the rearm cycle after <n> passes

Instead of taking repetitive recordings indefinitely, you can setup the analyzer to stop after making a certain number of recordings. As the analyzer runs repetitively, a pass counter is incremented after each pass of the analyzer through its rearm cycle.

Select the **Until Pass Count** = option from the pop-up menu on the top line of the window (see Figure 7-7). Another field appears to the right that contains the desired number of passes. You can change the number by typing a new value over the old one, or use the up-down arrows to raise or lower the number. The valid range is from 1 to 9999.

![Pass count settings](image)

**Figure 7-7.** Stopping after <n> passes.

Stopping the rearm cycle after <n> passes and keeping track of compares (or miscompares)

The default is to rearm the analyzer without comparing Last and Reference data. You can compare the data after each recording and keep track of the number of compares or miscompares. The results are shown in the Status window if the Update option is selected. See the *Status Window* section of this chapter for more information.
Click the checkbox for Advance Comparison Counter. A new field appears to the right as shown in Figure 7-8. The pop-up window allows you to specify whether to count compares or a miscompares.

![Figure 7-8. Keeping track of successful comparisons.](image)

Stopping the rearm cycle at the first compare (or the first miscompare)

You may want you continue to rearm the analyzer only until the first successful comparison between Last and Reference.

Select the Until Last = Reference option from the pop-up menu on the top line. A new field appears below the old one. Make sure the top, blank option is selected. In this mode, the comparison counter is ignored.

You can also rearm until the first miscompare by selecting the Until Last ≠ Reference option on the top line as shown in Figure 7-9.

![Figure 7-9. Rearming until Last ≠ Reference.](image)
Looking for a compare (or miscompare), but not running indefinitely

In the previous example, selecting the Until Last ≠ Reference option opened a new field on the second line of the window. Select the or pass count = n option in this menu as shown in Figure 7-10. This option stops the analyzer when the specified number of recordings has been made even if the condition on the first line of the window was never found.

![Figure 7-10. Looking for a miscompare, but not indefinitely](image)

The pass counter counts all recordings. The comparison counter counts compares or miscompares. You can use both of these functions simultaneously as shown in figure 7-11. This setup will count the number of successful comparisons while searching for a miscompare. The rearm cycle will stop after 100 passes even if no miscompares were found.

![Figure 7-11. Counting successful comparisons.](image)

Looking for a compare (or miscompare) to occur after a certain number of passes

You may want to stop the rearm cycle if you find a miscompare, but only after the analyzer has made a certain number of passes through the rearm cycle. Use the same method as in the previous example, except select the and pass count ≥ n option in the pop-up on the second line. This causes the CLAS 4000 to take <n> recordings, and then continue until a Last recording does not equal the Reference (see Figure 7-12).
Automatic Data Save

Automatically saving the Last recorded data on disk

As the analyzer runs repetitively, you may want to have it automatically save data on the disk for you to study later. This could be especially true if you set up the CLAS 4000 to run overnight or on a weekend searching for an intermittent problem.

To save data on the hard disk, click the Save Last memory checkbox. A new field appears with a pop-up menu (see Figure 7-13). The menu allows you to select which data you want saved. The CLAS 4000 can automatically save the data when Last = Reference or when Last = Reference. Selecting the top blank option causes data to be saved after each recording regardless of the results of the comparison.

To specify the base name of the saved data files, click the Save as... button to open a save dialog box. Since this dialog box is similar to the one used to save regular setup and data files, refer to Chapter 10 for a complete explanation of saving files.

The base name is used to save all the data files during the rearm session. Each time a file is saved, the name is appended with a number. For example, if the base name is "TEST" and three files are saved, they will be called "TEST.1" through "TEST.3."
Data Comparisons

Comparing all samples

Many of the rearm run modes make decisions based on the results of a comparison between Last and Reference. The lower half of the Arm Control Setup menu is used to specify which samples will be compared. This affects only the rearm comparisons. Single shot comparisons in State or Timing are not affected because the comparisons are always made of all samples.

To compare all the Last and Reference samples, choose **All Samples** from the pop-up menu as shown in Figure 7-14.

![Figure 7-14. Comparing all samples](image)

Comparing only the samples between cursors

You may only want to compare a small part of the sample memory and ignore all other samples. To compare only the samples between the cursors, choose **Samples Between Cursors** as shown in Figure 7-15.

In this mode, only the samples between C1 and C2 in the data displays are used for the comparison. The present cursor locations are displayed in the lower part of the window. You may need to go to either the Timing or State display to adjust the cursor locations. See chapters 8 and 9 for more information on the cursors.

![Figure 7-15. Comparing the samples between the cursors.](image)

Comparing only certain selected samples

You can also define the compare range by choosing the option **Samples Selected Below** as shown in Figure 7-16. This option allows you to specify the compare range explicitly in the fields at the bottom of the window.
There are two main advantages that this method has over using the cursors to mark the range. First, the range is independent from the cursors. You can move the cursors around in the data displays without accidentally changing your compare range.

Second, you can specify the starting sample number for both Last and Reference. This allows you to compare skewed ranges of samples. For example, you can compare samples 100-300 in Last with samples 500-700 in Reference.

**Arming the analyzer to make a recording**

After you have used the various menus to create the desired setup, you can arm the analyzer by selecting the **Run** option from the Run menu (see Figure 7-17).

The **Stop** and **Cancel** commands are greyed and cannot be selected unless the analyzer is already running. These commands are explained in the following sections.

**Manually stopping a recording and observing the data**

After the analyzer is running the **Stop** option can be selected from the Run menu (see Figure 7-18). This option is used to stop a repetitive recording, or a single-shot recording that does not trigger on its own. For example, the analyzer does not trigger if the trigger condition is not found, the trigger setup is faulty, or an external clock is not running.

Selecting **Stop** not only halts the analyzer, but it also transfers any data that was recorded into the State and Timing displays for you to study.
Cancelling a recording without observing the data

The `Cancel` option from the Run menu is identical to the `Stop` option except the data that was collected is not transferred into the State and Timing displays (see Figure 7-19). `Cancel` is therefore faster than `Stop`, and can be used to quickly abort a recording.

Status Window

- LA 1: Run
- Stop
- Cancel
- LA 2: Run
- Stop
- Cancel
- All: Run
- Stop
- Cancel
- Multiple...

Checking the status of the analyzer during or after several rearm cycles (passes)

The Status window is a special window that floats in front of all the others. If the window is open, it can always be seen even if there are other windows open. The status window is always open when you start up the CLAS 4000 software, but it can be closed with the close box. To open the status window again, choose `Show Status` from the `Control` menu.

The Status window reports if the analyzer is `Ready` to run, `Busy`, or in one of the labeled steps of the Trace Control scheme. If the analyzer stops or becomes "stuck" in one of the Trace Control steps, the Status window reports which step, so you can see what the analyzer was waiting for or trying to do. You can drag the Status window out of your way, using the gray bar at the top for a handle, as shown in Figure 7-20.

```
<table>
<thead>
<tr>
<th>LA</th>
<th>Status</th>
<th>Run Information</th>
<th>Compare/Pass</th>
</tr>
</thead>
<tbody>
<tr>
<td>LA 1</td>
<td>Ready</td>
<td>Finished</td>
<td>0:1</td>
</tr>
<tr>
<td>LA 2</td>
<td>Ready</td>
<td>Ready</td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 7-20. Status window.

The Status window also gives information relating to any rearm modes that are selected in the Arm Control Setup window as long as the Update option is specified. If a rearm run mode is specified that causes several passes through the run cycle, the current pass count is displayed and well as the number of successful compares. By subtracting the number of compares from the number of passes, you can determine how many passes had contained miscompares. If the Update option is not specified in the Arm Control Setup window, the information will not be updated until all passes are complete.
Chapter 8  Timing Display

You can use the Timing or State displays to observe the data collected by the CLAS 4000. The Timing Display shows the data in a waveform format, while the State Display shows the data in a list format. This chapter explains how to use the Timing Display to observe the data collected by the CLAS 4000.

To open the Timing Display window, pull down the Timing Display menu and select Last (see Figure 8-1).

![Help Timing...]

Figure 8-1. Timing Display menu.

Unlike the setup menus which have a Next option, the Timing menu has only Last and Reference. In the setup menus, you select the Next option to create the setup that will be used to make the next recording. You select the Last or Reference options to merely observe the setup that was used to collect the data in Last or Reference memory.

In the display menus, you select the Last and Reference options to see the data in Last or Reference memory. There is no Next option because the next data has not been collected yet. Once the next recording has been made, the data will have been stored in Last memory.

For a general description of the Next, Last and Reference options, see the beginning of Chapter 5.

Overview

Getting to know the Timing Display window

The Timing Display window is shown in Figure 8-2. The names of the channels are on the left edge of the window, and the waveforms are drawn to the right. The channels are arranged in order from top to bottom according to the order defined in the Channel Setup window.

The most significant channel of the left-most group in the Channel Setup window appears at the top of the Timing Display. The least significant channel of the right-most group in the Channel Setup window appears as the bottom channel in the timing display.
You can always tell what section of the data is currently in the display by looking at the fields to the left and right of the horizontal scroll bar at the bottom of the window. In Figure 8-2, the waveforms for samples 0-77 can be seen in the display.

The resolution of the display can be changed to show more or less data in the window at one time. Both the horizontal and vertical resolution can be changed as described in the Window Resolution section of this chapter.

The right-most menu on the top menu bar is the options menu for the Timing Display window (see Figure 8-3). The menu is only available when the Timing Display window is the current active window in the display.

The Timing and State displays have cursors that you can use to mark samples of interest. The current cursor locations are displayed in the C1 = ... and C2 = ... fields. The cursors can be used to temporarily mark the sections of the data and measure the distance or elapsed time from one place in the data to another. See the Cursors section of this chapter for more information.

The lines used to represent zero's are thicker than the lines that represent one's. This is useful when you are looking at large areas of unchanging data. By observing the thickness of the lines, you can easily tell whether the lines are high or low.
The format and arrangement of the channels in the Timing Display can be changed using the various options and features explained in this chapter. Once you have customized the Timing Display, you can save your changes by saving the Last setup. To reload the customized display, open the same Last setup. See Chapter 10 for more information of opening and saving setups.

**Data Manipulation**

**Scrolling through the recorded waveforms**

Only a small portion of the data is visible on the display at one time. The amount of data displayed in the window depends on the current size and resolution of the window. The next several sections of this chapter explain various ways to observe data that is currently off the screen.

![Figure 8-4. Scrolling through data in the timing display.](image)

You can use the scroll boxes and arrows on the right and bottom edges of the window to scroll the data in the window. For horizontal scrolling, use the bottom scroll bar. Click or press on the arrows to move the display left or right one sample at a time. Drag the scroll box, or click on either side of it, as shown in Figure 8-4, to move greater distances. Moving to the left displays previous timing information, and moving to the right displays the more recent samples. To see data from other channels, scroll vertically with the right edge scroll bar.

**Moving quickly to a certain off-screen sample**

If you want to move the display directly to a certain sample number, you can either scroll to the new location as described in the previous section, or use the **Options** menu. Select the **Goto Sample...** option from the **Options** menu to open a dialog box (see Figure 8-5).
The Goto Sample dialog box appears (see Figure 8-6). Enter the desired destination sample number and click the **Goto** button. The display immediately scrolls to the specified sample, and places it on the left edge of the window.

Moving quickly to the area around an off-screen cursor

To display the data at a cursor location, choose **Goto C1** or **Goto C2** from the **Options** menu (see Figure 8-7). The display immediately scrolls to the data around the cursor with the left edge of the window at the cursor's location. The cursors are explained in detail in the following section.

Cursors  

Bringing an off-screen cursor into view

To bring an off-screen cursor onto the current display, choose **Get C1** or **Get C2** from the **Options** menu (see Figure 8-8). This places the chosen cursor in the middle of the display window. A cursor is represented by a vertical line through the timing waveforms with a cursor tag at the top.
Moving a cursor that is visible in the display

To move a cursor from one part of the display to another, drag the cursor tag (1 or 2) across the window (see Figure 8-9). The vertical line representing the cursor always sits at the left edge of a sample in the waveform. As you drag the cursor with the mouse, you need to move the mouse pointer all the way into the next sample before the cursor actually moves. If you drag it off either side of the display, the screen scrolls with it.

![Figure 8-9. Dragging a cursor in the Timing Display](image)

Viewing the Trace Control information and the binary value of the channels at the cursor location

When you place the cursor on a sample of interest, you may want to know the binary value of the data at that point or the Trace Control level or step information.

To get the binary value at the cursor, look to the left of the waveforms. Part of the display is a column of 1's and 0's (see Figure 8-9). This column contains the data values for each channel at the sample that contains the cursor. As you move the cursor, the column always shows you the data at the new location. In the illustrated example, the most significant nibble of the data at cursor C2 is 0011, or "3" in Hex.

To get the Trace Control information, look above the waveforms on the second line of the window. The Trace Control level and step information is shown for the sample at the cursor location. In Figure 8-9, the Trace Control step, "Find 05," was active when the sample at C2 was taken. The active Trace Control hardware level was Level 01. The meaning of this information is described in detail in Chapter 9.

Both the Trace Control and binary information can be displayed for the sample either cursor. At the top of the binary column is a field indicating which cursor's data is displayed. The most recently moved cursor is always used.
Moving a cursor to a certain off-screen sample

The current cursor locations all always indicated in the $C_1 =$... and $C_2 =$... fields in the upper left corner of the display. You can send a cursor to a new location by typing a new sample number into the field and pressing the <return> key. You can also use the up and down arrows to move the cursor to a higher or lower sample number (see Figure 8-10).

![Timing [LA 1-Last]](image)

$C_1 = 0$ $C_2 = 28$ $\triangle Sample = 28$

Figure 8-10. Moving a cursor.

![Timing [LA 1-Last]](image)

$C_1 = 0$ $C_2 = 28$ $\check\triangle Sample$ $\Delta Time Stamp$

Figure 8-11. Changing the units for the distance between cursors.

Measuring the distance between the cursors

To the right of the cursor fields is an area that displays the distance between the cursors. You can display the distance in terms of the number of samples between the cursors, or the amount of time represented by that portion of the waveform bored by the cursors. To change modes, select either $\Delta Sample$ or $\Delta Time Stamp$ from the pop-up menu as shown in Figure 8-11.

Window Resolution

Changing the resolution of the display

In a full-size Timing Display window on a 13" monitor, the default display resolution shows you the first 90 or so samples from about 15 channels. You can zoom-in or zoom-out by changing the horizontal and vertical expansion of the display.

The current expansion values are shown in the upper left part of the window under the cursor fields. The default values are $V = x 2$ $H = x 2$.

To change the horizontal expansion, pull down the Options menu and put the cursor on the Horizontal Exp. $\rightarrow$ (The arrow, $\rightarrow$, indicates that there is a side menu. See Figure 8-12.) Move the cursor onto the side menu and select the desired setting.
When you let go of the mouse, the horizontal display resolution changes to the selected value as indicated in the upper left part of the window. Zoom-in by choosing a higher number, and zoom-out by choosing a lower number. The **Compact** option shows you all the samples at once.

![Options menu]

**Figure 8-12. Setting the horizontal expansion.**

You can use the same method to change the vertical expansion. Select **Vertical Exp. ▼** from the **Options** menu. Changing the vertical expansion varies the height of each channel waveform. Choosing a higher number increases the height of each channel.

### Window Format

![Window Format table]

**Figure 8-13. Highlighting a channel.**

### Highlighting a channel or group of channels

Some of the operations defined in the following sections require you to highlight a channel or group of channels. To highlight a channel, click in the blank box to the left of the channel label as shown in Figure 8-13.

You can also highlight a contiguous group of channels. All the channels you want to highlight must be visible on the display. Hold down the `<shift>` key and click the first channel. Then drag up or down the list of channels.
Changing the color of highlighted channels

If you have a color monitor, you can change the color of the timing waveforms to help distinguish one group of channels from another. Highlight the desired channel(s) using the methods described in the previous section. Pull down the Options menu and put the cursor on the Color ▶ option. A side menu appears with a list of available colors as shown in Figure 8-14.

Inserting a new line above an existing channel

If you want to add a new channel to the list, or add a copy of an existing channel to a different place in the list, you need to insert a new line in the display. Highlight a channel and select Insert from the Edit menu (see Figure 8-15). A new line named --- New--- is inserted as shown in Figure 8-16.

You can also add lines to the display using the Duplicate option from the Edit menu. Highlight one or more channels and select Duplicate. A copy of the highlighted channels is inserted into the channel list.

If you add groups to the setup in the Channel Setup window, the new channels will not automatically appear in the Timing Display after the next recording. You must insert and define the
new lines in the display as described in this section and the following sections. Also keep in mind that if you add channels to the existing channels in the Channel Setup window, the group will be displayed in the default format in the Timing Display after the next recording.

Renaming a channel

The Timing display provides default names for each channel that are derived from the channel group names. For example, a 16-channel group named Address has individual channels named Address15-Address0. You can change the name of the channels in the Timing Display from the default names to more descriptive ones.

For example, in a channel group called Status, you may want to change the default name Status3 to Ready. The names can contain spaces and standard keyboard symbols and can be up to ten characters long.

To name a new channel, click on the channel name to highlight it for editing. Type the new name and press return. This field allows standard text editing techniques, so you can also edit part of the name by highlighting only that portion you want to change (see Figure 8-17).

![Figure 8-17. Changing channel names in the Timing Display.]

You cannot use the same name for two different channels, but you can display the same channel on more than one line of the display. See the following section for more information.

Defining a line on the display as a certain channel

To the right of the column of channel names in the Timing Display is a Chan column. This column indicates which channel is currently displayed on each line of the display. The channel designators specify the data board (A-D) and channel number (00-95). For example, A15 means channel 15 on data board A.
The default setup shows the channels from each group in descending order, but any line in the display can be used to show any channel from any group. You can show a different channel on a line of the display by using either of the two methods described in the following paragraphs.

The first method requires that you know the name of the desired channel and the channel is currently displayed elsewhere in the Timing Display. Type the channel name into the Label field. You must use the exact same name that is used in the other location. If you enter a name that does not exactly match the name of the desired channel, you will merely change the name of the channel that is currently displayed. To avoid this potential problem, you can use the method described below.

The second method requires that you know the channel designator and group name of the channel you want to display. Click on the button in the Chan column as shown in Figure 8-18. The Channel Selection dialog box appears (see Figure 8-19).

![Figure 8-18. Opening the Channel Selection dialog box.](image)

![Figure 8-19. Channel Selection dialog box.](image)

The Channel Selection dialog box has three main options. You can choose to display a channel, a bus, or a blank line. The BUS option is explained in the Bus Display Waveforms section of this chapter.

The Display: and channel: fields indicate which channel from which group is currently displayed. To change the channel group, open the pop-up menu in the Display: field and choose the desired group from the list.

To select which channel to display from the chosen group, open the pop-up menu in the channel: field and choose from the list of channel designators. The list only contains the channels in the group specified in the Display: field.

Click the Select button to return to the Timing Display and implement your changes. The affected line of the display shows the data and label for the selected channel. The Cancel button closes the window without implementing the changes.
Deleting a line from the display

To remove a line from the Timing Display, highlight the channel and select **Clear** from the **Edit** menu (see Figure 8-20). To delete more than one channel at a time, highlight several channels at once as described in the *Highlighting a channel or group of channels* section of this chapter. Pressing the `<delete>` key on the keyboard also removes highlighted channels.

![Edit menu](image)

*Figure 8-20. Deleting highlighted channels from the display.*

**Bus Display Waveforms**

Viewing all the waveforms in a certain channel group as a bus

You can see more information in the Timing Display at one time by using the bus display format for groups of signals. For example, you can display the entire Address group on one line. The Hex value of the Address is displayed for each sample as shown in Figure 8-21.

![Bus Display](image)

*Figure 8-21. Bus Display of waveforms.*

To define a line of the display as a bus waveform, click on the button in the **Chan** column (see Figure 8-22). The Channel Selection dialog box appears as shown on Figure 8-23. Select the desired group from the **Display** pop-up menu and click the...
as a BUS button. Click the Select button to return to the Timing Display and implement your changes. The Cancel button closes the window without implementing the changes.

![Figure 8-22. Opening the Channel Selection dialog box.](image)

![Figure 8-23. Channel Selection dialog box.](image)

The bus shows a row of rectangles. If the horizontal resolution is high enough, the group's Hex value for the sample is displayed in each rectangle. The resolution required to display the Hex value depends on how many channels are in the group. At the maximum resolution, the Hex value for thirty-two channels can be displayed in the rectangles.

### Viewing miscellaneous waveforms as a bus

You can combine many lines of the Timing Display into a bus waveform using the Group command in the Options menu. Unlike the method described in the previous section, you do not have to combine all the channels in channel group. You can combine up to 32 channels from different groups, and you can even combine channels with bus waveforms to create larger bus waveforms.

The channels you combine must be next to each other in the Timing Display, so you may have to rearrange the display before using the Group command. See the previous sections in this chapter for more information about highlighting, deleting, inserting, and defining lines of the display.

To combine channels into a bus, highlight the channels you want to group together and choose Group command from the Options menu (see Figure 8-24). See the previous section for information about displaying the Hex values in different horizontal resolutions.

![Figure 8-24. Grouping channels into a bus.](image)
Viewing the bus value at the cursor location

The Cursors section of this chapter described how to view information about the sample at a cursor. You can also view the value of a bus waveform at a cursor. First click on the asterisk in the binary column for the bus waveform as shown in Figure 8-25. Then drag one of the cursors.

![Figure 8-25. Viewing the bus waveform value at a cursor.]

The bus value at the cursor is displayed above the waveforms on the second line of the window. The "0x" indicates that the value is displayed in Hex. In the illustrated example, the Address value at cursor C2 is C9C8 in Hex. The value is always shown at the most recently moved cursor.

The second line of the window normally shows the Trace Control information. To return to this mode, click above the waveforms on the second line of the window and drag a cursor. See the Cursors section of this chapter for more information.

Data Comparisons

Comparing Last and Reference waveforms in the Timing Display

You can compare the data in Last memory with the data in Reference memory and view the differences in the Timing Display. Make sure that you have meaningful data in the Reference memory by using the Transfer or Open commands (see Chapter 10).

To put the the Timing Display in compare mode, choose Compare from the Options menu (see Figure 8-26). Greyed waveforms appear in the Last Timing Display indicating the value of the Reference data (see Figure 8-27). In areas where the Reference data matches the Last data, the greyed waveform cannot be seen. If you select Compare from the Options menu of the Reference Timing Display, the greyed waveforms represent the value of the Last data.
When the Timing Display is in compare mode, the **Compare** option in the **Options** menu has a checkmark next to it. The Timing Display will remain in compare mode until you select the **Compare** option again to remove the checkmark.

In the state display, you can search for the next or previous miscompare. Since the cursors track between the two displays, you can find the miscompares in the State Display, note the sample numbers or mark them with the cursors, and return to the Timing Display. See Chapter 9 for more information about using the compare mode in the State Display.

The comparison uses the Edge Tolerance setting from the Arm Control Options menu, but not the range limits from the Arm Control Setup window. See Chapter 7 for more information on Arm Control.

**Editing the Reference Timing display**

In the Reference Timing Display, you can edit the Reference memory. This is useful if you want to compare the Last data to data that you have never been able to capture. You can correct slightly flawed Reference recordings and create a perfect batch of data.

Make sure that you have meaningful data in the Reference memory by using the **Transfer** or **Open** commands (see Chapter 10). Then open the Reference Timing Display from the Timing Display menu. The Reference Timing Display is identical to the Last Timing Display except you can highlight portions of the timing waveforms (see Figure 8-28).
Figure 8-28. Editing Reference Timing Display

To edit Reference data, highlight the sample and type a "1" or a "0." You can also use block editing techniques to change many samples at once. Use the mouse to drag across the waveforms to highlight a large section of data. Typing a "1" or a "0" changes the value of all highlighted samples. To highlight very large sections of data, use the minimum horizontal and vertical resolutions because you can only highlight samples visible in the window.

The changes you make to the Reference memory in the Timing Display can also be seen in the State Display of Reference memory. The State Display also has an Edit Reference mode, but there is no block edit feature. You can use the block edit in the Timing Display to make changes that are reflected in the State Display. See Chapter 9 for more information about the State Display.

You can also enter "don't care" values by typing <option>X. The X's are not used at all in the Timing Display. In fact, the waveforms appear unchanged and miscompares are still shown. The only way you can tell that the data is an X is to put the cursor on the sample and look at the sample value at the left of the display. The X's are used in the Reference State Display and can be used for State Display and rearm comparisons. When you enter X's in the State Display Edit Reference mode, the data appears as zeros (a low level) in the Timing Display.

**Displaying the final value of the Trace Control parameters**

When you are using Full Feature Trace Control, there are two counters and a timer that can provide additional information about your data and how the CLAS 4000 triggered. If you use these features, you can observe the final counter and timer values by selecting Timing Info... from the Options menu.
The Timing Info dialog box appears (see Figure 8-29). When you are finished looking at the values, click the OK button to return to the Timing Display. The timer and counters are explained in detail in Chapter 11.

![Timing Info dialog box](image)

Figure 8-29. Timing Info dialog box.
Chapter 9  State Display

You can use the Timing or State displays to observe the data collected by the CLAS 4000. The Timing Display shows the data in a waveform format, while the State Display shows the data in a list format. This chapter explains how to use the State Display to observe the data collected by the CLAS 4000.

To open the State Display window, pull down the State Display menu and select Last (see Figure 9-1).

![Figure 9-1. State Display menu.](image)

Unlike the setup menus which have a Next option, the State menu has only Last and Reference. In the setup menus, you select the Next option to create the setup that will be used to make the next recording. You select the Last or Reference options to merely observe the setup that was used to collect the data in Last or Reference memory.

In the display menus, you select the Last and Reference options to see the data in Last or Reference memory. There is no Next option because the next data has not been collected yet. Once the next recording has been made, the data will have been stored in Last memory.

For a general description of the Next, Last and Reference options, see the beginning of Chapter 5.

Overview

Getting to know the State Display window

The State Display window is shown in Figure 9-2. The data is displayed in a list format with a column for each of the channel groups. The name of the group appears at the top of the column. The groups are arranged in order from left to right according to the order defined in the Channel Setup window.

The column of the far left of the display contains the sample number for the data on each line. You can always tell what section of the data is currently in the display by looking at the sample numbers. If the window is large enough, the data appears in two sections. The section on the right side of the
display is a continuation of the section on the left side. In Figure 9-2, the data for samples 0-27 can be seen in the left section, and samples 28-55 can be seen on the right.

Figure 9-2. State Display window

The right-most menu on the top menu bar is the Options menu for the State Display window (see Figure 9-3). The menu is only available when the State Display window is the current active window in the display.

The Timing and State displays have cursors that you can use to mark samples of interest. The current cursor locations are displayed in the C1 = ... and C2 = ... fields. The cursors can be used to temporarily mark sections of the data and measure the distance or elapsed time from one place to another. See the Cursors section of this chapter for more information.

Scrolling through the recorded data

Only a small portion of the data is visible on the display at one time. The amount of data displayed in the window depends on the current size the window and number of columns. The next several sections of this chapter explain various ways to observe data that is currently off the screen.

You can use the scroll boxes and arrows on the right and bottom edges of the window to scroll the data in the window. For vertical scrolling, use the scroll bar on the right side of the window. Click or press on the arrows to move the display up or down one sample at a time. Drag the scroll box, or click on either side of it to move a page at a time. Moving up displays previous state information, and moving down displays the more recent samples. To see data from other channels, scroll horizontally with the bottom scroll bar. If the window is large
enough to display all channel groups, the bottom scroll bar is not present.

**Moving quickly to a certain off-screen sample**

If you want to move the display directly to a certain sample number, you can either scroll to the new location as described in the previous section, or use the Options menu. Select the Go to Sample... option from the Options menu. The Goto Sample dialog box appears (see figure 9-4).

![Goto Sample dialog box](image)

**Figure 9-4.** Go to Sample dialog box.

Type in the desired destination sample number and click the Goto button. The display immediately scrolls to the specified sample, and places it on the top line of the window.

**Viewing the data at an off-screen cursor**

To display the data at a cursor location, choose Go to C1 or Go to C2 from the Options menu. The display immediately scrolls to the data at the cursor with the top line of the window at the cursor's location. The cursors are explained in detail in the following section.

**Cursors**

**Bringing an off-screen cursor into view**

To bring an off-screen cursor onto the current display, choose Get C1 or Get C2 from the Options menu. This places the chosen cursor at the top of the display window. A cursor is represented by a horizontal line through the data list with a cursor tag at the left. In Figure 9-2, cursor C1 is at sample 00000, and cursor C2 is at 00025.

**Moving a cursor that is visible in the display**

To move a cursor from one part of the display to another, drag the cursor tag (C1 or C2) up or down the window (see Figure 9-5). Note that the cursor you moved most recently has a solid
line; the line of the other cursor is dotted. If you drag it off the display, the screen scrolls with it.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000</td>
<td>F5F4</td>
<td>F7F6</td>
<td>F9F8</td>
<td></td>
</tr>
<tr>
<td>00001</td>
<td>E9E8</td>
<td>EBEA</td>
<td>EDEC</td>
<td></td>
</tr>
<tr>
<td>00002</td>
<td>DDDC</td>
<td>DFDE</td>
<td>E1E0</td>
<td></td>
</tr>
<tr>
<td>00003</td>
<td>D100</td>
<td>D3D2</td>
<td>D5D4</td>
<td></td>
</tr>
<tr>
<td>00004</td>
<td>C5C4</td>
<td>C7C6</td>
<td>C9C8</td>
<td></td>
</tr>
<tr>
<td>00005</td>
<td>B9B8</td>
<td>BBA8</td>
<td>BDBC</td>
<td></td>
</tr>
<tr>
<td>00006</td>
<td>ADAC</td>
<td>AFAE</td>
<td>B1B0</td>
<td></td>
</tr>
<tr>
<td>00007</td>
<td>A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
<td></td>
</tr>
<tr>
<td>00008</td>
<td>9594</td>
<td>9796</td>
<td>9998</td>
<td></td>
</tr>
<tr>
<td>00009</td>
<td>8988</td>
<td>8B8A</td>
<td>8D8C</td>
<td></td>
</tr>
<tr>
<td>00010</td>
<td>7D7C</td>
<td>7F7E</td>
<td>8180</td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-5. Dragging a cursor in the Timing Display

If the display is divided into a left and right section, and you want to move the cursor from one section to the other, use the up and down arrows to the right of the cursor field. The cursor fields are explained in the following section.

**Moving a cursor to a certain off-screen sample**

The current cursor locations are always indicated in the C1 = ... and C2 = ... fields in the upper left corner of the display. You can send a cursor to a new location by typing a new sample number into the field and pressing the <return> key (see Figure 9-6). You can also use the up and down arrows to move the cursor to a higher or lower sample number.

Figure 9-6. Cursor fields.

**Measuring the distance between the cursors**

To the right of the cursor fields is an area that displays the distance between the cursors. You can display the distance in terms of the number of samples between the cursors, or time. To change modes, select Display Setup... from the Options menu. The State Display Setup dialog box appears (see Figure 9-7). Click one of the buttons to the right of "Units for C2-C1:". You can select Samples or Time. Click OK to close the dialog box.
Window Format

Changing the display radix

The data is displayed in the radix specified in the Channel Setup window for each group. If a group is displayed in symbol radix, the data patterns are replaced by the corresponding symbols. Any data pattern that does not have a symbol is displayed in the radix selected in the Symbol Table dialog box (see Chapter 5 for more information on symbols). Keep in mind that you can also change the radix from the Trace Control Pattern Definition window (see Chapter 7).

You can change the radix for the currently displayed Last or Reference data from the Last or Reference Channel Setup windows, but you must change it in the Next setup windows to affect future recordings.

Moving a column of data to the left or right

You can change the distance between the columns in the display by moving the columns left or right. Drag the column header (Address, Data, etc.) of the column as shown in Figure 9-8. All columns to the right of the selected one move also.

The Sample column and the first data column cannot be moved. If the Time Tag column is present as the rightmost column, it can not be moved individually. See the Viewing the Time Tag for each line of data section of this chapter for more information on Time Tags.
Using a split screen to see two sections of the data at once

You can split the display to look at blocks of data that occur at different parts of the recording, such as subroutines that should be the same each time they appear.

The screen splitter is a small black rectangle at the top of the right-hand scroll bar. Drag the splitter down the scroll bar. A line appears through the data. You can now scroll the data above this line independently from the data below it. Note that the right-hand scroll bar is split into two parts as shown in Figure 9-9.

![Figure 9-9. Vertical split screen state display.](image)

![Figure 9-10. Horizontal split screen state display.](image)

If the window is too narrow to display all the data columns at once, you can also split the screen horizontally. This is very useful for putting different columns next to each other. To split the screen, drag the black rectangle in the lower left corner of the screen into the bottom scroll bar. The bottom scroll bar is split into two parts allowing the left and right sections of the window to be scrolled separately as shown in Figure 9-10.
You can only scroll to the right until the rightmost column can be seen and to the left until the leftmost column can be seen. You may need to vary the window size to get certain columns next to other columns. You can put any column next to any other column by making the window only wide enough to display two data columns and splitting it down the middle.

Changing the font size of data in the display

The data can be displayed in two different font sizes. The default display uses the small font so that more lines of data can fit in the window. If you use the larger font, less data can be seen in the window, but the data is easier to read. This is especially useful if you want to see the data from a distance or if you lose your glasses.

To change the font, select Display Setup... from the Options menu. The State Display Setup dialog box appears (see Figure 9-11). Click one of the buttons to the right of "Font size". You can select Small font or Big font. Click OK to close the dialog box.

![State Display Setup dialog box](image)

Figure 9-11. Changing the font size.

Viewing the Time Stamp for each line of data

The CLAS 4000 stores a 16-bit Time Stamp with each data sample that indicates when the sample was taken relative to other samples. The Time Stamps can be displayed next to each sample in the State Display.

Select Display Setup... from the Options menu to open the Display Setup dialog box (see Figure 9-12). On the second line, there are three Time Stamp options. The Time Stamps are not shown in the default display because the Hide time tag option is selected.
You can display the Time Stamps in two formats. In **Delta time** mode, each Time Stamp shows how much time passed since the last sample.

In **Time from line:** mode, each Time Stamp shows the cumulative time from the specified sample. For example, if sample 500 shows the start of a subroutine, you could select **Time from line: 500**. The Time Stamp at sample 500 would be zero. All other Time Stamps would show the elapsed time from the start of the subroutine. The Time Stamp for the sample at the end of the subroutine would show how much time passed during the execution of the subroutine.

To display the Time Tag information, click either the **Delta time** or **Time from line:** button. Click **OK** to close the dialog box.

The Time Tags appear in a column to the right of the data as shown in Figure 9-13.
The Time Tags are especially useful if you are using an external clock or you are collecting data at irregular intervals. In external clock mode, you can change the Time Stamp resolution in the Channel Setup window. See the *External Clocks* section of Chapter 5 for more information.

**Selecting a Time Stamp interpolation scheme**

The maximum resolution of the Time Stamp is 40 ns. In this mode, the Time Stamp counter increments its count every 40 ns. By keeping track of the number of times the Time Stamp counter increments and knowing that each count represents 40 ns, the CLAS 4000 software can determine how much time has gone by between samples.

If two samples occur within 40 ns of each other, the Time Stamp counter contains the same count for both samples. Without any interpolation, the Time Stamps would show that no time passed between the samples. This is not very realistic, so the CLAS 4000 software provides two interpolation schemes that calculate the Time Stamps and display a more accurate representation of the passage of time.

You can select the desired interpolation scheme on the last line of the *Display Setup* dialog box (see Figure 9-14 a).

![State Display Setup dialog box](Figure 9-14 a. Selecting a Time Stamp interpolation scheme.)

There are three interpolation choices. Selecting *off* disables all interpolation. The Time Stamps are displayed as they are actually collected by the Time Stamp counter.

Selecting *linear* enables linear interpolation. This method assumes that samples occur at regular intervals and are evenly spaced in time.
Part 2 Learning the CLAS 4000

The **Sample** option is only enabled when the Time Stamp software knows the actual sample rate. For example, if you collect data with the internal clock at 20 ns, the Time Stamp software assumes that samples occur at 20 ns intervals.

Table 9-1 provides an example of the interpolation schemes. The Time Stamps corresponding to twenty-five data samples are shown in the different interpolation modes. The Time Stamps in the table are shown in bold type when the Linear and Sample interpolation schemes result in different values.

<table>
<thead>
<tr>
<th>50 ns Time Stamp Count</th>
<th>Off (no interpolation)</th>
<th>Linear Interpolation</th>
<th>Sample Interpolation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>000 ns</td>
<td>000 ns*</td>
<td>000 ns*</td>
</tr>
<tr>
<td>0000</td>
<td>000 ns</td>
<td><strong>025 ns</strong></td>
<td><strong>020 ns</strong></td>
</tr>
<tr>
<td>0001</td>
<td>050 ns</td>
<td>050 ns*</td>
<td>050 ns*</td>
</tr>
<tr>
<td>0001</td>
<td>050 ns</td>
<td>070 ns</td>
<td>070 ns</td>
</tr>
<tr>
<td>0001</td>
<td>050 ns</td>
<td>090 ns</td>
<td>090 ns</td>
</tr>
<tr>
<td>0002</td>
<td>100 ns</td>
<td>110 ns</td>
<td>110 ns</td>
</tr>
<tr>
<td>0002</td>
<td>100 ns</td>
<td>130 ns</td>
<td>130 ns</td>
</tr>
<tr>
<td>0003</td>
<td>150 ns</td>
<td>150 ns</td>
<td>150 ns</td>
</tr>
<tr>
<td>0003</td>
<td>150 ns</td>
<td>170 ns</td>
<td>170 ns</td>
</tr>
<tr>
<td>0004</td>
<td>200 ns</td>
<td>190 ns</td>
<td>190 ns</td>
</tr>
<tr>
<td>0004</td>
<td>200 ns</td>
<td>210 ns</td>
<td>210 ns</td>
</tr>
<tr>
<td>0004</td>
<td>200 ns</td>
<td>230 ns</td>
<td>230 ns</td>
</tr>
<tr>
<td>0005</td>
<td>250 ns</td>
<td>250 ns*</td>
<td>250 ns*</td>
</tr>
<tr>
<td>0005</td>
<td>250 ns</td>
<td><strong>275 ns</strong></td>
<td><strong>270 ns</strong></td>
</tr>
<tr>
<td>0006</td>
<td>300 ns</td>
<td>300 ns</td>
<td>300 ns*</td>
</tr>
<tr>
<td>0006</td>
<td>300 ns</td>
<td><strong>325 ns</strong></td>
<td><strong>320 ns</strong></td>
</tr>
<tr>
<td>0008</td>
<td>400 ns</td>
<td>400 ns*</td>
<td>400 ns*</td>
</tr>
<tr>
<td>0008</td>
<td>400 ns</td>
<td><strong>425 ns</strong></td>
<td><strong>420 ns</strong></td>
</tr>
<tr>
<td>0009</td>
<td>450 ns</td>
<td>450 ns</td>
<td>450 ns*</td>
</tr>
<tr>
<td>0009</td>
<td>450 ns</td>
<td><strong>475 ns</strong></td>
<td><strong>470 ns</strong></td>
</tr>
<tr>
<td>0010</td>
<td>500 ns</td>
<td>500 ns*</td>
<td>500 ns*</td>
</tr>
<tr>
<td>0010</td>
<td>500 ns</td>
<td>520 ns</td>
<td>520 ns</td>
</tr>
<tr>
<td>0010</td>
<td>500 ns</td>
<td>540 ns</td>
<td>540 ns</td>
</tr>
<tr>
<td>0011</td>
<td>550 ns</td>
<td>560 ns</td>
<td>560 ns</td>
</tr>
<tr>
<td>0011</td>
<td>550 ns</td>
<td>580 ns</td>
<td>580 ns</td>
</tr>
</tbody>
</table>

Table 9-1. Time Stamp interpolation schemes.

The first column shows the Time Stamp counter value when each sample was taken. Since many of the samples were collected within 50 ns of each other, the counter value often remains unchanged for two or three samples. The Time Stamp information is always stored in this format as the data is collected. For display purposes, the Time Stamps are shown in units of time, so this Time Stamp count is never actually displayed. It is shown in Table 9-1 to demonstrate how the software calculates the Time Stamps from the counter values.

The second column shows how the Time Stamps would be displayed with no interpolation. Each count of the Time Stamp counter represents 50 ns. Samples with the same count have the same Time Stamp.
The third column shows the Time Stamps with Linear interpolation. The software divides the samples into segments that appear to have uniform sample intervals. Within each segment, the software distributes the total time evenly between the samples. The start of each segment is marked with an asterisk.

The fourth column shows the Time Stamps with Sample interpolation. The data samples are divided into segments. Within each segment, the software uses the known sample rate to calculate the Time Stamps. In the example in table, the software knows that the samples were collected at 20 ns.

**Viewing the Trace Control step for each line of data**

In addition to keeping a Time Tag for each sample, the CLAS 4000 also keeps track of which samples were collected in each part of the Trace Control triggering sequence. Displaying this information adds another column to the State Display. For each sample, this column tells which part of the triggering sequence was active when the sample was taken.

You can enable the Trace Control information from the State Display Setup dialog box. Select **Display Setup**... from the **Options** menu. The dialog box appears as shown in Figure 9-14 b. On the third line, there are three Trace Control options. The Trace Control information is not shown in the default display because the **Hide level** option is selected.

You can display the Trace Control information in two formats. You can select either **Show Level Data** mode or **Show Level Step** mode. Click **OK** to close the dialog box.

The following paragraphs and figures give examples of how to use these modes. See Chapter 6 and Chapter 11 for more information on Trace Control.

In Trace Control Predefined mode, the triggering sequence consists of one software level. The software level is implemented internally as several hardware levels. Some of the Predefined Tasks consist of a software level that is very complex and uses many internal hardware levels.

In Figure 9-15, the Trace Control Predefined setup searches for Addr 02, then Addr 05, then Addr 09. You can give the software level a name. The software level is called, "Trig."
Predefined Trace Control setup.

Selecting the **Show Level Step** in the **Display Setup** dialog box adds a Level Info column to the display (see Figure 9-16). The Level Info column displays the name of the active software level for each sample. Since there is only one software level in Trace Control Predefined mode, the Level Info column shows the same software level name for every sample. This is not the best mode if you are using Predefined Trace Control.

<table>
<thead>
<tr>
<th>C Sample</th>
<th>Level Info</th>
<th>Address Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>02038</td>
<td>Trig</td>
<td>00 F6</td>
</tr>
<tr>
<td>02039</td>
<td>Trig</td>
<td>01 02</td>
</tr>
<tr>
<td>02040</td>
<td>Trig</td>
<td>02 93</td>
</tr>
<tr>
<td>02041</td>
<td>Trig</td>
<td>03 2B</td>
</tr>
<tr>
<td>02042</td>
<td>Trig</td>
<td>04 8A</td>
</tr>
<tr>
<td>02043</td>
<td>Trig</td>
<td>05 F7</td>
</tr>
<tr>
<td>02044</td>
<td>Trig</td>
<td>06 20</td>
</tr>
<tr>
<td>02045</td>
<td>Trig</td>
<td>07 11</td>
</tr>
<tr>
<td>02046</td>
<td>Trig</td>
<td>08 BD</td>
</tr>
<tr>
<td>02047</td>
<td>Trig</td>
<td>09 DC</td>
</tr>
<tr>
<td>02048</td>
<td>Trig</td>
<td>0A DB</td>
</tr>
<tr>
<td>02049</td>
<td>Trig</td>
<td>0B A7</td>
</tr>
<tr>
<td>02050</td>
<td>Trig</td>
<td>0C 00</td>
</tr>
</tbody>
</table>

**Figure 9-16. Using "Show Level Step" with Predefined mode.**

Selecting the **Show Level Data** mode adds an **L** column to the display which is only one character wide (see Figure 9-17). The L column shows the active hardware level for each sample. Since the Predefined Trace Control setup in Figure 9-15 uses several internal hardware levels, the L column shows when each trigger event was found.

In Full Feature Trace Control mode, the triggering sequence consists of one or more software levels. If the software levels are from the list of Predefined Tasks, they are implemented with several internal hardware levels. If the software levels are from the list of Steps, they are implemented with one internal hardware level. You can give each software level a name.

The Trace Control Full Feature setup in Figure 9-18 performs the same function as the Predefined setup in Figure 9-15, but it uses Steps instead of the Predefined Task. The software levels "Find 02," "Find 05," and "Find 09" search for Addr 02, then Addr 05, then Addr 09. The last Step, "Fill 2K," collects 2048 post-trigger samples.
Figure 9-18. Full Feature Trace Control setup.

Selecting the **Show Level Step** mode adds a Level Info column to the display (see Figure 9-19). The Level Info column displays the name and level number of the active software level for each sample. Since the software level changes each time a trigger condition is found, the Level Info column shows when each trigger event was found.

![Figure 9-18](image)

<table>
<thead>
<tr>
<th>C</th>
<th>Sample M</th>
<th>Level Name</th>
<th>Address</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>02038</td>
<td>1:find pat1</td>
<td>087</td>
<td>06F</td>
<td></td>
</tr>
<tr>
<td>02039</td>
<td>1:find pat1</td>
<td>087</td>
<td>10F</td>
<td></td>
</tr>
<tr>
<td>02040</td>
<td>1:find pat1</td>
<td>000</td>
<td>000</td>
<td></td>
</tr>
<tr>
<td>02041</td>
<td>1:find pat1</td>
<td>000</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02042</td>
<td>1:find pat1</td>
<td>080</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02043</td>
<td>3:find pat2</td>
<td>098</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>02044</td>
<td>3:find pat2</td>
<td>000</td>
<td>000</td>
<td></td>
</tr>
<tr>
<td>02045</td>
<td>3:find pat2</td>
<td>087</td>
<td>38F</td>
<td></td>
</tr>
<tr>
<td>02046</td>
<td>3:find pat2</td>
<td>106</td>
<td>20C</td>
<td></td>
</tr>
<tr>
<td>02047</td>
<td>3:find pat2</td>
<td>100</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>02048</td>
<td>5:fill 2k</td>
<td>080</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02049</td>
<td>5:fill 2k</td>
<td>0A7</td>
<td>34F</td>
<td></td>
</tr>
<tr>
<td>02050</td>
<td>5:fill 2k</td>
<td>028</td>
<td>059</td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-19. Using "Show Level Step" with Full Feature mode.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample M</th>
<th>L</th>
<th>Address</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>02038</td>
<td>1</td>
<td>087</td>
<td>06F</td>
<td></td>
</tr>
<tr>
<td>02039</td>
<td>1</td>
<td>087</td>
<td>10F</td>
<td></td>
</tr>
<tr>
<td>02040</td>
<td>1</td>
<td>000</td>
<td>000</td>
<td></td>
</tr>
<tr>
<td>02041</td>
<td>1</td>
<td>000</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02042</td>
<td>1</td>
<td>080</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02043</td>
<td>3</td>
<td>098</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>02044</td>
<td>3</td>
<td>000</td>
<td>000</td>
<td></td>
</tr>
<tr>
<td>02045</td>
<td>3</td>
<td>087</td>
<td>38F</td>
<td></td>
</tr>
<tr>
<td>02046</td>
<td>3</td>
<td>106</td>
<td>20C</td>
<td></td>
</tr>
<tr>
<td>02047</td>
<td>3</td>
<td>100</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>02048</td>
<td>5</td>
<td>080</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>02049</td>
<td>5</td>
<td>0A7</td>
<td>34F</td>
<td></td>
</tr>
<tr>
<td>02050</td>
<td>5</td>
<td>028</td>
<td>059</td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-20. Using "Show Level Data" with Full Feature mode.

Selecting the **Show Level Data** mode adds an L column to the display which is only one character wide (see Figure 9-20). The L column shows the active hardware level for each sample and changes each time a trigger event is found.

If fewer than 4096 samples are taken during a recording, the data appears at the end of memory. The beginning of memory was not overwritten by the collected data and contains zeros. The Level Data for these samples is an "F," and the Level Step name is a row of periods.
Pattern Find

Finding certain patterns in the data

As you study the data in the State Display, you may want to find a certain data pattern or sequence of data patterns. You can search for a sequence if up to eight data patterns by using the State Search feature.

Select the Find... option from the State Options menu. The State Search window appears with a line of data (see Figure 9-21). An "X" ("don't care") appears for each character. To define the desired pattern, click on the digits you want to specify and enter values from the keyboard. You can only enter values appropriate for the current radix.

![Figure 9-21. State Search window.](image)

If you want to specify only some of the bits in a multi-bit character (such as a hex digit), click the Binary Expansion checkbox. All bits for each digit appear, and you can specify as many as you want. When you uncheck the binary expansion box, data returns to the original format. Characters with only some of their bits defined are displayed as semi-cares (§).

If you want to search for a pattern consisting of two, four or eight consecutive lines of data, click the corresponding button at the top of the window as shown in Figure 9-22.

![Figure 9-22. Searching for sequential lines of data patterns.](image)

To initiate the search, click the Find all button. If matches are found, the top of the window shows the line numbers of the first and last matching patterns, and the total number of matches found. Each matching sample is tagged with an asterisk in the
marker area to the right of the Sample column in the State Display (see Figure 9-23). See the Next/Previous section of this chapter for more information on using the marks in the State Display marker area.

![Figure 9-23. Matching samples are tagged with asterisks in the marker area.](image)

Normally, the markers remain in the marker area until you select Clear the marker data from the Options menu. If you are in Edit Reference mode in the Reference State Display, the markers are cleared from the marker area when you leave the window or change back to normal display mode.

You can leave the State Search window open while you study the State Display. To move quickly through the data to the matching patterns, click the Next or Previous buttons in the State Search window.

Close the State Search window by clicking in the window's close box in the upper left corner.

**Data Comparisons**

Comparing Last and Reference data in the State Display

You can compare the data in Last memory with the data in Reference memory and view the differences in the State Display. Make sure that you have meaningful data in the Reference memory by using the Transfer or Open commands (see Chapter 10).
To initiate the comparison, choose **Compare** from the State **Options** menu. The State Compare window appears and shows the total number of miscompares and the sample number of the first and last miscompare (see Figure 9-24).

![State Compare Window](image)

**Figure 9-24.** State Compare window.

Each miscompare is tagged with a not-equal sign (≠) in the marker area to the right of the Sample column (see Figure 9-25). See the **Next/Previous** section of this chapter for more information on using the marks in the State Display marker area.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>F5F4</td>
<td>F7F6</td>
<td>F9F8</td>
<td></td>
</tr>
<tr>
<td>0001</td>
<td>E9E8</td>
<td>EBEA</td>
<td>EDEC</td>
<td></td>
</tr>
<tr>
<td>0002</td>
<td>≠ DDSO</td>
<td>DFDE</td>
<td>E1E0</td>
<td></td>
</tr>
<tr>
<td>0003</td>
<td>D1D0</td>
<td>D3D2</td>
<td>D5D4</td>
<td></td>
</tr>
<tr>
<td>0004</td>
<td>C5C4</td>
<td>C7C6</td>
<td>C9C8</td>
<td></td>
</tr>
<tr>
<td>0005</td>
<td>≠ B9B9</td>
<td>BBBA</td>
<td>BDBC</td>
<td></td>
</tr>
<tr>
<td>0006</td>
<td>ADAC</td>
<td>AFRE</td>
<td>B1B0</td>
<td></td>
</tr>
<tr>
<td>0007</td>
<td>A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
<td></td>
</tr>
<tr>
<td>0008</td>
<td>≠ 9594</td>
<td>9796</td>
<td>9998</td>
<td></td>
</tr>
<tr>
<td>0009</td>
<td>≠ 8988</td>
<td>888A</td>
<td>8D8C</td>
<td></td>
</tr>
<tr>
<td>0010</td>
<td>7D7C</td>
<td>7F7E</td>
<td>B1B0</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 9-25.** Miscompares tagged with asterisks in the marker area.

Since the State Compare window is a window and not a dialog box, you can leave it open while you study the State Display. To initiate another compare, double-click anywhere in the lower part of the State Compare window.

If you are in the Last State Display window, the Last data is shown and the miscompares are tagged with ≠ signs. If you are in the Reference State Display window, the Reference data is shown and the miscompares are tagged.

Normally, the markers remain in the marker area until you select **Clear the marker data** from the **Options** menu. If you are in Edit Reference mode in the Reference State Display, the markers are cleared from the marker area when you leave the window or change back to normal display mode.

**Editing the Reference data**

In the Reference State Display, you can edit the Reference memory. This is useful if you want to compare the Last data to data that you have never been able to capture. You can correct
slightly flawed Reference recordings and create a perfect batch of data.

Make sure that you have meaningful data in the Reference memory by using the **Transfer** or **Open** commands (see Chapter 10). Then open the Reference State Display from the State Display menu. The Reference window is identical to the Last window except you can use the **Edit Reference** feature to change the Reference data. You can not edit the Last data in the Last State Display.

To edit the reference data, choose **Edit Reference** from the Reference State Display **Options** menu. You can only select the **Edit Reference** command when the Reference State Display is the current active window.

To change data, click on a data display character in the list and type a new value (see Figure 9-26). Use an "X" to indicate "don't care." You can enter any new value that is appropriate for the current display radix. For example, Hex data can be entered as 0-9, A-F. Binary data can only be changed to a 1 or a 0.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>00000</td>
<td>F5F4</td>
<td>F7F6 F9F8</td>
</tr>
<tr>
<td></td>
<td>00001</td>
<td>E9E8</td>
<td>EBEA EDEC</td>
</tr>
<tr>
<td></td>
<td>00002</td>
<td>DDDD</td>
<td>DFDE E1E0</td>
</tr>
<tr>
<td></td>
<td>00003</td>
<td>1D00</td>
<td>0000 D5D4</td>
</tr>
<tr>
<td></td>
<td>00004</td>
<td>C5C6</td>
<td>00C6 C9C8</td>
</tr>
<tr>
<td></td>
<td>00005</td>
<td>BB0B</td>
<td>BB0B BBBC</td>
</tr>
<tr>
<td></td>
<td>00006</td>
<td>ADAC</td>
<td>AFAC B1B0</td>
</tr>
<tr>
<td></td>
<td>00007</td>
<td>11A0</td>
<td>A3A2 A5A4</td>
</tr>
<tr>
<td></td>
<td>00008</td>
<td>9592</td>
<td>9796 9998</td>
</tr>
<tr>
<td></td>
<td>00009</td>
<td>9992</td>
<td>989A 8D8C</td>
</tr>
<tr>
<td></td>
<td>00010</td>
<td>707C</td>
<td>7F7E 8180</td>
</tr>
</tbody>
</table>

Figure 9-26. Editing data in the Reference State Display.

If you want to change only some of the bits represented by a data display character, you must change the radix to binary from the Reference Channel Setup window.

In the **Options** menu, a checkmark next to the **Edit Reference** option indicates that you are in the Edit Reference mode. Selecting the **Edit Reference** option again returns you to the normal display mode.

The changes you make to the Reference memory in the State Display are reflected in the Timing Display of Reference memory. The Timing Display also has data editing capabilities including a block edit feature that is not present in the State Display. You can use the block edit in the Timing Display to
make changes that are reflected in the State Display. See Chapter 8 for more information about the Timing Display.

**Markers**

**Marking lines of data in the display**

As you study the data in the State Display, you can manually mark certain samples of interest so that they are easy to find again. To mark a sample, double-click in the marker area between the sample number and the data. The letter "M" appears as shown in Figure 9-27. See the Next/Previous section of this chapter for more information on using the marks in the State Display marker area.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>F5F4</td>
<td>F7F6</td>
<td>F9F8</td>
</tr>
<tr>
<td>0001</td>
<td>M E9E8</td>
<td>EBEA</td>
<td>EDEC</td>
</tr>
<tr>
<td>0002</td>
<td>DDDD</td>
<td>DFDE</td>
<td>E1E0</td>
</tr>
<tr>
<td>0003</td>
<td>M D1D0</td>
<td>D3D2</td>
<td>D5D4</td>
</tr>
<tr>
<td>0004</td>
<td>C5C4</td>
<td>C7C6</td>
<td>C9C8</td>
</tr>
<tr>
<td>0005</td>
<td>B9B8</td>
<td>BBA</td>
<td>BDBC</td>
</tr>
<tr>
<td>0006</td>
<td>M ADAC</td>
<td>AFAE</td>
<td>B1B0</td>
</tr>
<tr>
<td>0007</td>
<td>M A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
</tr>
<tr>
<td>0008</td>
<td>9594</td>
<td>9796</td>
<td>9998</td>
</tr>
<tr>
<td>0009</td>
<td>8988</td>
<td>8B8A</td>
<td>8D8C</td>
</tr>
<tr>
<td>0010</td>
<td>7D7C</td>
<td>7F7E</td>
<td>8180</td>
</tr>
</tbody>
</table>

*Figure 9-27. Marking data samples.*

Normally, the markers remain in the marker area until you select **Clear the marker data** from the **Options** menu. If you are in Edit Reference mode in the Reference State Display, the markers are cleared from the marker area when you leave the window or change back to normal display mode.

**Next/Previous**

**Determining the function of the Next/Previous buttons**

At the top of the State Display are two buttons labeled **Next** and **Previous** (see Figure 9-28).

*Figure 9-28. Next and Previous buttons.*

You can use these buttons to move through the data to next and previous locations in the State Display. There are four possible types of locations that are found by the **Next** and **Previous** buttons. Their exact function depends on what is present in the marker area to the right of the sample numbers.
Several of the features described in the previous sections use the marker area to mark certain samples. There are three types of marks that can appear in the marker area as shown in Figure 9-29. These are described in detail in the previous section.

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001</td>
<td>E9E8</td>
<td>EBEA</td>
<td>EDEC</td>
<td></td>
</tr>
<tr>
<td>00002</td>
<td>≠</td>
<td>DDDC</td>
<td>DFDE</td>
<td>E1E0</td>
</tr>
<tr>
<td>00003</td>
<td>*</td>
<td>D1D0</td>
<td>D3D2</td>
<td>D5D4</td>
</tr>
<tr>
<td>00004</td>
<td>≈</td>
<td>C5C4</td>
<td>C7C6</td>
<td>C9C8</td>
</tr>
<tr>
<td>00005</td>
<td>≠</td>
<td>B9B8</td>
<td>BBA2</td>
<td>BDAC</td>
</tr>
<tr>
<td>00006</td>
<td>≈</td>
<td>ADAC</td>
<td>AF8E</td>
<td>B1B0</td>
</tr>
<tr>
<td>00007</td>
<td>*</td>
<td>A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
</tr>
<tr>
<td>00008</td>
<td>9594</td>
<td>9796</td>
<td>9998</td>
<td></td>
</tr>
<tr>
<td>00009</td>
<td>M</td>
<td>898B</td>
<td>8BBA</td>
<td>8D8C</td>
</tr>
<tr>
<td>00010</td>
<td>M</td>
<td>7D7C</td>
<td>7F7E</td>
<td>81B0</td>
</tr>
</tbody>
</table>

Figure 9-29. Marks in the marker area.

If there are any marks in the marker area, the Next and Previous buttons move the display to the next or previous mark. If there are no marks in the marker area, the buttons move the display to the next or previous change in Trace Control level or step. See the Viewing the Trace Control step for each line of data section of this chapter for more information.

If there is not a Next or Previous location to find, the Next or Previous button is greyed and cannot be selected. To remove all marks from the marker area, select Clear the marker data from the options menu.

There are four special markers that are created when several of the standard markers apply (see Figure 9-30). For example, on sample 1, both * and ≠ apply. The resulting symbol is a ™. The four special markers are created as follows:

- \((*)*($)\)
- \((*)*(M)\)
- \((M)*($)\)
- \((*)*($)*(M)\)

<table>
<thead>
<tr>
<th>C</th>
<th>Sample</th>
<th>Address</th>
<th>Data</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>00001</td>
<td>™</td>
<td>E9E8</td>
<td>EBEA</td>
<td>EDEC</td>
</tr>
<tr>
<td>00002</td>
<td>DDDC</td>
<td>D1D0</td>
<td>D3D2</td>
<td>D5D4</td>
</tr>
<tr>
<td>00003</td>
<td>≈</td>
<td>C5C4</td>
<td>C7C6</td>
<td>C9C8</td>
</tr>
<tr>
<td>00005</td>
<td>$</td>
<td>B9B8</td>
<td>BBA2</td>
<td>BDAC</td>
</tr>
<tr>
<td>00006</td>
<td>ADAC</td>
<td>AF8E</td>
<td>B1B0</td>
<td></td>
</tr>
<tr>
<td>00007</td>
<td>A1A0</td>
<td>A3A2</td>
<td>A5A4</td>
<td></td>
</tr>
<tr>
<td>00008</td>
<td>9594</td>
<td>9796</td>
<td>9998</td>
<td></td>
</tr>
<tr>
<td>00009</td>
<td>$</td>
<td>898B</td>
<td>8BBA</td>
<td>8D8C</td>
</tr>
<tr>
<td>00010</td>
<td>7D7C</td>
<td>7F7E</td>
<td>81B0</td>
<td></td>
</tr>
</tbody>
</table>

Figure 9-30. Special markers.
Using Next/Previous to find changes in Trace Control levels or steps

You can use the Next or Previous buttons to find the next or previous Trace Control level or step. Remove all marks from the marker area with the Clear the marker data option. Click on the Next or Previous button. The display scrolls to the sample containing the change in level or step. You do not need to have the Trace Control information displayed for this function to work, but it may help you interpret the results. See the Viewing the Trace Control step for each line of data section of this chapter for more information.

Using Next/Previous to locate the markers you placed

You can use the Next or Previous buttons to find the samples marked with the "M" markers. Remove all marks from the marker area with the Clear the marker data option. Double click in the marker area to mark the desired samples. Click on the Next or Previous button. The display scrolls to the next or previous marked sample. See the Markers section of this chapter for more information.

Using Next/Previous to locate samples marked by the Find feature

You can use the Next or Previous buttons to find samples marked by the State Search. Remove all marks from the marker area with the Clear the marker data option. Use the Find... option to perform the search. All matching samples are marked with an asterisk (*). Click on the Next or Previous button. The display scrolls to the next or previous marked sample. See the Pattern Search section of this chapter for more information.

Using Next/Previous to locate miscompares after a comparison

You can use the Next or Previous buttons to find samples marked by the Compare feature. Remove all marks from the marker area with the Clear the marker data option. Use the Compare option to perform the comparison of Last and Reference data. All miscompares are marked with a not-equal sign (≠). Click on the Next or Previous button. The display shows the sample containing the miscompare. See the Data Comparisons section of this chapter for more information.
Using the disassembler options at the bottom of the Options menu

One kind of accessory available for the CLAS 4000 is a MAP (Microprocessor Analysis Package). You can use MAP's to help debug target systems containing microprocessors. The MAP's are available for a variety of microprocessors and contain both hardware and software. The hardware consists of a special probe interface that allows you to easily collect data from all microprocessor pins.

The software part of the package allows you to see the disassembled microprocessor instructions in the order that they were executed. The data collected by the CLAS 4000 includes instruction fetches. The microcode can be seen in Hex format in the State Display, and the instruction mnemonics can be seen in the Disassembly window. This window can only accessed if the MAP software is installed.

The Disassembly window is very similar to the State Display and uses the same options menu. The last four lines in the State Display options menu contain the options for the Disassembly window. These are normally greyed and can only be selected when the Disassembly window is the current active window. All disassembly functions for a particular MAP are explained in the the manual that comes with the MAP accessory.

Contact the factory for a list of all MAP's that are currently available and additional information on the capabilities of any particular MAP.
Chapter 10  Working with the CLAS 4000

This chapter explains some of the extra features of the CLAS 4000 that can make digital problem solving easier. It tells how to transfer setups and data, save and open files from the hard disk, print data and setups, and move quickly from window to window when you have several open at once.

How to Juggle Windows

Overview

The CLAS 4000 user interface is based on a windowing environment in which many windows can be open at the same time. To use the analyzer efficiently, you must know how to manipulate the windows. This section offers some suggestions on how to arrange and move between windows. The basics of using a window are described in Part 1 of this manual.

Viewing a window that is partially covered

To view a window that is partially covered, click on any exposed part of the hidden window. The window becomes the current active window and is moved to the front. In Figure 10-1, the State Display window is almost completely hidden. Clicking on the exposed corner of the window moves it to the front as shown in Figure 10-2.

Figure 10-1. Clicking on a partly hidden State Display window.

Figure 10-2. State Display window brought to the front.
Viewing a window that is totally hidden

As you move the windows around the display, a window you want to use may become completely hidden. There are five different methods for bringing a hidden window to the front as the current active window. In Figure 10-3, both the Timing and State windows are open, but the State window is completely hidden behind the Timing window. Each of the methods described on the following pages can be used to bring the State window to the front.

Figure 10-3. Timing window covering the State window.
Method #1 (see Figures 10-4 and 10-5):
Rearrange the windows using the **Stack Windows** option from the **Windows** menu. This option enlarges all open windows and arranges them such that all the title bars can be seen at the top of the screen. Once the State window title bar is visible, you can click on it to bring the State window to the front.

![Figure 10-4. Method #1, selecting "Stack Windows."](image)

![Figure 10-5. Method #1, Stacked windows.](image)

This method has a slight disadvantage. When you click on the State window title bar, the State menu is brought to the front as desired, but the Timing window is now completely hidden.
Method #2 (see Figures 10-6 and 10-7):
Rearrange the windows using the **Tile Windows** option from the **Windows** menu. This option adjusts the size and position of all the open windows such that every window can be seen. The windows are arranged in a tile pattern that fills the screen. Once the State window is visible, you can click on it to make it the current active window.

Figure 10-6. Method #2, Selecting "Tile Windows."

Figure 10-7. Method #2, Tiled windows.
Method #3 (see Figure 10-8):
The lower part of the Windows menu contains a list of all open windows. Select the window's name from the list to bring it to the front as the current active window.

![Windows Menu](image)

Figure 10-8. Method #3, Selecting the window title from the Windows menu.

Method #4 (see Figure 10-9):
Move the Timing window out of the way. This can be done by changing the size of the window with the size box, or moving the window by dragging the title bar. Once the Timing window is partially out of the way, you can click anywhere on the State window to bring it to the front.

![State Window](image)

Figure 10-9. Method #4, Dragging the Timing Display window out of the way.
Method #5 (see Figure 10-10):
Select Last from the State menu. The checkmark next to "Last" tells you that the window is already open. Selecting Last again brings the window to the front.

This method has one great advantage. If you cannot see a window, it may be hidden or it may not even be open. This method brings the window to the front in either case.

Viewing all windows at once and moving quickly from one another

If you have several windows open, you can use the Tile Windows option from the Windows menu to organize the display (see Figure 10-11). The Tile function spreads the windows over the screen in a tile pattern. The windows are made small enough that they can all fit on the screen (see Figure 10-12).

You can use the zoom boxes on the windows to switch your view quickly from one full-size window to another. Zoom any window up to full size. When you are finished with it, click the zoom box again and the window returns to its previous size. Then click another window’s zoom box to see it full size. Keep in mind, though, that if you resize or move a window after zooming it up to full size, it will not return to the tiled windows.
pattern when you click the zoom box again. If this happens, select **Tile Windows** again from the **Windows** menu.

**Figure 10-12. Tiled Windows**

The cursors track between the State and Timing windows and between Last and reference. This is especially useful when you have several data display windows open at once. You can move the cursor in the Timing Display and it moves to the same samples in the State Display. Move a cursor in the State Display, and it tracks in Timing.

**How to Open and Save**

**Overview**

As you work with setups and data, you may want to save them on the hard disk for future use. When you save a Next, Last, or Reference setup, all parameters and configurations from the Channel Setup, Trace Control Setup, and Arm Control Setup windows are saved in the setup file. When you save a Last or Reference setup, you also save the data in the Last or Reference memory buffer.
Since the setup file only contains information about the three setup menus, any changes you make to the format of the Timing Display are not saved in a Next setup file. All the timing labels and timing formats are saved with the Last data. If you have customized the Timing Display and you want to save your changes, you must save the Last setup and data. To retrieve your custom timing format, you must open the Last setup and data file and use it in Last. The same principles apply to Reference data and setups.

Use the **Save as...** and **Open...** commands in the file menu to open the dialog boxes for saving and opening setup files (see Figure 10-13).

### Moving to a different folder

Files are saved on the hard disk in a hierarchical format using Folders to create directories and sub-directories. (See Part 1 of this manual for basic information on arranging files and folders on the desktop.) Figure 10-14 shows a sample hierarchy of a hard disk. The top level root directory of the hard disk is called "20 MB HD." This top level contains two lower level folders, "System" and "CLAS 4000." The "CLAS 4000" folder contains three lower level folders, "Jim's setups," "Robin's setups," and "Disassemblers."

![Hierarchy of Folders](image)

**Figure 10-14. Sample hard disk hierarchy of folders.**

You can move to different folders using the top portions of the **Save as...** and **Open...** dialog boxes. A **Save as...** dialog box is used as an example in this section, but you can use the same methods in an **Open...** dialog box.

Selecting **Save as...** from the File menu opens the **Save as...** dialog box (see Figure 10-15). The top part is used to navigate through the hierarchy of folder. The bottom part is for naming the file and specifying which setup to save.
The current folder is "CLAS4000Folder" as indicated in the Folder field at the top of the dialog box. The contents of the folder are shown in the scroll window in the center. The names of folders are shown in dark letters and are selectable. The names of files are shown in greyed letters because you have no reason to select them in a \textit{Save as...} dialog box.

![Figure 10-15](image)

\textbf{Figure 10-15.} Save as... dialog box.

To move down the hierarchy into a folder shown in the scroll window, double click on the folder name (see Figure 10-16). The new folder name appears in the Folder field at the top of the dialog box (see Figure 10-17). Files are always saved into the current folder shown at the top. The names of other files in the folder are greyed.

![Figure 10-16](image)

\textbf{Figure 10-16.} Moving down the hierarchy by double-clicking on a folder name.

![Figure 10-17](image)

\textbf{Figure 10-17.} "Jim's Setups" is now the current folder.
To move up the heirarchy to a folder above the current one, open the Folder field and select the desired folder name as shown in Figure 10-18. Keep in mind that as you move the selection bar down the menu, you are moving to higher levels in the folder hierarchy.

![Figure 10-18. Moving up the heirarchy.](image)

**Moving to a different disk drive**

If there is a floppy disk in the floppy disk drive or there are several hard disks connected to the SCSI bus, you can save and retrieve setup files from the other disks. You can use the Drive button to access a different disk drive as shown in Figure 10-19. Clicking the Drive button repeatedly alternates between the available drives. If no other disks are available, the Drive button is greyed. The name of the currently selected disk is always shown in the upper right corner of the dialog box.

![Figure 10-19. Accessing to a different disk drive.](image)

If the currently active drive is a floppy disk, you can eject it from the drive by clicking on the Eject button. After the floppy disk is ejected, the hard disk is automatically selected. When the currently active drive is the hard disk, the Eject button is greyed because ejecting a hard disk would be extremely undesirable.
Saving the Next setup for future use

You can save the Next setup information to a setup file for future use. Select the **Save as...** command from the **File** menu to open the **Save as...** dialog box. Use the upper portion of the dialog box to specify the destination folder for the saved file. (See the Moving to a different folder and Moving to a different disk drive sections of this chapter for more information on changing folders.)

Type a name for the setup file in the **Filename** text field (see Figure 10-20). Click the **Next** button to specify saving the information in the Next setup menus. Click the **Save** button to save the file and close the dialog box.

![Figure 10-20. Saving Next setup.](image)

When you save a Next setup, you only save the information from the Next Channel Setup, Next Trace Control Setup, and Next Arm Control Setup windows. If you want to save a Timing Display format, you must save a Last or Reference setup.

Saving the Last or Reference setup and data

You can save the Last or Reference setup information to a setup file for future use. The procedure is identical to the one described in the Saving the Next setup for future use section of this chapter except you click the **Last setup with data** or **Reference setup with data** button.
Saving the State or Disassembly data in a text format

Data is normally saved on the hard disk in a binary format that cannot be edited or viewed. You may want to use parts of the data in a document or use the data in another software package, like an FFT program.

You can save the data on the hard disk in an ASCII text format by using the **Save as Text**... command from the **File** menu (see Figure 10-21). The command is only selectable when either the State or Disassembly displays are active.

The **Save** dialog box appears as shown in Figure 10-22. Select the destination folder and type the desired file name. Click **Save** to go on.

![Figure 10-21. Saving data in ASCII text format.](image)

**Figure 10-22. Save as...dialog box for Save as Text.**

Another dialog box appears as shown in Figure 10-23. Specify which samples you want to save. You can save all the samples, the samples between the current cursor locations, or the samples specified in the sample fields. Click **OK**... to save the file.

While the file is being written, a dialog box with a bar graph shows you the progress (see Figure 10-24).

![Figure 10-23. Specifying the desired samples.](image)
The saved file is a standard ASCII file that can be viewed and edited in a text editor. The file format for saved State data is shown in Figure 10-25.

Figure 10-26 shows the same file with edit marks displayed. The small dot indicates a "space" character (ASCII code 20 Hex). The arrow indicates a "tab" character (ASCII code 09 Hex) which is used to separate the columns. The paragraph mark at the end of the line indicates a "carriage return" character (ASCII code 0D Hex).

The first column contains the cursor information. The cursor names are shown on the samples containing the cursors in the State display. The second column contains the sample numbers. The third column shows any markers that are currently present in the State display marker area. The data from each group is displayed in its own column. If the Time Stamps are displayed in the State display, they will appear in the far right column of the file.

If you want to use the data in another software package like an FFT program, you may need to strip out some of the formatting characters and convert it to binary. You can write a simple C program to do this, or you may be able to do the necessary changes by hand.
Keep in mind that the text file cannot be reopened by the CLAS 4000 software. Use the **Save as Text**... only for transferring the data to other software packages. No setup information is saved, and the file cannot be used by the CLAS 4000 software in any way.

**Viewing saved files on the desktop**

When you are not running an application program like the CLAS 4000 software, you can look at the setup file icons in a folder from the desktop. The setup file icons are the same style as document icons. They appear as a rectangle with a folded corner. Setup files that contain both setup and data have a black folded corner. Setups without data have a white folded corner.

The body of the icon contains timing traces. The number of traces tells you how many boards were present in the analyzer configuration when the file was saved. For example, setup files saved for a two-board, 192-channel analyzer have two timing traces in the icon.

The name of the setup file appears below each icon. Several setup icons are shown in Figure 10-27.

![Jim's Setups](image)

**Figure 10-27.** Folder containing setup files.

**Opening setup files from the hard disk**

You can use setup files on the hard disk for the **Next** setup menus using the **Open**... dialog box. It is the same as the **Save as**... dialog box except for a few minor differences. The Open dialog box has no text field for entering the name of the file. Also, setup file names can be selected from the scroll window.
Select the **Open**... command from the **File** menu to open the dialog box. Use the upper portion of the dialog box to specify the folder containing the setup file. (See the **Moving to a different folder** and **Moving to a different disk drive** sections of this chapter for more information on changing folders.)

Click the **Next**, **Last** (with **Data**) or **Reference** (with **Data**) button to see a list of available setups in the scroll window. If you select Last or Reference, only files containing data are shown in the file list. Click on the name of the desired setup file to highlight it (see Figure 10-28). Click the **Open** button to open the file and exit the dialog box.

![Figure 10-28. Opening a Next setup file.](image)

When you save a setup file, the current analyzer configuration (number of data boards) is saved as part of the setup file. A setup file can only be used by analyzers with the same configuration. For example, if you save a setup while the analyzer is configured as a two-board, 192-channel analyzer, the setup file cannot be used by a one-board, 96-channel analyzer. It does not matter how many channels are actually used in the setup.

Only setup files with matching configurations can be seen in the scroll window of the **Open** dialog box. If you do not see the setup file that you want to open, make sure the analyzer is configured for the correct number of data boards. Also make sure that you are not trying to open a file without data into Last or Reference. (See Chapter 4 for more information on the analyzer configuration.)
When you open a setup file for Next, only the Next Channel Setup, Next Trace Control Setup, and Next Arm Control Setup windows are affected. If you want to retrieve data or a Timing Display format, you must open a Last or Reference setup and data file. When you open a setup file with data into Last or Reference, the setup information is used in the setup windows, the data is stored in the display windows, and the timing labels and timing format are used in the Timing Display.

How to Transfer

Overview

You can use the Transfer menu to move setups and data between Last, Reference and Next. See the beginning of Chapter 5 for a complete explanation of the Last, Reference and Next.

Transferring the setup and data from Last to Reference

If you want to save the Last data temporarily while you take new recordings, you can transfer it to Reference. Keep in mind that a more permanent way to save Last data is to save the data on the hard disk.

You may also want to transfer data to the Reference memory to use the Compare features available in the Timing and State displays. Of course, you can also retrieve Reference data from the hard disk.

To transfer the setup and data from Last to Reference, choose Last ➔ Reference from the Transfer menu (see Figure 10-29). The old contents of the Reference setup menus and data buffer are overwritten with the Last setup and data.

![Transfer Menu](image)

Figure 10-29. Transferring setup and data from Last to Reference.

Transferring the setup from Last to Next

The Last setup windows contain the setup that was used to collect the data in the Last buffer. This setup is not necessarily the same as the setup in the Next setup windows. If you want to use the Last setup for your next recording, you can transfer the setup from Last to Next. You could also save the Last setup on
Chapter 10 Working with the CLAS 4000

the hard disk and then use it in Next, but transferring is much faster.

To transfer the Last setup to Next, choose Last >> Next from the Transfer menu. The Next setup menus are overwritten with the information in the Last setup menus.

Transferring the setup from Reference to Next

The Reference setup menus contain the setup that was used to collect the data in the Reference buffer. This setup is not necessarily the same as the setup in Next. If you want to use the Reference setup for your next recording, you can transfer the setup from Reference to Next.

To transfer the Reference setup to Next, choose Reference >> Next from the Transfer menu. The Next setup menus are overwritten with the information in the Reference setup menus.

How to Print

Overview

Documentation is an important part of any project. You can use the printing capabilities of the CLAS 4000 to get printouts of setup and data windows as well as long printouts of the entire memory buffers.

Connecting the printer

To connect the printer to the computer, plug the printer cable into the printer port on the back. The printer icon appears above the port and is shown in Figure 10-30.

Make sure the printer is plugged into an adequate power source and turn it on. Check the paper tray to make sure it contains a supply of the size paper you want to use.

Selecting the printer in the Chooser

Open the Chooser from the menu at the far left of the menu bar (see Figure 10-31).
The Chooser window appears as shown in Figure 10-32. Click on the printer icon in the left side of the window that matches the printer you are going to use. The box on the right side of the window lists the names of all printers of the specified type that are connected to the computer. Select the name of your printer and close the window.

![Chooser window](Figure 10-32. Chooser window.)

If your printer type does not appear in the left side of the window, you probably do not have the file for that printer type in the system folder.

### Adjusting the page setup

To adjust the page setup parameters, select **Page Setup...** from the **File** menu (see Figure 10-33). A dialog box appears, with default settings for paper size, image size, orientation, and special printer effects. The Page Setup dialog box depends on the printer you are using, but it should look similar to Figure 10-34.

![Page Setup dialog box](Figure 10-34. Page Setup Dialog Box)

Change the paper size if any paper other than the standard US Letter (8 1/2 X 11 inch) is being used. Reduce or enlarge the image by entering percent values from the keyboard. Even
increments such as 50% and 200% will produce the clearest
results. Change the orientation if you want to print sideways on
the paper. This creates printouts that are 8 1/2" tall and 11"
wide.

Unless you have a special need for unusual fonts or graphics,
leave the special printer effects in their default settings.

Printing the information in a window

You can print the contents of the current window by using the
Print Window... option from the File menu. A printer dialog
box appears and should look similar to the one in Figure 10-35.

![Figure 10-35. Print dialog box.]

In most cases, you can leave all parameters in at their default
settings. Click OK to start the print job. The progress of the job
will be indicated by message boxes that appear on your screen.
For information on these messages, see your computer or printer
manual.

Printing a long document of State Display data

You can print a long document of the State data. Open the State
Display and select the Print Long... option from the File menu.
The option is only selectable when one of the data display
windows is open. The Print Selection Dialog box appears as
shown in Figure 10-36.

![Figure 10-36. Print Selection dialog box.]

Use the dialog box to specify which samples to print. Click in
the appropriate radio button to print all samples, the samples
between the cursors, or the samples specified. Click the Print... button to close the Print Selection dialog box and open the Print dialog box. See the previous section for a complete explanation of the Print dialog box.
• Part 3  Advanced Uses of the CLAS 4000 •
Part 3  Advanced uses of the CLAS 4000
Chapter 11  Full Feature Trace Control

Chapter 6 explained how to use the Predefined mode of Trace Control to solve most of your triggering needs. The Predefined Tasks, however, cannot solve every application. For the more complex applications, you may need to use the increased capabilities of the Full Feature Trace Control.

This chapter explains how to use the Full Feature mode to build multi-step triggering schemes with counters, timers, branches, and loops. It is assumed that you have read Chapter 6 and are very familiar with Predefined mode, pattern definition, and all other setup windows.

The Additional Triggering Techniques section of this chapter covers other Trace Control options that you may need for complex triggering. Some of these, like the OR groups and ranges, are also available in Predefined mode.

To get into Full Feature mode, select Full Feature Mode from the Trace Ctl menu on the top menu bar (see Figure 11-1).

Overview

Getting to know Full Feature Trace Control

The Trace Control window in Full Feature mode is slightly different from the window in Predefined mode (see Figure 11-2). The Steps and Seq. menus are added to the right of the Tasks menu. Below these menus are the Append and Delete buttons. In Predefined mode, the entire triggering scheme consisted of a single Task. Full Feature mode allows you to combine Tasks and Steps to create multi-step triggering schemes.

Figure 11-2. Trace Control window in Full Feature mode.
Determining when to use a Task, Step or Sequence

In Predefined mode, you can change a Trace Control level to one of the Tasks in the Tasks menu. In Full Feature mode, you can also select from the list of Steps and Sequences.

In Chapter 6, you learned that the Predefined Tasks are macros created from low-level language steps. All the steps are hidden, and only the main parameters need to be selected. The Predefined Tasks do not cover all possible triggering applications, however. You may need to build your own setups out of the low-level language steps.

The Steps menu lists all the low-level language steps that you can use to build complex triggering schemes (see Figure 11-3). The Steps contain a variety of tools that offer different triggering capabilities. Other sections of this chapter provide more information on the Steps.

<table>
<thead>
<tr>
<th>Input Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay/Input Step</td>
</tr>
<tr>
<td>Edge, Glitch Step</td>
</tr>
<tr>
<td>Count Events Step</td>
</tr>
<tr>
<td>Delay/Edge/ Step</td>
</tr>
<tr>
<td>Loop/Delay/Edge/ Step</td>
</tr>
<tr>
<td>Full Step</td>
</tr>
<tr>
<td>Set Loop Counter</td>
</tr>
<tr>
<td>Input Branch</td>
</tr>
<tr>
<td>Delay/Input Branch</td>
</tr>
<tr>
<td>Edge, Glitch Branch</td>
</tr>
<tr>
<td>Delay/Edge/ Branch</td>
</tr>
<tr>
<td>Loop/Delay/Edge/ Branch</td>
</tr>
<tr>
<td>Full Branch</td>
</tr>
</tbody>
</table>

Figure 11-3. List of Steps.

The Seq. (Sequences) menu contains a list of the Tasks. This menu provides the exact same triggering capabilities as the Tasks menu. The only difference is the way the Tasks are displayed. Tasks are macros created from Steps. When you select a Task from the Tasks menu, the Steps are hidden to make the Task easier to read and use.

When you select a Task from the Seq. menu, it is displayed in an expanded form in a low-level language like the Steps. By looking at Tasks in sequence form, you can determine how the Tasks work on a more basic level. Use these as models for
creating your own multi-level Trace Control schemes using the Steps.

**Multi-level Trace Control**

**Highlighting a Trace Control Level**

The operations described in the following sections require you to highlight a Trace Control level. To highlight the level, click on a place within the level boundaries that does not contain a changeable field. For example, Figure 11-4 shows clicking below the level name.

![Figure 11-4. Highlighting a level.](image)

If you click on a changeable field in the level, you can change the contents of the field, but the entire level is not highlighted. In fact, a good way to unhighlight a level is to momentarily click on one of the changeable fields.

**Adding a Trace Control level**

One of the main advantages of Full Feature Trace Control is the ability to create multi-level triggering schemes. The default Full Feature setup contains only one level. You can add a new level by either appending it to the current triggering scheme, or inserting it between two existing levels.

To append a new level, click the **Append** button in the window or select **Append** from the **Edit** menu (see Figure 11-5).

![Figure 11-5. Appending a new level.](image)

To insert a new level above an existing one, highlight the level and select **Insert** from the **Edit** menu.

**Deleting a Trace Control level**

To delete a level from the Trace Control scheme, highlight the level and click the **Delete** button or select **Clear** from the **Edit** menu (see Figure 11-6).
Changing a Trace Control level to a Task, Step, or Sequence

Any level can be changed to a Task, Step, or Sequence. In Predefined mode, all you had to do was select a new Task from the Tasks menu. In Full Feature mode, changing a level is a two-step process.

Since a Full Feature setup can contain many levels, you must first highlight the level you want to change. If no levels are highlighted, the Tasks, Steps and Sequences are all greyed.

After you have highlighted the level you want to change, you can select a new level from the lists of Tasks, Steps and Sequences.

Steps

Getting an overview of the Steps

The fourteen Steps all have slightly different capabilities and can be combined to create powerful triggering schemes (see Figure 11-7). Each of the first seven Steps can search for one condition and have one possible exit point. These vary in complexity from the simple Input Step to the powerful Full Step.

Input Step
Delay/Input Step
Edge, Glitch Step
Count Events Step
Delay/Edge/ Step
Loop/Delay/Edge/ Step
Full Step
Set Loop Counter
Input Branch
Delay/Input Branch
Edge, Glitch Branch
Delay/Edge/ Branch
Loop/Delay/Edge/ Branch
Full Branch

Figure 11-7. Steps menu.

The last six Steps have branching capabilities. They can search simultaneously for two separate conditions, and they have two possible exit points. Each of the first seven Steps have a branch version except the Count Events Step.
Some complex applications require looping through a series of steps. For example, it takes five Steps to find a certain complex event. You want to trigger on the tenth occurrence of this event. In order to trigger, you need to loop through the five Steps ten times. Full Feature mode has a loop counter that you can use for this purpose. Just above the branches is a Step called, Set Loop Counter, which controls the loop counter.

For complex applications, you may need to use several Steps to create a multi-level triggering scheme.

Getting to know what triggering Tools are available in each Step

When you build your triggering scheme, you can use complete Tasks from the Tasks menu, or individual Steps from the Steps menu. As you know, Tasks are actually made up of smaller pieces called "Steps." Similarly, the Steps are made up of smaller pieces called, "Tools."

In order to decide which Steps to use for your triggering scheme, you need to know what Tools are available in each Step. The Steps have various Tools that perform triggering functions.

For example, all the Steps except Set Loop Counter have the ability to search for a pattern. This is called the PATTERN SEARCH Tool. All the Steps can control the global timer. This is called the TIMER ON/OFF Tool. Steps with "LOOP" in their name can check the current loop counter value because they have the CHECK LOOP COUNT Tool. There are twelve different Tools, and each Step has a different combination of them.

The best way to pick a Step from the menu is to first decide what Tools you need, and then find the Step that has them. Table 11-1 lists all the available Tools. The description for each Tool includes the Tool's purpose and an example. Use this table to become familiar with the Tools and find the ones you need.

In each example, the Tool is shown in bold type and all the changeable fields in the example Step are underlined.
<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Purpose and Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMER ON/OFF</td>
<td>Purpose: Turn the global timer on or off. Timer keeps track of how much time is spent in Steps that have the timer enabled.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td>Store if input is Pattern 1.</td>
</tr>
<tr>
<td></td>
<td>Stop if input is Pattern 2.</td>
</tr>
<tr>
<td>SIMPLE STORE</td>
<td>Purpose: Allows you to filter out unwanted data. Samples are only saved if they match the specified pattern, OR group, or range.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if input is Pattern 1.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stop if input is Pattern 2.</strong></td>
</tr>
<tr>
<td>GOTO/STOP</td>
<td>Purpose: Controls the flow of the triggering scheme. Tells what to do when the condition is found.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if input is Pattern 1.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stop if input is Pattern 2.</strong></td>
</tr>
<tr>
<td>PATTERN SEARCH</td>
<td>Purpose: Search for a pattern, OR group, or range to be true. You can also search for the pattern to be false by selecting “isn’t” instead of “is.”</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if input is Pattern 1.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stop if input is Pattern 2.</strong></td>
</tr>
<tr>
<td>2ND GOTO/STOP</td>
<td>Purpose: Allows branching. Searches for two separate conditions simultaneously.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if input is Pattern 1.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stop if input is Pattern 2.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Go on if input is Pattern 3.</strong></td>
</tr>
<tr>
<td>COMPLEX STORE</td>
<td>Purpose: Allows you to use transitions and other options as part of the store condition. Use this technique to make a transitional recording.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if A transition occurs and</strong></td>
</tr>
<tr>
<td></td>
<td>if input is Pattern 1.</td>
</tr>
<tr>
<td></td>
<td><strong>Stop if A sample occurs and</strong></td>
</tr>
<tr>
<td></td>
<td>if input is Pattern 2.</td>
</tr>
<tr>
<td>EDGE DETECTION</td>
<td>Purpose: Allows you to use transitions and other options as part of the search condition.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if A sample occurs and</strong></td>
</tr>
<tr>
<td></td>
<td>if input is Pattern 1.</td>
</tr>
<tr>
<td></td>
<td><strong>Stop if A transition occurs and</strong></td>
</tr>
<tr>
<td></td>
<td>if input is Pattern 2.</td>
</tr>
<tr>
<td>DELAY</td>
<td>Purpose: Allows you to use a delay as part of the search condition.</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><strong>Step #A</strong> The timer is on. Set delay for 200 samples.</td>
</tr>
<tr>
<td></td>
<td><strong>Store if input is Pattern 1.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Stop if &lt;= delay and</strong></td>
</tr>
<tr>
<td></td>
<td>if input is Pattern 2.</td>
</tr>
<tr>
<td>Tool Name</td>
<td>Purpose and Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| COUNT EVENTS            | Purpose: Allows you to use the number of occurrences of an event as part of the search condition. The event is defined on the last two lines.  
Example:  
Step #A  The timer is on. Set delay for 200 events.  
Store if input is Pattern 1 and  
if A sample occurs.  
Stop if <= event count and  
if input is Pattern 2 and  
if A sample occurs.  
Event if input is Pattern 3 and  
if A sample occurs.                                                                                                                                                                                                                                                                   |
| INCREMENT LOOP COUNT    | Purpose: Specify the desired final loop count value in the "Preset..." line. The current loop counter value is checked against this final value during a LOOP COUNT CHECK in another Step. The loop counter is incremented each time you pass through this level.  
Example:  
Step #A  The timer is on.  
Preset the Loop Counter for 100 Loops.  
Increment Loop on entering this step.  
and Store if A sample occurs and  
if input is Pattern 1.  
Go on.                                                                                                                                                                                                                                                                                       |
| LOOP COUNT CHECK        | Purpose: Checks to see if the loop counter has reached its final value. Same as DELAY except the condition "Delay" can be replaced by "The loop count" or "The count." The latter is the same as "Delay."  
Example:  
Step #A  The timer is on. Set delay for 200 samples.  
Store if A sample occurs and  
if input is Pattern 1.  
Stop if <= The loop count and  
if A sample occurs and  
if input is Pattern 2.                                                                                                                                                                                                                                                                     |
| COUNTER CONTROL         | Purpose: In DELAY, you can use the delay counter to count within the Step. COUNTER CONTROL allows you to continue counting with the same delay counter value even after going to other Steps.  
Example:  
Step #A  The timer is on. The counter is on.  
Load delay for 200 samples.  
Store if A sample occurs and  
if input is Pattern 1.  
Go on and Keep Counting  
if <= The count and  
if A sample occurs and  
if input is Pattern 2.                                                                                                                                                                                                                                                                     |

Table 11-1. The twelve Tools found in Steps.
Table 11-2 lists all the Steps and shows what Tools are available in each one. Once you know what Tools you need, use this table to pick a Step that has all the required Tools for your application.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Tools</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Step</td>
<td>TIMER ON/OFF</td>
<td>SIMPLE STORE</td>
<td>GOTO/STOP</td>
<td>PATTERN SEARCH</td>
<td>2ND GOTO/STOP</td>
<td>COMPLEX STORE</td>
<td>EDGE DETECTION</td>
<td>DELAY</td>
<td>COUNT EVENTS</td>
</tr>
<tr>
<td>Delay/Input Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge, Glitch Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Count Events Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay/Edge/Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loop/Delay/Edge/Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Step</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Loop Counter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay/Input Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge, Glitch Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay/Edge/Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loop/Delay/Edge/Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Branch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As you become familiar with the capabilities of each Step, it may be helpful to consider how the Steps relate to each other. For example, a Delay/Input Step is just like an Input Step except it also has the DELAY Tool.

Figure 11-8 shows the differences between the Steps. The ovals represent Tools, and the rectangles are the Steps. Follow the arrows from the top of the Figure to any of the Steps. All Steps contain the TIMER ON/OFF, SIMPLE STORE, and GOTO/STOP.
Tools. The **Input Step** also contains the PATTERN SEARCH Tool.

The **Input Branch** is the same as the **Input Step** except it has the 2ND GOTO/STOP. Likewise, the **Full Step** is the same as the **Loop/Delay/Edge/ Step** except it has the COUNTER CONTROL Tool.

![Diagram](image-url)

**Figure 11-8.** Tools available in each Step relative to other Steps.
OR Groups and Ranges

Using OR groups

You can use an OR group as the search condition by selecting `New OR Group...` from the pattern pop-up menu as shown in Figure 11-9. The OR Group dialog box appears. Open the pop-up menus and select the patterns that you want to OR together (see Figure 11-10). If any of the patterns goes true, the entire OR group is true. If you have defined ranges, you can use the ranges in the OR group also.

![Figure 11-10. OR Group dialog box.](image)

You can search for one of the patterns to be false by changing the "equal" sign in front of the pattern name to a "not-equal" sign. You can also name the OR group by typing a name in the field at the bottom of the dialog box. When you are finished, click `OK` to return to the Trace Control window. The name of the OR group appears as the search event (see Figure 11-11).

![Figure 11-11. Using the OR group in the Trace Control level.](image)

Once an OR group has been defined, you can use it in other levels by selecting `OR groups...` from the pattern pop-up menu. A dialog box appears with the names of all the existing OR groups. Select the OR group that you want to use.

Deselect the OR group by selecting "Don't Care" for all patterns, then the OR group will disappear and you can again choose the patterns.
You can actually AND conditions together with the OR groups by using the "not-equal" capabilities. By using the logical NOT, an AND can be defined in terms of an OR:

\[ A \times B = (\overline{A + B}) \]

It is normally not necessary to AND patterns together because you can define a single pattern as certain values in many different groups. There are some applications, however, that require ANDing a pattern with a range.

For example, you can trigger on a write to ROM, which is obviously an error condition. Define a pattern, "Write," that indicates a write condition. Define a range, "ROM range," that is the ROM address space. Use the "not-equal" in the OR group to AND the "Write" pattern with the "ROM range." In Figure 11-12, the expression,

\[ \text{isn't}(\neq \text{"Write"}) \text{ OR } (\text{out of "ROM range"}) \],

is the same as

\[ \text{is}(\eq \text{"Write"}) \text{ AND } (\text{in "ROM range"}) \].

Figure 11-12. Triggering on a write to ROM using the ANDing capabilities of the OR group.
Using Ranges

You can use a range as a trigger condition instead of a pattern. Open the Range dialog box by selecting **Range Detection**... from the **Trace Ctrl** menu or clicking on the Range icon to the right of the Pattern icon (see figures 11-13). The Range dialog box appears as shown in Figure 11-14.

![Figure 11-13. Range icon.](image)

![Figure 11-14. Range dialog box.](image)

Select a channel group from the pop-up menu at the top of the dialog box. The channel group can contain up to thirty-two channels. All the channels in the group must be on the same half of one data board. For example, define a 32-channel Address group using channels A31-A00, not A71-A40. Do not cross the channel 47/48 boundary.

There are eight fields in the dialog box for defining specific range border values. These values are used to "tag" places in the Address space, for example. All addresses between two tags are in that range. You can use the tags to divide the Address space into eight contiguous ranges. If you want to define two non-contiguous ranges, define three contiguous ones, and ignore the one in the middle. Make sure to define the tags in ascending order. The range names appear at the left and can be changed by typing over the old ones.
After you have defined the ranges, you can select them from the pattern list pop-up menus in the Trace Control Steps. The range names do not appear until the ranges have been defined. The ranges are also not available in 5 ns or 10 ns internal clock modes.

You will get an error message if a channel group that crosses the channel 47/48 boundary is selected in the top pop-up menu. You will also get an error message if the range tags are not defined in ascending order. For example, if the upper boundary of a range is below the lower boundary, you will get an error message when you close the window. Also, an error message appears if the group has been changed to a duplicate group.

Transitions and Glitches

Detecting Transitions

The CLAS 4000 can detect transitions on a channel or group of channels when sampling data in all clock modes. There are two common applications for detecting transitions: transitional recording and edge detection.

Transitional recording stores samples into the memory buffer only when the data changes. This is especially useful when the data appears in bursts. Transitional recording ignores the dead time between data bursts, and records at high sample rates when the data is changing. To use transitional recording, define the transition in the Pattern Definition window and then use the COMPLEX STORE Tool in one of the Steps.

Edge detection searches for a pattern to become true. If it is already true when the search begins, the pattern must go false and then true again to satisfy the search condition. To use edge detection, define the transition in the Pattern Definition window and then use the EDGE DETECTION Tool in one of the Steps.

<table>
<thead>
<tr>
<th>Trace Control Pattern Definition (LA 1 → Next)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glitch Width</td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>20ns</td>
</tr>
<tr>
<td>Glitch</td>
</tr>
<tr>
<td>Transition</td>
</tr>
</tbody>
</table>

Figure 11-15. Defining transitions in the Pattern Definition window.

In order to use either type of transition detection in Trace Control, you must first define exactly what changes are to be considered a transition. A transition can be defined as a rising edge, falling edge, or either edge on a single channel or a group of channels. Transitions are defined in the upper portion of the Pattern Definition window as shown in Figure 11-15.

The Transition= line indicates what edges and channels will be used by Trace Control as criterion for detecting a transition. The default setup has hyphens for each character on the line. This means that the channels are not used for transition detection. Each character represents up to four channels depending on the current display radix. If you want to define transitions on individual channels, you can temporarily change the radix to binary.
To define the transition, edit the Transition= line. Highlight the characters representing the desired channels and type a "0," "1," "2," or "3" to place a —, ↑, ↓, or $ symbol. The arrow symbols mean that a transition will be detected if the indicated rising edge, falling edge, or either edge occurs on any of the specified channels. A semi-care character, %, indicates that not all the channels represented by the character are defined the same.

For example, to define a transition as the rising edge of a strobe signal, put a ↑ symbol over the strobe channel. To define a transition as any change on any channel in the Address bus, put a $ over all the Address bus channels (see Figure 11-16).

Once you have defined the transition, you can use the transition Tools in the Steps. The COMPLEX STORE and EDGE DETECTION Tools allow you to specify "if a transition" as one of the conditions.

To setup the Trace Control for transitional recording, use a Step like the Edge, Glitch Step that contains the COMPLEX STORE Tool. Specify storing only if a transition occurs as shown in Figure 11-17.

To set up the Trace Control for edge detection that finds a pattern going true, first define a transition as any change on any channel used in the pattern. Then use a Step like the Edge, Glitch Step that contains the EDGE DETECTION Tool. You can search for a transition to occur and the pattern to be true. This setup finds when the data on the channels changes to the desired pattern (see Figure 11-18).

The advantage of using this method of edge detection instead of using two Steps to search for the pattern to be false and then true, is that you can search for an edge while using other Trace Control Tools in parallel. For example, by using the Delay/Edge/ Branch, you can easily trigger if a pattern does not go true within a specified time (see Figure 11-19). Define the transition as any change on any channel used in the pattern.
Keep in mind that you should only use transition detection when sampling in 20 ns internal clock mode. If you want to use edge detection with an external sample clock or a slower internal rate, you must use one of the following two methods:

1) If all you want to do is trigger when a pattern goes true, you can use the Simple Edge Trigger Task.

2) If the edge detection is only a portion of your triggering scheme, use two Steps in a row. In the first Step, search for the pattern to be false and then go on. In the second Step, search for the pattern to be true.

Detecting Glitches

The CLAS 4000 can detect glitches that occur on specified channels. The glitch detection is very similar to the transition detection. You must first define the glitch in the Pattern Definition window, and then use the EDGE DETECTION Tool to specify "if a glitch." Glitch detection is independent from sample rate.

Define the glitch using the upper portion of the Pattern Definition window (see Figure 11-20). First specify the channels to be monitored by the glitch detection circuitry using the Glitch= line. Enable a channel by typing a "1." If the group is displayed in a radix that has more than one channel represented by a character, you can type a value containing 1's for the channels you want enabled. A checkmark appears for that channel.
For example, if the group is displayed in Hex, type an "F" to enable all four channels or a "3" to enable only the lower two channels.

You also need to define the glitch width. A glitch is a pulse (i.e. \[\text{[-]}\] or \[\text{[\[-}]\]) that is narrower than any valid pulse in your system. In the upper left corner of the Pattern Definition window, specify the pulse width that you want to consider as a glitch. The glitch detection hardware checks the enabled channels every 20 ns to watch for glitches. For example, if you specify 20 ns glitch width, the glitch hardware watches for pulses that were seen by only one 20 ns check.

Since the channels enabled for glitch detection are only checked every 20 ns, there is some uncertainty about the exact width of the pulses detected as glitches.

For example, set the glitch width to 20 ns and enable a channel that has a 30 ns pulse. The channel is checked asynchronously every 20 ns by the glitch circuitry. In one case, the channel may be checked at the beginning of the pulse and again 20 ns later near the end of the pulse (\[\text{[\[\[-]\]}\]). In this case, the pulse is seen by two 20 ns checks and is considered 40 ns wide. It is not considered to be a glitch.

In another case, the channel may be checked just before the pulse, once in the center of the pulse, and once again after the pulse (\[\text{[\[\[-]\]}\]). In this case, the pulse is seen by only one 20 ns check and is considered to be a glitch.

With the glitch width set to 20 ns, there is a 100% chance that a 5-20 ns pulse will be seen as a glitch, 50% chance for a 30 ns pulse, and 0% for a 38 ns pulse.

![Glitch Logic Diagram]

Figure 11-21. Triggering on a Glitch.

---

**Timer, Counters, and Loops**

**Using the timer**

The Trace Control has a global 32-bit timer that you can use to time various events with 20 ns resolution. For example, you can determine how much time is spent in a certain subroutine, or how long it takes to service an interrupt. The maximum time recorded is about 85 seconds.
On the first line of each Step, you can specify whether or not you want the timer to run by selecting either **Pause the timer** or **The Timer is on** from the timer field (see Figure 11-22). The timer is reset to zero when you arm the analyzer and cannot be reset again during the recording.

![Figure 11-22. Timer field in a Step.](image)

As the CLAS 4000 makes a recording, it runs or pauses the timer based on the timer field of the currently active Step. At the end of the recording, the final timer value is the total cumulative time spent in all Steps that had the timer on.

One application for this feature is timing how long it takes to execute a subroutine. Set up the Trace Control to search for the start of the subroutine in the first Step and the end of the subroutine in the second Step. Have the timer off while you are searching for the subroutine to start, and then turn it on while you are in the subroutine (see Figure 11-23).

![Figure 11-23. Timing a subroutine.](image)

![Figure 11-24. Timing Info dialog box.](image)

The final timer value can be seen by selecting **Timing Info** from the **Options** menu of the Timing Display. The Timing Info dialog box appears as shown in Figure 11-24. The top line contains the timer value.
Using the delay counter

One of the counters available in the Trace Control is the delay counter. Unlike the global timer which cannot be reset during a recording, the delay counter is reset at the beginning of each new Step so it can be used repeatedly.

You can use the delay counter in any Step that has Delay or Full in its name because it has the DELAY Tool (see Figure 11-25). The Full Step and Full Branch also have the COUNTER CONTROL Tool which allows you to prevent the counter from being reset when you go to a new Step. If the counter is not reset, you can choose whether or not to count in the Step.

Selecting a delay in the first level results in a delay of 64K.

The delay counter is not available in the first Trace Control level.

If you want to use the counter at the beginning of your triggering scheme, make the first Step a simple "go on if anything" Input Step and then use the counter in the second Step.

Using loops

You can use the Count Events Step to count the occurrences of events. This works very well for simple events, but not for complex ones. To count complex events, you can use the loop counter to pass through several Steps a certain number of times.

When you are using the loop counter, you must have one, and only one, Set Loop Counter Step in your Trace Control scheme (see Figure 11-26). The Step has two functions. First, use the Preset... line to specify the desired final loop count. Second, each time you pass through this Step, the loop counter is incremented by one. You can use a Step that has the CHECK LOOP COUNT Tool to check the current loop counter value against the desired final loop count.

For example, if the event you want to count is the execution of a conditional jump instruction, you need two Steps just to find the event. The first Step would search for the jump instruction to be fetched, and the second Step would figure out whether or not the jump was taken (see Figure 11-27).

A delay is used in the second Step because the instructions immediately following the jump are prefetched regardless of whether or not the jump was taken. If the jump's destination address is not seen within in three samples, however, the jump was not taken.
Chapter 11  Full Feature Trace Control

Figure 11-27. Finding a complex event.

The two steps in Figure 11-27 can be used to find one occurrence of the complex event. To find the 20th occurrence of the event, you can use the loop counter as shown in Figure 11-28.

Figure 11-28. Using the loop counter to trigger on the 20th complex event.

After finding the executed jump in the Jumped? Step, you go on and increment the loop counter in the Inc cntr Step. Then you go on and check the loop count in the 20th? Step. This is a complex Step, but you are really only using it for the fourth and seventh lines. If you have reached the final loop count, this is the 20th occurrence and you stop. If the loop count is still less
than the desired final value, you loop back to the Find Jmp Step.

The delay counter is not available in the first Trace Control level. If you want to use the counter at the beginning of your triggering scheme, make the first Step a simple "go on if anything" Input Step and then use the counter in the second Step.

**Positioning the trigger point**

As you learned in Chapter 6, the Predefined Tasks have a Fill element that allows you to specify how many post-trigger samples to take. By adjusting the number of post-trigger samples taken, you can position the trigger point anywhere in memory. If you take more than 4K post-trigger samples, the trigger point is moved completely out of memory and the buffer contains a 4K window of data that occurred long after the trigger.

The same post-trigger fill principles apply to the Steps, except there is no predefined Fill element. You must create the fill by appending a Task or Step that collects the desired additional samples.

![Fill](image)

**Figure 11-29. Post-trigger fill.**

One of the easiest methods is to append a Delay/Input Step to the end of your triggering scheme. Set the delay for the number of post-trigger samples you want to collect. In the example in Figure 11-29, 4000 post-trigger samples will be collected, leaving only 95 pre-trigger samples. The trigger point will be at sample 95.

Do not use Steps with delay conditions on the first Trace Control level. Use an input step, then use the counter in the second step.

**Using the output links**

The CLAS 4000 can send two types of output signals from the CLAS 4000 chassis to other instruments, Link and Trigger Out. The Link output can be used to notify the target system or other instruments that the analyzer is capturing data. Both of the
output signals are available from connectors on the front of the analyzer.

The Trigger Out is a short pulse that can be sent when a certain event is found. Since it can be generated based on a complex set of conditions, an oscilloscope or other instrument can be triggered for a very specific event. Many Trigger Out signals can be generated in one recording. The time between the events, or their frequency can be determined by connecting a timer or counter to this output.

Selecting the last item in the Trace Ctl menu toggles the Outputs field on and off. You can also toggle the field by clicking the Outputs icon to the right of the Pattern and Range icons (see Figure 11-30). When the Outputs are enabled, an Outputs field appears to the right of each Trace Control level. Click on the field to open the outputs pop-up menu.

![Figure 11-30. Outputs icon.](image)

The first option is reserved for future use. The second option, **Send a link to the Local Analyzers** (disable ‘external link out’ for this step) causes the Link Output signal on the chassis to go true (low) during the subsequent Trace Control level. The Link signal is negative TTL (-3.5 V to 0 V) and remains true while the analyzer is recording.

The third option, **Send a trigger pulse outside**, sends a 20 ns TTL pulse to the Trigger Output connector on the chassis when leaving the Trace Control level.

When you select either of these options, a corresponding icon appears in Outputs field as shown in Figure 11-31. Selecting the option from the pop-up menu again turns the feature off.

![Figure 11-31. Outputs field with both options selected.](image)
The output signals appear on the chassis connectors 260 ns or 280 ns after the sample that satisfies the Trace Control condition for that level. The potential variation is due to asynchronous sampling uncertainty and is fixed during any single recording.

Catalog of Steps

Learning each Step

This catalog of Steps allows you to see all the capabilities of the Steps without having to open each one from the Trace Control window. The information for each Step includes a picture of the Step and a table showing which Tools are available.
## Input Step

**Tools Available:**

- Timer ON/OFF
- Simple Store
- GOTO/STOP
- Pattern Search
- 2nd GOTO/STOP
- Complex Store
- Edge Detection
- Delay
- Count Events
- Increment Loop Count
- Loop Count Check
- Counter Control

### Step #1

- The timer is on.
- Store [if] input is =XXXXXXXXX.
- Stop [if] input is =Pattern 1.

## Delay/Input Step

**Tools Available:**

- Timer ON/OFF
- Simple Store
- GOTO/STOP
- Pattern Search
- 2nd GOTO/STOP
- Complex Store
- Edge Detection
- Delay
- Count Events
- Increment Loop Count
- Loop Count Check
- Counter Control

### Step #1

- The timer is on. Set delay for 2048 samples.
- Store [if] input is =XXXXXXXXX.
- Stop [if] = delay and
  [if] input is =Pattern 1.
Edge, Glitch Step

Tools Available:

- TIMER ON/OFF
- SIMPLE STORE
- GOTO/STOP
- PATTERN SEARCH
- 2ND GOTO/STOP
- COMPLEX STORE
- EDGE DETECTION
- DELAY
- COUNT EVENTS
- INCREMENT LOOP COUNT
- LOOP COUNT CHECK
- COUNTER CONTROL

Step #1

The timer is on.

Store [if] A sample Occurs and
[if] input is =HXXXXHHHHH.

Stop [if] A sample Occurs and
[if] input is =Pattern 1.

Count Events Step

Tools Available

- TIMER ON/OFF
- SIMPLE STORE
- GOTO/STOP
- PATTERN SEARCH
- 2ND GOTO/STOP
- COMPLEX STORE
- EDGE DETECTION
- DELAY
- COUNT EVENTS
- INCREMENT LOOP COUNT
- LOOP COUNT CHECK
- COUNTER CONTROL

Step #1

The timer is on. Set delay for 2048 events.

Store [if] input is =HXXXXHHHHH and
[if] A sample Occurs.

Stop [if] event count and
[if] input is =Pattern 1 and
[if] A sample Occurs.

Event [if] input is =Pattern 2 and
[if] A sample occurs.
Delay/Edge/ Step

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ TIMER ON/OFF</td>
</tr>
<tr>
<td>✓ SIMPLE STORE</td>
</tr>
<tr>
<td>✓ GOTO/STOP</td>
</tr>
<tr>
<td>✓ PATTERN SEARCH</td>
</tr>
<tr>
<td>✓ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✓ COMPLEX STORE</td>
</tr>
<tr>
<td>✓ EDGE DETECTION</td>
</tr>
<tr>
<td>✓ DELAY</td>
</tr>
<tr>
<td>✓ COUNT EVENTS</td>
</tr>
<tr>
<td>✓ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✓ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✓ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

Step #1
The timer is on. Set delay for 2048 samples.
Store [if] A sample occurs and
[if] input is =XXXXXX.
Stop [if] delay and
[if] A sample occurs and
[if] input is =Pattern 1.

Loop/Delay/Edge/ Step

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ TIMER ON/OFF</td>
</tr>
<tr>
<td>✓ SIMPLE STORE</td>
</tr>
<tr>
<td>✓ GOTO/STOP</td>
</tr>
<tr>
<td>✓ PATTERN SEARCH</td>
</tr>
<tr>
<td>✓ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✓ COMPLEX STORE</td>
</tr>
<tr>
<td>✓ EDGE DETECTION</td>
</tr>
<tr>
<td>✓ DELAY</td>
</tr>
<tr>
<td>✓ COUNT EVENTS</td>
</tr>
<tr>
<td>✓ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✓ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✓ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

Step #1
The timer is on. Set delay for 2048 samples.
Store [if] A sample occurs and
[if] input is =XXXXXX.
Stop [if] The loop count and
[if] A sample occurs and
[if] input is =Pattern 1.
Part 3  Advanced uses of the CLAS 4000

Full Step

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ TIMER ON/OFF</td>
</tr>
<tr>
<td>✔ SIMPLE STORE</td>
</tr>
<tr>
<td>✔ GOTO/STOP</td>
</tr>
<tr>
<td>✔ PATTERN SEARCH</td>
</tr>
<tr>
<td>✔ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✔ COMPLEX STORE</td>
</tr>
<tr>
<td>✔ EDGE DETECTION</td>
</tr>
<tr>
<td>✔ DELAY</td>
</tr>
<tr>
<td>✔ COUNT EVENTS</td>
</tr>
<tr>
<td>✔ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✔ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✔ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step #1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The timer is on. The counter is on.</td>
</tr>
<tr>
<td>Load delay to 2048 samples.</td>
</tr>
<tr>
<td>Store [if] A sample Occurs and</td>
</tr>
<tr>
<td>[if] input is =HHHHHHHHH.</td>
</tr>
<tr>
<td>Stop and Load Count</td>
</tr>
<tr>
<td>[if] A sample Occurs and</td>
</tr>
<tr>
<td>[if] The count and</td>
</tr>
<tr>
<td>[if] input is =Pattern 1.</td>
</tr>
</tbody>
</table>

Set Loop Counter

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ TIMER ON/OFF</td>
</tr>
<tr>
<td>✔ SIMPLE STORE</td>
</tr>
<tr>
<td>✔ GOTO/STOP</td>
</tr>
<tr>
<td>✔ PATTERN SEARCH</td>
</tr>
<tr>
<td>✔ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✔ COMPLEX STORE</td>
</tr>
<tr>
<td>✔ EDGE DETECTION</td>
</tr>
<tr>
<td>✔ DELAY</td>
</tr>
<tr>
<td>✔ COUNT EVENTS</td>
</tr>
<tr>
<td>✔ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✔ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✔ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step #1</th>
</tr>
</thead>
<tbody>
<tr>
<td>The timer is on.</td>
</tr>
<tr>
<td>Preset Loop Counter for 15 loops.</td>
</tr>
<tr>
<td>Increment Loop on entering this step</td>
</tr>
<tr>
<td>and Store [if] A sample Occurs and</td>
</tr>
<tr>
<td>[if] input is =HHHHHHHHH.</td>
</tr>
<tr>
<td>Go on.</td>
</tr>
</tbody>
</table>
Input Branch

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ TIMER ON/OFF</td>
</tr>
<tr>
<td>✔️ SIMPLE STORE</td>
</tr>
<tr>
<td>✔️ GOTO/STOP</td>
</tr>
<tr>
<td>✔️ PATTERN SEARCH</td>
</tr>
<tr>
<td>✔️ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✔️ COMPLEX STORE</td>
</tr>
<tr>
<td>✔️ EDGE DETECTION</td>
</tr>
<tr>
<td>✔️ DELAY</td>
</tr>
<tr>
<td>✔️ COUNT EVENTS</td>
</tr>
<tr>
<td>✔️ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✔️ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✔️ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

Step #1: The timer is on.

- Store [if] input is $\text{HHHHHHHHHH}$.
- Stop [if] input is $\text{Pattern 1}$.
- Go on [if] input is $\text{Pattern 2}$.

Delay/Input Branch

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ TIMER ON/OFF</td>
</tr>
<tr>
<td>✔️ SIMPLE STORE</td>
</tr>
<tr>
<td>✔️ GOTO/STOP</td>
</tr>
<tr>
<td>✔️ PATTERN SEARCH</td>
</tr>
<tr>
<td>✔️ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✔️ COMPLEX STORE</td>
</tr>
<tr>
<td>✔️ EDGE DETECTION</td>
</tr>
<tr>
<td>✔️ DELAY</td>
</tr>
<tr>
<td>✔️ COUNT EVENTS</td>
</tr>
<tr>
<td>✔️ INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>✔️ LOOP COUNT CHECK</td>
</tr>
<tr>
<td>✔️ COUNTER CONTROL</td>
</tr>
</tbody>
</table>

Step #1: The timer is on. Set delay for $2048 \times 8$ samples.

- Store [if] input is $\text{HHHHHHHHHH}$.
- Stop [if] = delay and [if] input is $\text{Pattern 1}$.
- Go on [if] = delay and [if] input is $\text{Pattern 2}$.
**Edge, Glitch Branch**

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ TIMER ON/OFF</td>
</tr>
<tr>
<td>✓ SIMPLE STORE</td>
</tr>
<tr>
<td>✓ GOTO/STOP</td>
</tr>
<tr>
<td>✓ PATTERN SEARCH</td>
</tr>
<tr>
<td>✓ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✓ COMPLEX STORE</td>
</tr>
<tr>
<td>✓ EDGE DETECTION</td>
</tr>
<tr>
<td>DELAY</td>
</tr>
<tr>
<td>COUNT EVENTS</td>
</tr>
<tr>
<td>INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>LOOP COUNT CHECK</td>
</tr>
<tr>
<td>COUNTER CONTROL</td>
</tr>
</tbody>
</table>

**Step #1**

The timer is on.

- Store [if] A sample Occurs and [if] input is =XXXXXXXXX.
- Stop [if] A sample Occurs and [if] input is =Pattern 1.
- or Go on [if] A sample Occurs and [if] input is =Pattern 2.

**Delay/Edge/ Branch**

<table>
<thead>
<tr>
<th>Tools Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ TIMER ON/OFF</td>
</tr>
<tr>
<td>✓ SIMPLE STORE</td>
</tr>
<tr>
<td>✓ GOTO/STOP</td>
</tr>
<tr>
<td>✓ PATTERN SEARCH</td>
</tr>
<tr>
<td>✓ 2ND GOTO/STOP</td>
</tr>
<tr>
<td>✓ COMPLEX STORE</td>
</tr>
<tr>
<td>✓ EDGE DETECTION</td>
</tr>
<tr>
<td>✓ DELAY</td>
</tr>
<tr>
<td>COUNT EVENTS</td>
</tr>
<tr>
<td>INCREMENT LOOP COUNT</td>
</tr>
<tr>
<td>LOOP COUNT CHECK</td>
</tr>
<tr>
<td>COUNTER CONTROL</td>
</tr>
</tbody>
</table>

**Step #1**

The timer is on. Set delay for 2048 samples.

- Store [if] A sample Occurs and [if] input is =XXXXXXXXX.
- Stop [if] = delay and [if] A sample Occurs and [if] input is =Pattern 1.
- or Go on [if] = delay and [if] A sample Occurs and [if] input is =Pattern 2.
Loop/Delay/Edge/Branch

Tools Available

- TIMER ON/OFF
- SIMPLE STORE
- GOTO/STOP
- PATTERN SEARCH
- 2ND GOTO/STOP
- COMPLEX STORE
- EDGE DETECTION
- DELAY
- COUNT EVENTS
- INCREMENT LOOP COUNT
- LOOP COUNT CHECK
- COUNTER CONTROL

Step #1

The timer is on. Set delay for 2048 □ samples.

- Store [if] A sample Occurs and
- [if] input is =H H H H H H H H .
- Stop [if] = The count and
- [if] A sample Occurs and
- [if] input is =Pattern 1 .

or Go on [if] = The loop count and
- [if] A sample Occurs and
- [if] input is =Pattern 2 .

Full Branch

Tools Available

- TIMER ON/OFF
- SIMPLE STORE
- GOTO/STOP
- PATTERN SEARCH
- 2ND GOTO/STOP
- COMPLEX STORE
- EDGE DETECTION
- DELAY
- COUNT EVENTS
- INCREMENT LOOP COUNT
- LOOP COUNT CHECK
- COUNTER CONTROL

Step #1

The timer is on. The counter is on.

Load delay to 2048 □ samples.

- Store [if] A sample Occurs and
- [if] input is =H H H H H H H H .
- Stop and Load Counter
- [if] A sample Occurs and
- [if] = The count and
- [if] input is =Pattern 1 .

or Go on and Keep counting
- [if] A sample Occurs and
- [if] = The loop count and
- [if] input is =Pattern 2 .
Part 3  Advanced uses of the CLAS 4000
Chapter 12  Advanced Clocking Techniques

This chapter describes some clocking considerations for advanced applications. The first section explains how to use the Multimodule Clock Probe to synchronize multiple data boards for external clocking. The second section explains how to use phase locking techniques to reduce setup and hold times.

Multimodule Clock Probe

General description

This section describes the Multimodule Clock Probe (P/N A70070) which is supplied as an accessory to the CLAS 4000. This probe is used to synchronized external clock inputs to a logic analyzer that is configured with two or more 96-channel data board modules. The probe supplies inputs for up to six clock signals and a ground connection.

The Multimodule Clock Probe must be used whenever you are using an external clock to collect data on more than one data board.

Using the multi-module clock probe

The Multimodule Clock Probe consists of the following:
- One Clock Probe Case
- One Coax Cable attached to the Probe Case
- Four Clock Probe Interface Cables attached to the Probe Case
- One Connector with Flying Leads and grabbers.
- Four Clock Probe Interface Adapters

The Coax Cable transmits a 100 MHz synchronization signal from the Control Board in the CLAS 4000 chassis to the clock probe (see ☞ in Figure 12-1).

The four Clock Probe Interface Cables are flat ribbon cables that supply external clock signals to the analyzer (see ☞ in Figure 12-1).

The Connector with Flying Leads attaches to the probe case. The seven leads consist of six clock input lines for channels 90-95, and one ground line. Use the grabbers to connect to signals that you want to use in your clock equations (see ☞ in Figure 12-1).

The Four Clock Probe Interface Adapters are small boards with three connectors that are used to connect the flat ribbon cables to the Z probe connectors on the data boards (see ☞ in Figure 12-1).
Figure 12-1. Multimodule Clock Probe installation.
Chapter 12 Advanced Clocking Techniques

Use the following procedure and Figure 12-1 to connect the Multimodule Clock Probe to the CLAS 4000.

1. Remove the Z data probes from the Z probe connectors on the data boards.
2. Install the Clock Probe Interface Adapters (©) into the Z probe connectors on the data boards.
3. Plug the Z data probes into these Clock Probe Interface Adapters.
4. Locate the Clock Probe Interface Cable (©) from the Multimodule Clock Probe that is labeled, "POWER, GROUND, THRESHOLD." Connect this cable to the Clock Probe Interface Adapter (©) installed in the Z connector of the lowest data board.
5. Connect the remaining Clock Probe Interface Cables (©) to the other Clock Probe Interface Adapters (©).
6. Connect the Coax Cable (©) to one of the CLK OUT jacks on the CLAS 4000 Control Board.

When you define your external clock equations in the Channel Setup window, use the channels A90-A95 as the clock inputs. The clock signals are automatically routed to the other data boards and synchronized. Keep in mind that channels 90-95 of all the data boards are now dedicated clock channels and cannot be used as regular data inputs from the data probes.

Phase locking

General description

This section describes how to use Phase Locking techniques to reduce the setup time requirement for data sampled by the CLAS 4000 with an external clock.

The ECL Sync input connector on the CLAS 4000 chassis allows you to reduce the data setup time by synchronizing the analyzer to the target board. Your target clock replaces the internal timebase of the analyzer. The Sync connector must be connected to a clock signal on the user's target board that is twice the desired sample rate and should be between 50 MHz and 100 MHz. Data is collected using the standard external clocking techniques. Note that the time stamp information will not be correct because the internal timebase of the analyzer has been changed.

Phase locking techniques

The CLAS 4000 Logic Analyzer (LA) has an internal clock running at 100 MHz. This 10 ns clock forms the timebase for all the analyzer's internal functions. This clock is also used for sampling data in internal clock mode. The internal sample rates are multiples of this 10 ns clock in a 1-2-5 sequence. In 20 ns sampling mode, data is collected on every other rising edge of
the 10 ns clock. In 10 ns mode, data is collected on every rising edge, and in 5 ns mode, data is collected on both edges.

In external clocking mode, the target system clock is used by the analyzer to sample data. This Target Clock is checked on both edges of the internal 10 ns clock (i.e. every 5 ns). When the analyzer detects that the Target Clock has gone high, it saves the data from the previous 5 ns checking time. This is the data present just prior to the rising edge of the Target Clock.

Since the analyzer is only checking the Target Clock every 5 ns, it does not know exactly when the clock went high. If a 5 ns check barely catches the rising edge of the Target Clock, the analyzer will save data that was present 5 ns before the rising edge. Therefore, in order to be sure the data is valid, it must be present for at least 5 ns before the rising edge of the Target Clock. (There is also some channel-to-channel skew, so the required setup time is actually about 9 ns.)

If the data setup time on the target system is less than 5 ns, it is very possible that the data can become valid after the 5 ns check that is used to save the data. In Figure 12-2, the clock is checked at time A and found to be low. It is checked again at time B and found to be high. Therefore, the data is saved from time A. In this case, the data will be erroneous because it does not become valid until after time A.

![Diagram](https://via.placeholder.com/150)

**Figure 12-2. Using an external clock without Phase Locking.**

If the Target Clock is checked 1 ns before the rising edge, it will be detected as low and the next check will find that it has gone high. The analyzer will then save the data that was present 1 ns before the rising edge. If the analyzer always checked the Target Clock about 1 ns prior to the rising edge, then the analyzer would always save the data that was present about 1 ns before the rising edge, and the required setup time for the data would be reduced to approximately the channel-to-channel skew.
The analyzer can be set up to always check the Target Clock at a certain time by synchronizing the analyzer's internal timebase to the target system. This can be done by using the ECL Sync input on the CLAS 4000 chassis.

Connect an ECL clock signal to this input connector that is at least twice the frequency of the Target Clock (i.e. the frequency can be 2X, 3X, 4X, etc.). The clock signal should also be between 50 MHz and 100 MHz and must have a 50% duty cycle. In most cases, a clock signal twice the frequency (2X) of your Target Clock is sufficient.

This Target 2X Clock must be synchronous to the Target Clock, but it does not have to be in phase (i.e. there can be some fixed delay from one clock to the other). Once it has been selected by the software, the Target 2X Clock replaces the analyzer’s 10 ns internal timebase clock and is used for all internal analyzer functions.

The Target 2X Clock can be selected as the analyzer’s new timebase in the Master Clock window under the Control menu in the analyzer software (see Figures 12-3 and 12-4). If External Master Clock is selected, a shifted version of the Target 2X Clock (called the Shifted Target 2X Clock) becomes the analyzer's internal master clock.

Figure 12-3. Opening the Master Clock Window

Figure 12-4. Master Clock window.

The Master Clock window also contains a delay field that is used to shift the Shifted Target 2X Clock in the analyzer relative to the Target Clock in 0.5 ns steps. When the Shifted Target 2X Clock has been shifted to exactly the right phase, the Target
Clock will always be checked just prior to its rising edge, and the analyzer can collect valid data even if the data setup time is less than 5 ns.

In Figure 12-5, the analyzer uses the Shifted Target 2X Clock for its internal timebase. The Target Clock is checked at time A and found to be low. It is checked again at time B and found to be high. Therefore, the data is saved from time A. In this case, the data will be valid because time A will always occur just prior to the rising edge of the target clock, and the data is always valid at this time.

![Diagram of clocks and data samples](image)

**Figure 12-5. Using an external clock with Phase Locking.**

When **External Master Clock** is selected in the Master Clock window, a delay value must be entered in the delay field (see Figure 12-6). Changing the delay shifts the Shifted Target 2X Clock in the analyzer relative to the Target Clock. The delay should be set such that one of the edges of the Shifted Target 2X Clock occurs just prior to the rising edge of the Target Clock.

![Master Clock window](image)

**Figure 12-6. Master Clock window.**

The delay values specified in the Master Clock window are relative values and do not indicate an absolute phase relationship between the two clock signals. A delay of zero does not indicate...
that the clocks are in phase. It only means that the delay cannot be decreased any more from this point.

When some initial delay setting is selected, like 15 ns, the Target Clock and the Shifted Target 2X Clock will probably have a phase relationship similar to that shown in Figure 12-7. The dashed horizontal lines represent the threshold voltages.

The 5 ns internal sampling mode can be used to determine the exact phase relationship of the two clocks. Normally, in 5 ns internal sampling mode, the analyzer samples data on each edge of the internal 10 ns clock. Since the internal timebase clock has been replaced with the Shifted Target 2X Clock, the analyzer will sample data on each edge of the Shifted Target 2X Clock.

![Figure 12-7. Clock signal relationships with arbitrary delay setting in the Master Clock window.](image)

![Figure 12-8. Clock signal relationships with calibrated delay setting in the Master Clock window.](image)

Changing the delay value shifts the Shifted Target 2X Clock relative to the Target Clock. As the delay value is changed and the analyzer samples the Target Clock in 5 ns internal mode, most of the time the Sampled Target Clock waveform in the Timing Display will show the Target Clock as two 0's followed by two 1's (see Figure 12-7).

At some point, however, the sampled Target Clock will appear to be three 0's followed by a 1, as shown in Figure 12-8. This will mean that an edge of the Shifted Target 2X Clock occurs just prior to the rising edge of the Target Clock. At this delay setting, the data appearing just prior to the rising edge of the Target Clock will be saved when the analyzer is used in external clocking mode (see Figure 12-5).

Note that adjusting the threshold of the data probe that is used to sample the Target Clock will have an effect on the Sampled Target Clock waveform. The higher the threshold, the more chance you have of getting three 0's and a 1.

There may several delay settings that result in the sampled Target Clock waveform having three 0's and a 1. In this case, the highest setting should be used if the analyzer will be collecting data on the rising edge of the Target Clock, and the lowest setting should be used if the analyzer will be collecting data on the falling edge of the Target Clock.
Once the best delay setting has been determined, the clocking mode can be changed from 5 ns internal mode back to external mode in the Channel Setup menu, and data can be collected from the target system using standard external clocking techniques.

An alternate method of calibrating delay is to record the clock signal using the 10ns selection (rising edge of the ECL Clock In signal).

To sample on a rising edge, increase the delay until the first recorded value of "all zeros" appears. Then, continue to increase the delay until a "1" appears in the recording. Decrease the delay by 0.5ns and the setup and hold combination is reduced to ≤ 4ns.

You can also sample on a falling edge by repeating the above procedure; however, look for all "ones" initially then increase the delay until the first "zero" appears in the recording.
Chapter 13 Using the GPIB or RS232 Interfaces

The CLAS 4000 chassis can be controlled over three different interfaces, SCSI, RS232, and GPIB. Normally, the SCSI interface is used to control the CLAS 4000 from the computer, but some applications may require using one of the other interfaces. For example, if you want to set up an automatic test station, you may want to use the GPIB interface to control all of the instruments from a central computer.

The operating system inside the CLAS 4000 chassis can be controlled by two types of commands, ASCII and Block. ASCII commands are strings of ASCII characters that form key words and parameters. These are discussed in more detail in the ASCII Commands section of this chapter. The Block commands are sent as blocks of binary data containing codes for the various command functions and parameters. See the Block Commands section of this chapter for more information.

All three interfaces are monitored by the operating system inside the CLAS 4000 chassis, and both types of commands can be sent over any interface. The RS232 and GPIB interfaces are discussed in the following sections.

RS232 interface Using the RS232 interface

The RS232 interface can be used by connecting a serial cable from the RS232 port on the CLAS 4000 chassis to a modem, computer, or dumb terminal. The cable must be a null modem cable wired as shown in Figure 13-1.

Figure 13-1. Null modem cable wiring diagram.
The RS232 parameters are shown in Table 13-1. The default parameters are 9600 baud, 8 data bits, no parity, and 1 stop bit. The RS232 software uses XON/XOFF handshake in ASCII mode, and RTS/CTS in block mode. By default, the echo feature is enabled in ASCII mode and disabled in block mode.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baud rate</td>
<td>110 - 38.4K</td>
<td>9600</td>
</tr>
<tr>
<td>Word length</td>
<td>5 - 8 bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop bits</td>
<td>0.5 - 2</td>
<td>1</td>
</tr>
<tr>
<td>Parity</td>
<td>None, Even, Odd</td>
<td>None</td>
</tr>
<tr>
<td>Protocol</td>
<td>XON/XOFF, RTS/CTS</td>
<td>XON/XOFF</td>
</tr>
</tbody>
</table>

Table 13-1. RS-232 Parameters

When a host computer is connected to the CLAS 4000, it can control the data flow using its RTS output. By deasserting the CTS (input) on the CLAS 4000, the host tells the CLAS 4000 not to send. Likewise, when the CLAS 4000 deasserts the host's CTS, it wants the host to stop sending. The CLAS 4000 asserts and deasserts this signal with its RTS output. It expects the host's CTS (input to the CLAS 4000) on pin 5 of the RS232 connector.

When the CLAS 4000 is first powered on, it defaults to ASCII mode. If a host wants to change to block mode, it has to send an ASCII string of "BLOCK" followed by two null characters and a <CR> to the CLAS 4000. To change from block mode to ASCII mode, the host must send the appropriate block command to the CLAS 4000.

When a terminal is connected to the RS232 port on the CLAS 4000, the RS232 software has the intelligence to recognize different types of terminators. The terminators can be CR, LF, or CR/LF.

**GPIB interface**

**Using the GPIB interface**

The CLAS 4000 GPIB is implemented according to the IEEE Std 488-1978 published November 30, 1978 by IEE under "IEEE Standard Digital Interface for Programmable Instrumentation." Table 13-2 shows the capabilities supported by the implementation.

After initialization, the device will be set according to the information saved in the CMOS RAM. This will not be done if CMOS has not been initialized or has been corrupted. After the device is set up, it is ready to process a command from a controller on the GPIB bus. If the device has been initialized to "talk only" mode, it will not respond to commands. It is necessary to change this setting from the RS232. The default parameters are shown in Table 13-3.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Handshake</td>
<td>(SH1) Complete Capability</td>
</tr>
<tr>
<td>Acceptor Handshake</td>
<td>(AH1) Complete Capability</td>
</tr>
<tr>
<td>Talker Function</td>
<td>(T5) Basic Talker</td>
</tr>
<tr>
<td></td>
<td>Talk Only</td>
</tr>
<tr>
<td></td>
<td>Unaddress if MLA</td>
</tr>
<tr>
<td>Talker Function with Address</td>
<td>(TE0) No Capability</td>
</tr>
<tr>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Listener Function</td>
<td>(L3) Basic Listener</td>
</tr>
<tr>
<td></td>
<td>Listen Only</td>
</tr>
<tr>
<td></td>
<td>Unaddress if MTA</td>
</tr>
<tr>
<td>Listener Function with Address</td>
<td>(LE0) No Capability</td>
</tr>
<tr>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Service Request</td>
<td>(SR1) Complete Capability</td>
</tr>
<tr>
<td>Remote Local Function</td>
<td>(RL1) Complete Capability</td>
</tr>
<tr>
<td>Parallel Poll Function</td>
<td>(PP1) Remote Configuration</td>
</tr>
<tr>
<td>Device Clear Function</td>
<td>(DC1) Complete Capability</td>
</tr>
<tr>
<td>Device Trigger Function</td>
<td>(DT1) Complete Capability</td>
</tr>
<tr>
<td>Controller Function</td>
<td>(CO) No Capability</td>
</tr>
</tbody>
</table>

Table 13-2. GPIB interface capabilities.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Talk Only, Listen Only</td>
<td>Listen only</td>
</tr>
<tr>
<td></td>
<td>Talk/Listen</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>0 - 30</td>
<td>N/A (15 in Talk/List.)</td>
</tr>
<tr>
<td>Terminator</td>
<td>CR, CR/LF</td>
<td>CR/LF</td>
</tr>
<tr>
<td>EOI Output</td>
<td>ON, OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Data mode</td>
<td>ASCII, Block</td>
<td>ASCII</td>
</tr>
<tr>
<td>Transparency</td>
<td>Trans., Non-Trans.</td>
<td>Non-transparent</td>
</tr>
<tr>
<td>Allowable transfer time</td>
<td>20,000 ticks</td>
<td></td>
</tr>
</tbody>
</table>

Table 13-3. GPIB default parameters.

The GPIB driver has a certain amount of intelligence built into it. When no task is using it for data transfer, it will respond to ASCII or Block commands. After a command has been received and passed on to the upper layer of the CLAS 4000 operating system, the driver goes into "data mode." It treats incoming or outgoing bytes as data until the upper layers of software tell it they have completed processing the command.

This device is implemented using interrupts and DMA. The transfer rate approaches 1 MB/sec if it is connected to another device that uses DMA. The limiting factor is always the slowest device on the bus.

According to the IEEE 488 Standard, the maximum number of addressable devices on the GPIB bus is 31. This address mode applies only in "talk and listen" mode. There are two other mode implemented, "talk only," and "listen only." When used as a "talk only" device, the CLAS 4000 can only send data out.
It cannot receive commands through the GPIB. This mode is used to dump out data to the printer, for example.

The other mode that may be used is "listen only." This might be used to receive the same commands as another CLAS 4000 so that a user at a remote location will know what is happening to the originating CLAS 4000.

Connecting the CLAS 4000 to another CLAS 4000 system or a host controller requires a standard GPIB cable. The connector on the CLAS 4000 is female and is located on the front panel of the chassis. The instrument can be operated locally or from a remote station.

**ASCII Commands**

**Using ASCII commands**

You can control the basic functions of the CLAS 4000 with a set of ASCII commands. The commands do not allow manipulation of data, or detailed changes in setup. For these functions, consult the factory to determine which special utility or custom development will best serve your needs.

When you are properly connected to the CLAS 4000, you can send the string, "HELP" to receive a list of commands.

**Catalog of ASCII commands**

**ARM {n}**

This command is used to arm the specified logic analyzer.

**AUTOARM {n}**

This command is used to arm the specified logic analyzer. Each time the logic analyzer completes a recording it will be re-armed unless a compare causes it to stop.

**BAUD parameter**

This command is used to set the baud rate for the RS232 device. If no parameter is specified, the current baud rate is displayed.

**BDUMP data board# [starting sample (1-sample depth)]**

Bdump is used to display captured data on a terminal device in ASCII format. It dumps out data for all the channels on a single data board.

**CLKSELECT dasic#**

This command is used to display which clocks are used for each channel of the logic analyzer.

**CONFIG {www xxx yyy zzzz}**

This command is used to set or display the logic analyzer configuration (i.e. the data boards associated with it). If no parameters are specified, it will return the configuration of the system.
Example: CONFIG ab

This command would assign data boards a and b to logic analyzer 1.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DATABIT</strong> parameter</td>
<td>This command is used to set the number of data bits for RS232 device. The system supports 5, 6, 7 and 8 data bits. If no parameter is specified, the current data bit number is displayed.</td>
</tr>
<tr>
<td><strong>DATE</strong></td>
<td>This command displays the current date in month/day/year format. It prompts the user to enter the desired date. If a new date is not entered, the current date is retained.</td>
</tr>
<tr>
<td><strong>ECHO</strong> {on/off}</td>
<td>This command is used to set echo mode for RS232 device. The parameters supported are &quot;on&quot; and &quot;off&quot;. If no parameter is specified, the current echo state is displayed.</td>
</tr>
<tr>
<td><strong>EOI</strong> parameter</td>
<td>This command is used to set the EOI mode for the GPIB device. The parameters supported are &quot;on&quot; and &quot;off.&quot; If no parameter is specified, the current EOI mode is displayed.</td>
</tr>
<tr>
<td><strong>PROBE</strong></td>
<td>This command will cause the status of the probe ID buttons to be continually displayed on a terminal screen. The format of the output is a row of sixteen numbers representing the sixteen possible data probes. The first number represents data board D, probe Z. The second number is for data board D, probe Y. The last number is for data board A, probe W. The numbers are normally all &quot;zero.&quot; When a probe ID button is pushed, the corresponding number changes to a &quot;one.&quot; Press &lt;esc&gt; to quit.</td>
</tr>
<tr>
<td><strong>KILL</strong> task#</td>
<td>This command is used to kill the downloaded application task. The task and associated exchanges, if any, will be deleted. If the task does not exist, an error message will be displayed.</td>
</tr>
<tr>
<td><strong>LISTEN ONLY</strong></td>
<td>This command is used to set mode for GPIB device. The parameter must be &quot;ONLY&quot;. If no parameter is specified, an error code will be returned.</td>
</tr>
<tr>
<td><strong>MLA</strong> {address}</td>
<td>This command is used to set my listen address for the GPIB device. The address range is from 0 to 31. If no address is specified, the current listen address is displayed.</td>
</tr>
<tr>
<td><strong>MTA</strong> {address}</td>
<td>This command is used to set my talk address the for GPIB device. The address range is from 0 to 31. If no address is specified, the current talk address is displayed.</td>
</tr>
<tr>
<td><strong>OUTPUT</strong> parameter</td>
<td>This command is used in redirecting output to a specified device. The parameters supported are GPIB and RS232. If no parameter is specified, the current output device is displayed.</td>
</tr>
</tbody>
</table>
**Part 3  Advanced uses of the CLAS 4000**

**PARITY parameter**
This command is used to set the parity mode for the RS232 device. The system supports "none," "odd" and "even" parity modes. If no parameter is specified, the current parity bit is displayed.

**QT**
This command displays the current time in hour/minute/sec format. It prompts the user to enter a new time. The current time is retained if no new time is specified.

**RESET parameter**
This command is used to re-initialize I/O devices. The parameters supported are "GPIB," "RS232" and "ALL." If "ALL" is specified, both "GPIB" and "RS232" devices are initialized. Devices are initialized using the current setup parameters.

**RESTART**
This command is used to restart the CLAS 4000 firmware system.

**STATUS parameter**
This command is used to retrieve the status information of the CLAS4000 firmware system or individual device. The parameters supported are "SCSI," "GPIB," "RS232," "1," "2," "3," "4," and "SYSTEM". If no parameter is specified, an error code will be displayed.

**STOP \{n\}**
This command is used to stop the specified logic analyzer. If the logic analyzer is not armed, an error message will be displayed.

**STOPBIT parameter**
This command is used to set the number of stop bits for RS232 device. The system supports "0.5," "1," "1.5" and "2" stop bits. If no parameter is specified, the current number of stop bits is displayed.

**TALK parameter**
This command is used to set the mode for the GPIB device. The parameters supported are "ONLY" and "LISTEN". If no parameter is specified, an error code will be returned.

**UNLOCK device#**
This command is used to unlock a device (SCSI, RS232 or GPIB) that has been locked out because another controller sent commands to the CLAS 4000. This happens, for example, whenever the GPIB port receives commands from a controller. If no parameter is specified, the current device will be unlocked. Then commands will be allowed from that unlocked device.

**VERSION**
This command is used to retrieve the CLAS4000 firmware version number. The version number and date will be displayed as an ASCII string.

**ZDUMP la# [starting sample (1-sample depth)]**

Zdump is used to display captured data on a terminal device in ASCII format. It will determine how many channels the logic analyzer contains, so the display will vary in width and length.
Using block commands

Block commands are low level binary commands that can be used to control all the functions of the CLAS 4000. They are more flexible than the ASCII commands, but they are more complicated to use. Each command is in the form of a block of binary data. Various bytes specify the different commands and parameters.

To use the Block commands, you must write a program on your host computer to form and send the binary blocks. For commands that return information, your program must receive the data and put it in a usable form.

The Block commands are best suited for a completely automatic test setup with a host computer controlling the entire environment. A variety of software programs and tools have already been written to perform a variety of functions. Consult the factory for more information.
Part 3  Advanced uses of the CLAS 4000
Appendices
Appendices
Appendix A: Command Key Shortcuts

The following commands have keyboard equivalents that combine holding the Command key (⌘) and striking another key. Use the keyboard to execute these commands quickly, without having to use the mouse to pull down menus.

**File Menu:**
- **Load...**  ⌘ L
- **Close**  ⌘ W
- **Save**  ⌘ S
- **Print Long**  ⌘ P
- **Quit**  ⌘ Q

**Edit Menu:**
- **Undo**  ⌘ Z
- **Cut**  ⌘ X
- **Copy**  ⌘ C
- **Paste**  ⌘ V
- **Insert**  ⌘ I
- **Duplicate**  ⌘ D
- **Select All**  ⌘ A

**Control Menu:**
- **Show/Hide Config.**  ⌘ E

**Windows Menu:**
- **Tile Windows**  ⌘ T
- **Stack Windows**  ⌘ Y

**State Options Menu:**
- **Find**  ⌘ F
- **Compare**  ⌘ =
- **Go to C1**  ⌘ 1
- **Go to C2**  ⌘ 2
Timing Options
Menu:

Compare  % =
Group    % G
Ungroup  % U

Vertical Expansion:
Increase  <option> ↓
Decrease  <option> ↑

Horizontal Expansion:
Increase  <option> →
Decrease  <option> ←

Alphabetical Listing:

Select All (Edit)  % A
Copy (Edit)        % C
Duplicate (Edit)   % D
Show/Hide Config. (Control)  % E
Find (State Options)  % F
Group (Timing Opt.)  % G
Insert (Edit)       % I
Load (File)         % L
Print Long (File)   % P
Save (File)         % S
Tile (Windows)      % T
Ungroup (Timing Opt.)  % U
Paste (Edit)        % V
Close (File)        % W
Cut (Edit)          % X
Stack (Windows)     % Y
Undo (Edit)         % Z
Compare (State & Timing Options)  % =
Go to C1 (State Options)  % 1
Go to C2 (State Options)  % 2
Appendix B: Customer Service Information

Warranty

This BIOMATION equipment is warranted against defects in materials and workmanship for a period of one year from date of shipment. Any floppy disk or hard disk drives attached to or contained within this equipment are warranted for 90 days from date of shipment. BIOMATION Corporation will repair or replace products that prove to be defective during the warranty period.

Warranty service must be performed at a BIOMATION authorized service facility. The customer must call BIOMATION's Customer Service department at the toll-free number listed in this Appendix and obtain a Return Authorization number prior to returning the unit for service. If the unit fails within 30 days of the shipment date, BIOMATION will pay for all shipping charges related to the repair of the unit. Units under warranty, but beyond the 30 day shipment period should be sent to BIOMATION, prepaid, and BIOMATION will return the unit prepaid. The customer must pay all shipping charges for units out of warranty. Misuse of, abuse of, or tampering with this unit will, at the discretion of BIOMATION, cause this warranty to be null and void.

Inspection

Remove the Unit from its shipping container and inspect for any damage that might have occurred during shipping. Refer to the shipping papers to verify that all items listed were received. Do not operate unit if it is damaged or incomplete. File a claim with the shipping firm. Notify BIOMATION Corporation Customer Service Department. BIOMATION will repair or replace the unit without waiting for settlement of the claim against the carrier.

Assistance

For assistance with this product, call BIOMATION Customer Service on the nationwide toll-free hot-line number: (800)538-9320, FAX (408)988-1647.
Appendix C: Specifications

Input Configurations

The CLAS 4000 has several possible configurations. The number of available channels and the sample memory depth vary depending on the number of data boards installed and the sample rate.

<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>1 Board</th>
<th>2 Boards</th>
<th>3 Boards</th>
<th>4 Boards</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤50 MHz</td>
<td>96 Channels</td>
<td>192 Channels</td>
<td>288 Channels</td>
<td>384 Channels</td>
</tr>
<tr>
<td>Internal</td>
<td>4K Samples</td>
<td>4K Samples</td>
<td>4K Samples</td>
<td>4K Samples</td>
</tr>
<tr>
<td>≤100 MHz</td>
<td>48 Channels</td>
<td>96 Channels</td>
<td>144 Channels</td>
<td>192 Channels</td>
</tr>
<tr>
<td>Internal</td>
<td>8K Samples</td>
<td>8K Samples</td>
<td>8K Samples</td>
<td>8K Samples</td>
</tr>
<tr>
<td>≤200 MHz</td>
<td>24 Channels</td>
<td>48 Channels</td>
<td>72 Channels</td>
<td>96 Channels</td>
</tr>
<tr>
<td>Internal</td>
<td>16K Samples</td>
<td>16K Samples</td>
<td>16K Samples</td>
<td>16K Samples</td>
</tr>
</tbody>
</table>

Power Requirements

- Input Frequency: 50 or 60 Hz
- Input Volts: 90 to 135 Vac or 180 to 270 Vac, Switch Selectable
- Input Power: 950 Watts with full complement of Data Boards.
- Fuses/Rated Voltage:
  - Voltage Range
    - 90 Vac to 135 Vac
    - 180 Vac to 270 Vac
  - Fuse
    - 3AG, 10 Amp
    - 3AG, 5 Amp

Controller

- Device: Macintosh II™*
- Memory: 4 Megabytes of RAM
- Floppy Drive: 3 1/2" 800k External drives via Apple disk interface
- Monitor: 13 inch, 640-by-480-pixel RGB
- Mouse: Apple™** Desktop Bus (ADB) interface

---

* Macintosh is a trademark of McIntosh Laboratories, Inc.
** Apple is a registered trademark of Apple Computer, Inc.
**Appendices**

- **Speaker:** 8 ohm standard mini-phone jack
- **Keyboard:** Synchronous serial, Apple Desktop Bus (ADB)
- **Printer:** Appletalk interface, Image Writer II or LaserWriter
- **Modem:** Appletalk interface
- **Interfaces:** Two 8-pin mini-circular serial (RS-422) ports, one DB-25 SCSI port, two Apple DeskTop Bus ports, six NuBus internal slots supporting full 32-bit address and data lines

**Optional Controller Interfaces**

- **SCSI:** (Small Computer System Interface) 25 pin Apple, in parallel with 50 pin Standard interface
- **RS232-C:** Serial interface, 38.4k baud maximum
- **GPIB (IEEE - 488):** (General Purpose Interface Bus, GPIB), Talker/Listener
- **Power:** Four +5V and -5.2V @ 300 mA Auxillary power

**Environmental Limits**

- **Ambient Temp:**
  - OPERATING: 39 to 115 Degrees F (4 to 46 Deg. C)
  - STORAGE: -8 to 117 Degrees F (-20 to 50 Deg. C)
- **Relative Humidity:**
  - OPERATING: 20% to 80%
  - STORAGE: 1% to 95%
- **Max Wet Bulb:**
  - OPERATING: 78 Degrees F (25 Degrees C)
  - STORAGE: No condensation (Warning: before powering up, wait two hours for aclimatization after moving unit from cold to warm location)

**Signal Inputs/Outputs**

- **Global Link IN BNC:** TTL Level Link Out Signal (High=Enable)
- **Sync Clock IN:** ECL Level System Clock Input at 50% Duty Cycle and 2x the sample frequency
- **Global Link OUT BNC:** TTL Level Link Out Signal (High=Enable)
Local Triggers Out: Four outputs, TTL Level (High = Enable)

Probe Test: 24 Channel Continuous TTL Level Pattern

**Probe Specs**

Input Resistance: 1 megohm referenced to threshold

Input Capacitance: $\leq 6\text{pF} (\leq 15 \text{pF with flying leads})$ Input resistance my approach 500K ohms at voltages exceeding $+15$ volts from threshold.

Max Input: $\pm 50$ volts, peak

Min. Pulse Width Out: $\geq 100$ MHz, OR 5 ns max (3 ns typical)

Min. Swing for Output: Threshold $\pm 0.20 \text{V}$ maximum

Threshold Variance: $\pm 15 \text{MV}$ maximum between input signals on one probe $\pm 30 \text{MV}$ maximum on any two probes

Input Compensation: Even to 20% overcompensated to account for probe loading

Thresholds: Thresholds are independently selectable for each group of 12 inputs.

TTL, +1.4 volts
ECL, -1.3 volts

Variable Thresholds may be set from -9.99 to +9.99 Volts in 0.01 Volt increments.

Accuracy of all threshold voltages is $\pm 30 \text{mV}$.

Polarity: + or - is selectable for each signal
Appendix D: Multianalyzer Operation

OVERVIEW

This Appendix describes how to operate the CLAS 4000 system when it is configured with up to four independent logic analyzer units contained on a single chassis.

The user's Macintosh System must meet the following memory requirements when the CLAS 4000 is configured for multianalyzer operation:

2 Analyzers (LA1 and LA2) 5 MegaBytes RAM
3 Analyzers (LA1, LA2 and LA3) 8 MegaBytes RAM
4 Analyzers (LA1, LA2, LA3 and LA4) 8 MegaBytes RAM

Each LA operates independently and may contain a different channel setup, trace control, clocking scheme and time stamp indication as determined by the user.

The multiple analyzers interact to generate recorded data. This application feature is especially useful for testing target systems that involve simultaneous operation for two, three or four subsystems.

Separate Timing and State display windows are presented for each LA. These displays are viewed separately or simultaneously. Each sample is timestamped for correlation.
This section explains how to assign Data Boards of the CLAS 4000 to one or more logic analyzers, and how to choose names for the analyzers to suit your specific problem solving needs. Go to the control menu and select the Show Configuration menu item. This will display the Configuration window of Figure D-1.

Assigning Boards

To assign the Data boards needed for one or more logic analyzers, drag the board icons from the lower panel of the window to the analyzer name in the upper panel. The default configuration shows the existing boards assigned to respective Logic Analyzers.

![Config Window](image)

**Figure D-1. Configuration Window**

You can assign all your data boards to a single analyzer as long as they are kept in contiguous order. For example, you could drag boards from slots B, C and D up to LA 1 and have 288 channels, but you could not assign boards from slots A, B, and D to LA 1, and leave the board from slot C unused. Assigning more boards to a logic analyzer increases the number of usable channels, at a rate of 96 per board.

Various high performance clocking schemes can reduce the number of available channels while increasing the memory depth. For example, in 100 MHz (10 ns) and 200 MHz (5 ns) internal clocking modes, the number of available channels per board is reduced by a factor of 2 and 4 respectively. In these modes, the sample memory depth increases by the same factors. Table D-1 shows the relationship between sample rates, channel count, and memory depth. External clock signals must be included in the channel count, and Latch clocks can also affect the number of channels available. See Chapter 5 for more information on clocking modes.

The channel reductions are actually done across each half of the data board, not across the whole board. For example, with a one-board analyzer in 100 MHz internal clock mode, you can use only half of the total channels. You can use any 24 channels out of the lower 48 and any 24 channels out of the upper 48. In 200 MHz mode, you can use any 12 channels from the lower half of the board, and any 12 channels from the upper half. Keep in mind that the whole board (in fact, the whole analyzer) must be clocked at the same rate.
<table>
<thead>
<tr>
<th>Sample Rate</th>
<th>1 Data Board</th>
<th>2 Data Boards</th>
<th>3 Data Boards</th>
<th>4 Data Boards</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 MHz Internal</td>
<td>24 Channels 16K Samples</td>
<td>48 Channels 16K Samples</td>
<td>72 Channels 16K Samples</td>
<td>96 Channels 16K Samples</td>
</tr>
<tr>
<td>100 MHz Internal or External</td>
<td>48 Channels 8K Samples</td>
<td>96 Channels 8K Samples</td>
<td>144 Channels 8K Samples</td>
<td>192 Channels 8K Samples</td>
</tr>
<tr>
<td>(\leq 50) MHz Internal or External</td>
<td>96 Channels 4K Samples</td>
<td>192 Channels 4K Samples</td>
<td>288 Channels 4K Samples</td>
<td>384 Channels 4K Samples</td>
</tr>
</tbody>
</table>
To name a configured logic analyzer or see information on it, select the icon for the logic analyzer in the Configuration window, and when the Info button becomes enabled, click it. An Information dialog box Figure D-2 opens.

![Machine Info [LA 2]](image)

**Figure D-2. Machine Info Dialog Box**

The **Kind** item tells you the maximum number of channels available at 50 MHz speed.

The **Depth** item tells you the sample memory depth of LA2 when it is used in standard clocking mode (i.e. not interfaced for high-speed sampling).

The **Where** item tells you the SCSI address (ID number) used by LA2.

The **Slots** item tells which slots in LA2 contains a data board.

The **Type** item tells you the speed of the LA in standard sampling mode.

Click the **Next** and **Previous** buttons, if they appear, to see the board info for other boards installed in Slots A through D of the CLAS 4000.
To Change the Name of the logic analyzer, click the Default Name checkbox to uncheck it. An editable text field appears around the default name. (Figure D-3)

![Machine Info [LA 2]](image)

Figure D-3. Analyzer Name Change

Change the name to whatever you want; it can reflect the data sampling method of the analyzer (internal, external clock, or transitional sampling), or it can refer to a particular target, or anything else that distinguishes it from other analyzers in use.

The Kind item tells you the maximum number of channels available in a given logic analyzer at 50 MHz speed.

Screen Interaction

The choices you make in the Configuration window affect all other screens, both setup windows and State/Timing displays. The name you choose for each logic analyzer appears in all screens.
The multianalyzer configuration permits a different Microprocessor Analysis Package (MAP) to be driven by each LA. The software for this optional accessory must be installed. The State and Timing displays for each target system can be viewed simultaneously to compare results from recorded information. Example Data Displays for 80386 and 88100 MAP Disassemblers are shown in Figure D-4.

Figure D-4. All Cycles Display, 80386 and 88100 MAP
MULTIANALYZER SETUP

Timestamp

The Timestamp is a value assigned to each sample which records the time that each sample is stored. This value begins at zero and is incremented in chronological order. The Timestamps can be displayed as cumulative time from a specific sample or delta time between samples. The Timestamp is 16 bits wide and can have an LSB value from 40 nsec resolution to 500 ms. For very long time intervals, the 16-bit Timestamp can measure times up to several seconds. The resolution selected is determined by the desired measurement.

The Timestamp is particularly useful in relating to the time and order of events in the multianalyzer configuration where signals are monitored simultaneously. Data for these multiple recordings can be presented on the screen simultaneously.

Assigning Timestamp

To assign the Timestamp resolution (LSB value) to multianalyzers, go to the Configuration window. Pull down the Timestamp submenu (Figure D-5) which provides choices for nanoseconds, microsecond, and millisecond. Select one of these choices for the timestamp resolution.

Figure D-5. Timestamp Submenu
The Time Cursor (TC) alignment allows the user to adjust the Time Cursor for two or more logic analyzers so that the Correlation Cursor is always in the same place in time across all analyzers. This adjustment is accomplished by changing the absolute start count of each analyzer using the Time Alignment Dialog Box as described in subsequent paragraphs.

**TIME ALIGNMENT**

Manually define the upper bits of the absolute time stamp counter below for proper time alignment if rollovers may have occurred. Reduce time stamp resolution for future recordings to reduce the possibility of a rollover.

<table>
<thead>
<tr>
<th>LAST RECORDING</th>
<th>REFERENCE RECORDING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Absolute</strong></td>
<td><strong>First</strong></td>
</tr>
<tr>
<td><strong>Start Count</strong></td>
<td><strong>Time Stamp</strong></td>
</tr>
<tr>
<td>LA 1</td>
<td>00 0000</td>
</tr>
<tr>
<td>LA 2</td>
<td>00 000A</td>
</tr>
<tr>
<td>LA 3</td>
<td>00 0014</td>
</tr>
<tr>
<td>LA 4</td>
<td>00 001E</td>
</tr>
</tbody>
</table>

**Figure D-6. Time Alignment Dialog Box**

**Timestamp Register**

When the Enable Time Correlation menu item is selected from the Control menu, the timestamp buffer from each active analyzer is aligned in a common time frame. This is possible because the timestamp register is common to all multianalyzers in the chassis. The timestamp register is 16 bits wide. It starts running before the multianalyzer is armed. Therefore, the actual timestamp start value that you will get in practice may be any value.

**Timestamp Normalization**

When the analyzer datasets are brought back to the host they are normalized. In single analyzer mode, Enable Time Correlation is off and each timestamp buffer is normalized to start at 0 time. However, in Time Correlation Mode, only the analyzer with the lowest absolute start count (Hexadecimal timestamp value of first sample taken) will be normalized to 0 time. We will call this analyzer the Base Analyzer of the multianalyzer set. The data set for Secondary Analyzers will be normalized to the data set of the Base Analyzer.
In practice, the timestamp register may roll over during the sample acquisition. In fact, in a multianalyzer system, a Secondary Analyzer might not take a sample until the timestamp register has already rolled over. In this case, the real Secondary Analyzer would appear to have started first because its absolute start count is lower than the Base Analyzer (e.g., where the Base Analyzer start count could be FFFF(hex) and the Secondary Analyzer could start 3 counts later at 0002(hex). In this RARE case, you can fix the problem by adding a rollover to the Secondary Analyzer to make its absolute start count 10002(hex). This can be done through the Time Alignment Dialog. (Figure D-6).

The Time Alignment Dialog gives you ability to see the timestamp start points of all active analyzer's datasets. It allows you to adjust the rollover value of each absolute start count. This is RARELY necessary. Under normal user trace control conditions, all analyzers will take their first sample within a single timestamp rollover period.

To change the time cursor alignment, first select the Configuration window from the Control menu. Next, go to the Control menu again and select the Enable Time Correlation menu item. This will activate the Time Align header on the Configuration window. Click the mouse on the Time Align header to obtain the Time Alignment Dialog Box (Figure D-6).

Assign a hexadecimal value for the start count of each analyzer as follows:

1. Select a Base LA so that its first recorded sample is the first sample of all multianalyzers.
2. Enter 00 as the absolute start count for the Base LA.
3. Adjust for rollover(s) of Secondary LAs other than the Base LA. The start count for Secondary LAs will be sequentially greater than the Base LA if their rollovers occurred within the same time period.
4. Select the number of rollovers as the absolute start for each Secondary LA. Use the sequence of rollovers as a basis for determining the associated start count for each LA.
Cross-triggering allows each independent analyzer to generate an internal link pulse that is sent out (broadcast) and detected by any other configured analyzers in the system.

The link signal appears to the detecting analyzer within one clock transition after exiting the Trace Control level from which it was generated. The link remains true for the time the link-generating analyzer is in the next level. The link-detecting analyzer may act upon detection of just the link, or on the link ANDed or ORed with patterns or address ranges. The detecting analyzer may in turn generate a new link to any other analyzers for more complex triggering scenarios.

A global link for linking several CLAS 4000 units is generated and detected in a similar fashion to the local links described previously. The global link signal appears at the connector on the front panel within 280 nsec minimum (280 nsec plus 1 sample clock maximum) of exiting the Trace Control Level from which it was generated.

It is necessary to ensure that other analyzers in the system are configured and setup properly to detect and respond to the link pulse.

The link pulse can trigger the responding analyzer to begin recording, store a predetermined number of samples, broadcast a message to other analyzers in the system, or initiate other tasks defined by the trace control parameters. The responding analyzer, however, must have been setup to initiate the specific task.

Trace control for the selected analyzer (e.g., LA1) is configured to define trigger conditions that generate the link pulse (Figure D-7). Detection of the link pulse is shown in Figure D-8.

---

**Figure D-7. Generating Link Pulse**

---

228
Figure D-8. Detecting Link Pulse
ARMIN G MULTIANALYZERS

Arm Control

The Arm Control Setup window is used to define setup conditions for arming multianalyzers. The description of setup for Arm Control and Run in Chapter 7 is also applicable for the multianalyzer configuration where the user must specify the unique setup requirement for individual analyzers.

When Auto Arm conditions are selected, each analyzer re-arms and compares independently (e.g., one analyzer may perform 20 recordings while another performs 102 recordings).

To open the Arm Control Setup window, pull down the Arm Control selection menu and select NEXT (see Figure D-9). The use of this window to define setup conditions is described in Chapter 7.

Run Control

The Run Menu, Figure D-10 is used to arm the analyzer and initiate RUN, STOP, CANCEL, and MULTIPLE analyzer operating conditions.

The Status Window (Figure D-11) reports conditions relating to the state of each analyzer as follows:

The LA field indicated which analyzers are present.

The Status field toggles between "Busy" and "Ready" to indicate if the LA is in use or idle.

The Run Information field defines further LA activity to indicate action for "Setting Up", "Arming", "Idle", "Finished-Getting Data", "Finished-Data Receiving", and "Finished".

The Compare:Pass field displays the current Compare and Pass Count information of the Analyzer.
Motion of the waveform symbol at far right side indicates communication is present between Macintosh and CLAS 4000 unit. The waveform is stationary when communication is interrupted.

Figure D-10. Run Menu

Figure D-11. Status Window
TIME CORRELATING MULTIANALYZERS

All samples on each analyzer have an independent timestamp associated with them. All timestamps are of the same resolution and use the same source. The 40 nsec resolution timestamp is enhanced with interpolation to accurately resolve sample-to-sample relationships.

Time Correlation allows a user to measure the time between samples in different LAs. The Correlation Cursor (CC) will appear in all State Display and Timing Display windows whenever Time Correlation is enabled. The CC is always in the same place in time across all analyzers. The timestamp can be Δ time, absolute time, or sample number time.

The absolute timestamp value is used to place the CC cursor in any Data or Timing window by mapping the timestamp value to its nearest sample number.

Enable Time Correlation Cursor

With either the State or Timing display window selected, go to the Control Menu and select the menu item for Enable Time Correlation (Figure D-12).

The correlation cursor is presented as a horizontal line (labeled CC) on the State display window, and is presented as a vertical line (labeled C) on the Timing display window.

When data is presented for multianalyzers, the cursor shown on one window (e.g. LA1) can be dragged from one sample number to another to observe the time difference between LA1 and LA2 or placed on a particular sample by typing in the sample number.

When the CC is moved in one analyzer window, the CC also moves in all other windows. The CC may also be moved in one analyzer to a position outside the next analyzer. The Δ Timestamp indication will show the actual time from CC to either C1 or C2 cursors in any of the analyzers. Also, the Δ Timestamp button can be toggled to provide a Δ Sample indication. The Δ Sample indication shows the number of samples between cursors.

Figure D-12. Enable Time Correlation
The composite State and Timing display for LA1 and LA2 is presented in Figure D-13. The resolution of time difference between C1 and CC is presented for each LA.

Figure D-13. Time Correlation for LA1 and LA2
Appendix E: 100 MHz State Operation

OVERVIEW
This Appendix describes 100 MHz State Operation for the CLAS 4000 Logic Analysis System. The CLAS 4000 actually samples at up to 110 MHz State with 8K samples per channel.

SAMPLING METHODS
Two External clocking methods, as follows, may be used for 100 MHz State Operation when state speeds exceed 50 MHz:

• Timebase Substitution Method (makes state measurements at up to 110 MHz, typical).

• Latching Method (makes state measurements at up to 100 MHz).

Timebase Substitution Method
The Timebase Substitution method of sampling is used for external clocking conditions where the target system clock replaces the CLAS 4000 100 MHz internal timebase with the users external timebase. To use this method, select 10 nsec as the sample rate on the channel setup screen. The user's timebase may be up to 110 MHz (typical).

The timestamp resolution is now defined in terms of the user timebase in clock cycles. Delta time for the cursors is similarly affected.

A single ECL clock signal is applied to the front panel connector labeled SYNC CLOCK ECL IN. The ECL clock must have a 50% duty cycle. The Timebase Sync Probe (Figure E-1) is used to translate the target clock signals to ECL level. The Timebase Sync Probe (Product Number A70098) is supplied as an accessory for the CLAS 4000. The user's manual for this accessory describes procedures for probe connections, operation, and calibration.

The samples are clocked on the ECL signal. The sample clock edge is positioned with a 31.5 nsec delay line in 0.5 nsec increments to precisely define the sample point relative to the clock edge.

By using the Delay dialog box (Figure E-2) to position the sample point, the sampling can occur on the rising or falling edge of the clock. This method reduces the combined set-up and hold time to 4 nsec or less.

Figure E-1. Timebase Sync Probe
Adjust the sample point with 0.5 nsec precision.

Figure E-2. Timebase Substitution for External Clocking

The triggering condition is affected by the Timebase Substitution method. Two samples are evaluated simultaneously by the trigger word recognizers. If either sample meets the Store or the Go To condition, then the appropriate action is taken.

Trace Control level-to-level decisions are made on every other clock cycle. Pattern recognition is on every clock cycle. The pattern need only be present for one clock cycle for action to be taken.

Loose Sequence triggering is available when using Timebase Substitution sampling. Loose Sequence triggering is used to detect selected patterns when the selected patterns occur in a specific sequence, but not on successive clocks (i.e., where extra patterns or events that occur between the selected patterns are ignored). Loose Sequence triggering for the Timebase Substitution Sampling Method is shown in Figure E-3.
Figure E-3. Loose Sequence Triggering for Timebase Substitution Method

**Latching Method**

This clocking method employs two latches where both edges of a one-half clock frequency signal is used as the clock for each latch (i.e. Latch #1 is clocked by the rising edge of the signal and Latch #2 is clocked by the falling edge).

This method latches the first sample, then records both first and second sample simultaneously. The same channels are sampled twice (see Figure E-4). The latched samples are clocked on the falling edge of the external clock, and both samples are recorded on the rising edge (master clock). The clock must be one-half the frequency of the target clock.

A combination of high-speed internal latches and the cross point switch cause the sample signal to be interrogated twice. The sample is latched at the rising edge of a half frequency clock signal and is sampled again on the falling edge. The half frequency clock is provided by the target system.
Figure E-4. Channel Setup with Dual Latches

The State listing for latching method presents samples displayed horizontally in pairs for a total of 8,192 samples or 4096 pairs. Each pair has a single timestamp value, where the second sample of the pair occurred one clock period after the timestamp value associated with the first sample in the pair.

TRIGGERING

Both Loose Sequence and Tight Sequence triggering are available when using the Latching method of sampling.

Loose Sequence Triggering

Loose Sequence triggering is used to detect selected patterns when the selected patterns occur in a specific sequence, but not on successive clocks (i.e., where extra patterns or events that occur between the selected patterns are ignored).

Loose Sequence triggering for the Latching sampling method is shown in Figure E-5.

Figure E-5. Loose Sequence Triggering for Latching Method
Tight Sequence Triggering

Tight Sequence triggering is used to detect that selected patterns occur in an exact sequence and in succession.

Tight Sequence triggering can occur on up to 15 patterns arranged in a tight sequence. The patterns are found on consecutive clocks. Like the Timebase Substitution sampling method, two words are evaluated simultaneously by the Trace Control. The latching method allows access to the trigger word recognizer for both samples. Up to 16 words may be defined and selected for a trigger.

Tight Sequence Triggering for the Latching sampling method is shown in Figure E-6. In this example, five words in sequence are selected for triggering.

<table>
<thead>
<tr>
<th>Glitch Width</th>
<th>L Address</th>
<th>R Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>20ns</td>
<td>Dec</td>
<td>Hex</td>
</tr>
<tr>
<td>Glitch</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>Transition</td>
<td>----</td>
<td>----</td>
</tr>
<tr>
<td>HHHHHH</td>
<td>xxxx</td>
<td>xxxx</td>
</tr>
<tr>
<td>R**B</td>
<td>xxxxR</td>
<td>xxxxB</td>
</tr>
<tr>
<td>H**A</td>
<td>xxxx</td>
<td>xxxxA</td>
</tr>
<tr>
<td>B**C</td>
<td>xxxxB</td>
<td>xxxxC</td>
</tr>
<tr>
<td>C**D</td>
<td>xxxxC</td>
<td>xxxxD</td>
</tr>
<tr>
<td>E**H</td>
<td>xxxxE</td>
<td>xxxx</td>
</tr>
</tbody>
</table>

Figure E-6. Tight Sequence Triggering for Latching Method
Index
Index

ANDing patterns and ranges, 173
Append, 37, 56
Applications
  executing, 22
  executing automatically, 21-22
Arm Control Setup window, 93-102
ASCII commands, 204-206
Block commands, 207
Bus display, 113-115
Can't undo, 37
Channel Setup window, 53-76
Chooser, 157-158
Clear the marker data, 43, 133-134, 136-138
Clear, 37, 56, 113
Clocking, 68-74, 193-200
  external, 70-74
  internal, 69-70
  multimonute, 193-195
  phase locking, 195-200
Close, 36
Color, 16-17, 20, 40, 55, 110
Compare, 42-43, 115-117, 133-134
Computer
  connecting, 6-7
  rebooting, 14
  setting up environment, 15-21
  shut down, 14-15
  turning on, 8
Configuration window, 49-52, 155
Control menu, 38
  master clock, 38, 197
  show configuration, 38, 49
  show status, 38, 102
Control panel, 15-20
Copy, 37
Count Events Step, 170-171, 186
Counters, 180-182
Cut, 37
Delay, 180
Delay/Edge/ Branch, 170-171, 190
Delay/Edge/ Step, 170-171, 187
Delay/Input Branch, 170-171, 189
Delay/Input Step, 170-171, 185
Desktop pattern, 16-17
Disassemble from top line, 43, 138-139
Disassembler config, 43, 138-139
Disassembler format, 43, 138-139
Display setup window, 122-129
Display setup, 43, 122-129
Duplicate, 37, 110
Edge tolerance, 41, 94, 116
Edge, Glitch Branch, 170-171, 190
Edge, Glitch Step, 170-171, 186
Edit menu, 37
  append, 37, 56
  can't undo, 37
  clear, 37, 56, 113
  copy, 37
  cut, 37
  duplicate, 37, 110
  insert, 37, 56, 110
  paste, 37
  select all, 37
  undo, 37
Edit reference, 43, 116-117, 134-135
Elements, 79-82
End of Loop Trigger, 82, 90
External clocking, 70-74
File menu, 36
  close, 36
  open..., 36, 154-156
  page setup..., 36, 158-159
  print window..., 36, 159
  print long..., 36, 159-160
  quit, 36, 44
  restart, 36, 44
  save as..., 36, 147-151
  save as text..., 36, 152-154
  shutdown, 36, 44-45
Fill element, 81
Fill Memory, 82, 87
Find..., 43, 132, 133
Font size, 125
Force to object mode, 43, 138-139
Full Branch, 170-171, 191
Full Feature mode, 40-41, 77, 163
Full Feature Trace Control, 163-191
  enabling, 163
Full Step, 170-171, 188
Get C1, 42-43, 106, 121
Get C1, 42-43, 106, 121
Glitches, 177-178
Go to C1, 43, 121
Go to C2, 43, 121
Goto C1, 42, 106
Goto C2, 42, 106
Goto Sample..., 42-43, 105-106, 121
GPIB interface, 202-204
Group, 42, 114
Highlight color, 17-18
Horizontal expansion, 42, 108-109
Input Branch, 170-171, 189
Input Step, 170-171, 185
Insert, 37, 56, 110
Internal clocking, 69-70
Interval Limits, 82, 91
Index

Keyboard
  connecting, 7
  shortcuts, 11, 211-212
Last >> next, 38, 157
Last >> reference, 38, 156
Level
  adding a, 165
  deleting a, 165
  highlighting a, 165
Loop/Delay/Edge/Step, 170-171, 187
Loop/Delay/Edge/Branch, 170-171, 191
Loops, 180-182
Loose Sequence Trigger, 82, 89
Markers, 136
Master clock, 38, 197
Monitors
  setting mode, 20-21
Mouse
  connecting, 7
  tracking, 18
Multimodule clocking, 193-195
Next, 136-138
Open..., 36, 154-156
Options menus, 39-43
  arm control setup, 41, 94
  channel setup window, 40, 55, 66
  state display, 43, 120-122, 132-139
  timing display, 42, 104-110, 115
  trace control setup, 40, 83, 174, 183
OR groups, 172-173
Output links, 182-183
Page setup..., 36, 158-159
Paste, 37
Patterns, 82-85
  defining, 84-85
  definition window, 82-83
  naming, 84
  radix, 84
  symbols, 85
Phase lock clocking, 195-200
Polarity, 65-66
Predefined mode, 40-41, 77-78
Predefined Tasks, see Tasks
Predefined Trace Control, 77-92
Previous, 136-138
Print long..., 36, 159-160
Print window..., 36, 159
Printer, 157-158
  connecting, 157
  selecting, 157-158
Pulse Train Trigger, 82, 90
Quit, 36, 44
Radix, 60
Range detection, 40-41, 174-175
Ranges, 174
Reference >> next, 38, 157
Restart, 36, 44
RS232 interface, 201-202
Save as text..., 36, 152-154
Save as..., 36, 147-151
Save, 147-154
  in text format, 152-154
  last setup and data, 151
  next setup, 151
  onto floppy disk, 150
  reference setup and data, 151
  to a different folder, 148-150
Search element, 81
Select all, 37
Sequences, 164
Set Loop Counter, 170-171, 188
Show configuration, 38, 49
Show output field, 40-41, 182-184
Show patterns, 40-41, 83
Show status, 38, 102
Show threshold, 40, 66
Shut down, 36, 44-45
Simple Condition Trigger, 82, 87
Simple Edge Trigger, 82, 88
Sound
  beep, 19-20
  volume, 17, 19-20
Speaker volume, 17
Specifications, 215-217
Stable Trigger Filter, 82, 92
Stack windows, 39, 143
State Display window, 119-139
Steps, 164-171, 184-191
  catalog of, 184-191
  tool descriptions, 167-171
  tools available, 170-171, 184-191
  using, 164-166
Store 'n' Samples, 82, 88
Store element, 80
Store/Time a Segment, 82, 91
Symbols, 60-65
Tasks, 164
  catalog of, 86-92
  elements available, 79-82
Test connector, 7
Tight Sequence Trigger, 82, 89
Threshold, 66
Tile windows, 39, 144, 146-147
Time stamp, 33-34, 125-129
Timer, 178-179
Timing Display window, 103-118
Timing info, 42, 117-118
Tools, 167-171
Trace Control, 77-92, 163-191
adding a level, 165
ANDing patterns and ranges, 173
counters, 180-182
delay, 180
deleting a level, 165
elements, 79-82
full feature, 163-191
glitches, 177-178
highlighting a level, 165
loops, 180-182
OR groups, 172-173
opening window, 77
output links, 182-183
patterns, 82-85
predefined, 77-92
ranges, 174
sequences, 164
steps, 163-191
tasks, 77-92, 164
timer, 178-179
tools, 167-171
transitions, 175-177

trigger placement, 182, 85-86
Trace Ctrl menu, see Options menus
Transfer menu, 38, 53-54, 115, 133, 135
last ➤ reference, 38, 156
last ➤ next, 38, 157
reference ➤ next, 38, 157
Transfer, 156-157
Transitions, 175-177
Trigger placement, 182, 85-86
Undo, 37
Ungroup, 42
Vertical expansion, 42, 108-109
Windows
   closing, 9-10
   changing size, 9-10
   juggling multiple, 141-147
   moving, 9-10
   printing, 159
   scrolling, 9-10
Windows menu, 39, 145
   stack windows, 39, 143
   tile windows, 39, 144, 146-147
Warranty/Registration

Please return this card to BIOMATION within five days.

Did the packaging of this equipment exhibit any outward signs of physical damage? ...... YES ☐ NO ☐
Did this equipment arrive intact, without missing parts, loose parts or cable damage? ...... YES ☐ NO ☐
Did the equipment operate on power-up? .............................................. YES ☐ NO ☐
Did you attain adequate system performance? ........................................... YES ☐ NO ☐
Were any electrical adjustments required? ............................................... YES ☐ NO ☐
If you required assistance, was a local BIOMATION representative contacted? .......... YES ☐ NO ☐

Comments

UserName ______________ Title ______________ Department ______________ M/S ______________

Company ______________ Phone ______________
Address ______________ City ______________ State ______________ Zip ______________
Model or Description ______________ Serial or Part No. ______________ Date Received ______________

Reader Comments

The manual's completeness, accuracy, organization, usability, and reliability:

____________________________________________________________________________________

____________________________________________________________________________________

Did you find errors in this manual? ______________ How can this manual be improved?

____________________________________________________________________________________

____________________________________________________________________________________

Additional comments:

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

Name ______________ Department ______________ Date ______________
Company ______________ Manual or Part No. ______________
Address ______________
City ______________ State ______________ Zip ______________ Phone ______________